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Kata Pengantar 
Edisi Pertama 

 

Unpad SAS (Seri Analisis Statistik) adalah software yang dikem-

bangkan oleh tim peneliti dari Unpad dengan tujuan untuk pengolahan data 

statistik yang banyak digunakan dalam penelitian bidang Psikologi dan ilmu 

Sosial lainnya, akan tetapi belum tersedia dalam software-software pe-

ngolahan data statistik yang ada, seperti SPSS, SAS, dan lain-lain.  

Unpad SAS diharapkan akan menjadi perangkat lunak analisis data 

Statistik yang murah, cepat, akurat, dan komprehensif bagi pengajaran mata 

kuliah Statistika. Software ini juga akan mengurangi ketergantungan ter-

hadap perangkat lunak yang dikembangkan pihak asing dan mengurangi 

maraknya pembajakan terhadap perangkat lunak analisis Statistik. 

Buku ajar yang dilengkapi software Unpad SAS ini akan memudahkan 

mahasiswa untuk belajar Statistika karena dilengkapi dengan contoh per-

hitungan secara manual dan juga cara menggunakan Unpad SAS dengan 

petunjuk yang jelas dan sederhana. Sebagai akibatnya mahasiswa akan 

tertarik untuk belajar Statistika karena pembelajaran Statistika mengguna-

kan Unpad SAS dapat dilakukan secara mudah, murah, cepat, dan akurat. 

Buku ini merupakan Edisi Pertama dari rangkaian hasil penelitian 

yang sedang kami lakukan. Oleh karena itu buku ini baru memuat tiga Bab, 

yaitu Petunjuk Instalasi Unpad SAS, Manajemen Basisdata, dan Statistik 

Deskriptif. Namun demikian, software Unpad SAS yang melengkapi buku ini 

telah memuat beberapa analisis lain yang belum didokumentasikan karena 

masih dalam tahap pengembangan. 

Masukan dari pengguna sangat diharapkan untuk menyempurnakan 

pengembangan Unpad SAS sebagai suatu media pembelajaran Statistika.  

Semoga buku ajar dan software Unpad SAS akan menambah per-

bendaharaan buku ajar dalam bidang Statistika yang dapat diaplikasikan 

seluas-luasnya bagi perkembangan ilmu pengetahuan di Indonesia. 

 

Bandung, Januari 2018 

 

Para penulis  



 

viii 

Kata Pengantar 
Edisi Kedua 

 

Buku ini merupakan Edisi Kedua dari rangkaian hasil penelitian yang 

sedang kami lakukan. Buku ini memuat enam Bab, yaitu Manajemen Ba-

sisdata, Statistik Deskriptif, Sampling, Uji Nonparametrik, Uji Korelasi, dan 

Petunjuk Instalasi Unpad SAS. 

Berbeda dengan Edisi Pertama, di dalam Edisi Kedua ini Petunjuk 

Instalasi Unpad SAS ditempatkan sebagai bab terakhir dengan pertim-

bangan bahwa buku ini merupakan buku ajar sehingga pembahasan akan 

langsung ke materi pembelajaran Statistika.  

Software Unpad SAS yang digunakan sebagai acuan di dalam buku ini 

adalah Unpad SAS Rilis 2, yang selain menambahkan modul-modul analisis 

baru (sampling, uji nonparametrik, dan uji korelasi) juga menambahkan 

fitur-fitur baru untuk pengolahan basis data, yaitu seperti impor/ekspor 

tabel data, pencetakan tabel data dan luaran, serta mendukung format 

masukan/luaran angka dengan pemisah simbol koma atau titik untuk nilai 

pecahan. 

Modul-modul analisis yang telah disediakan di dalam Unpad SAS tentu 

masih belum lengkap. Dukungan penelitian dan pengembangan dari Uni-

versitas Padjadjaran masih diperlukan agar modul-modul analisis lainnya 

dapat dikembangkan dan dapat menjadikan Unpad SAS sebagai software 

alternatif untuk keperluan pengolahan data statistik. 

Semoga buku ajar dan software Unpad SAS akan menambah per-

bendaharaan buku ajar dalam bidang Statistika yang dapat diaplikasikan 

seluas-luasnya bagi perkembangan ilmu pengetahuan di Indonesia. 

 

Bandung, Januari 2019 

 

Para penulis 
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Manajemen Basisdata 
 

 

A. PENDAHULUAN 

Unpad SAS merupakan software untuk keperluan analisis data sta-

tistik. Pengembangan Unpad SAS dilakukan secara modular dan bertahap, 

sesuai dengan kebutuhan pokok materi pembelajaran pada mata kuliah 

Statistika di Fakultas Psikologi Unpad, sehingga itu merupakan kumpulan 

modul analisis statistik. Itulah kenapa penulis menamakannya SAS (Seri 

Analisis Statistik). 

Modul inti dari Unpad SAS adalah Manajemen Basisdata yang dikemas 

dalam satu paket dengan Manajemen Modul. Modul Manajemen Basisdata 

digunakan untuk mengelola data/tabel yang akan diolah dan Manajemen 

Modul digunakan untuk mengintegrasikan modul-modul analisis ke dalam 

Unpad SAS sehingga modul-modul analisis tersebut dapat menggunakan 

data/tabel yang telah ada dan hasil analisisnya dapat dikelola oleh modul 

inti. 

Unpad SAS dikembangkan secara modul-terbuka sehingga siapa pun 

boleh berpartisipasi di dalam pengembangan program aplikasi ini. 
 
1. Memulai Unpad SAS 

Gambar 1.1 adalah tampilan yang muncul jika Anda menjalankan 

program Unpad SAS. 

▪ Menu-bar memuat daftar menu perintah yang dapat diberikan kepada 

Unpad SAS, yaitu menu File, Edit, View, Data, Analyze, dan Help. Klik 

nama menu tertentu untuk menampilkan daftar submenu dan atau pe-

rintah yang terdapat di dalamnya, klik nama submenu untuk menampilkan 

daftar perintah yang terdapat di dalamnya, dan klik nama perintah yang 

akan Anda berikan kepada Unpad SAS. 

▪ Tool bar memuat beberapa tombol yang mewakili perintah tertentu untuk 

mempercepat pemberian perintah tersebut. Bawalah pointer ke tombol 
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tertentu maka Anda akan melihat teks petunjuk perintah tersebut. Klik 

tombol tertentu untuk memberikan perintah yang sesuai kepada Unpad 

SAS. 

 

Gambar 1.1: 
Jendela Utama Unpad SAS 

▪ Status-bar memuat status atau keterangan dari proses yang sedang di-

jalankan oleh Unpad SAS. 

▪ Bidang-kerja menampilkan variabel, data, atau keluaran dari file data 

yang sedang dibuka. 

Sebelum penulis membahas tentang perintah-perintah yang berkaitan 

dengan manajemen basisdata secara terinci, berikut ini penulis akan 

membahas terlebih dahulu tentang bagaimana cara membuka dan menutup 

file data serta mengakhiri penggunaan Unpad SAS. 
 
2. Membuka dan Menutup Tabel 

Lakukan langkah-langkah berikut untuk membuka file/tabel yang 

telah ada. 

MENU-BARTOOL-BAR

BIDANG KERJA

STATUS-BAR
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▪ Klik menu File, pilih submenu Open, dan pilih perintah Data ..., seperti 

ditunjukkan pada gambar di bawah ini. 

  

▪ Untuk menyederhanakan penulisan, pemberian perintah seperti itu akan 

dituliskan dalam bentuk rangkaian nama menu, submenu, dan perintah 

yang dimaksud dengan pemisah berupa simbol “->”. Sebagai contoh, untuk 

memberikan perintah di atas akan dituliskan menjadi File->Open. 

▪ Atas perintah tersebut maka akan ditampilkan kotak dialog Select Table, 

yaitu seperti ditunjukkan pada gambar di bawah ini. 

 

▪ Klik nama tabel yang akan dibuka, dalam hal ini adalah “cor_sample”, 

kemudian klik tombol <Open>. 

▪ Selain dapat digunakan untuk membuka tabel data, kotak dialog ini juga 

dapat digunakan untuk menghapus tabel data yang ada di dalam daftar. 

▪ Klik nama tabel yang akan dihapus kemudian klik tombol Delete. 

Atas perintah Open tersebut maka pada bidang-kerja Anda akan 

melihat tampilan seperti ditunjukkan di dalam Gambar 1.2. 

Berdasarkan tampilan tersebut dapat disampaikan bahwa: 

▪ Tabel “cor_sample” terdiri dari 5 (lima) buah variabel, yaitu Sex, Per-

misiveness, TypeOfLawyer, IncomeLevel, dan EducationLevel. 
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▪ ID walaupun merupakan variabel tidak diperhitungkan sebagai variabel 

data karena itu hanya digunakan sebagai nomor urut data. Walaupun 

begitu, variabel ID harus selalu ada di dalam setiap tabel data Unpad SAS. 

 

Gambar 1.2: 
Jendela Data View 

▪ Perhatikan bagian bawah dari bidang-kerja, di sana ada tulisan “Data 

View” dan “Variable View". Itu berarti bahwa bidang-kerja dapat digunakan 

sebagai “Data View” atau “Variable View". 

▪ Bidang “Data View” digunakan untuk menampilkan, menambah, mem-

perbaiki, dan menghapus data dari dan ke dalam tabel, sementara bidang 

“Variable View” digunakan untuk menampilkan, menambah, memperbaiki, 

dan menghapus variabel dari dan ke dalam tabel.  

Sekarang cobalah Anda pilih/klik “Variable View”. Atas perintah ter-

sebut maka tampilan bidang kerja akan berubah menjadi seperti ditun-

jukkan di dalam Gambar 1.3. 

Berdasarkan tampilan tersebut dapat disampaikan bahwa: 

▪ Variabel ID berjenis-data numerik dengan lebar 8 digit,  
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▪ Variabel Sex berjenis-data numerik dengan lebar 1 digit, dengan nama 

label “Sex”, merupakan data nominal dengan 1=Perempuan dan 2=Laki-

laki, lebar kolom di layar adalah 3, dicetak tengah-tengah (center). 

▪ Variabel Permisiveness berjenis-data numerik dengan lebar 8 digit, dengan 

nama label “Permisiveness”, merupakan data ordinal dengan 0=Sangat 

rendah, 1=Rendah, 2=Cukup rendah, 3=Cukup tinggi, 4=Tinggi, dan 5=Sa-

ngat tinggi, lebar kolom di layar adalah 12, dicetak rata-kanan (Right). 

 

Gambar 1.3: 
Jendela Variable View 

▪ Variabel TypeOfLawyer berjenis-data numerik dengan lebar 8 digit, dengan 

nama label “Type of Lawyer”, merupakan data nominal dengan 1=Kon-

sultan, 2=Notaris, dan 3=Pengacara, lebar kolom di layar adalah 12, 

dicetak rata-kanan (Right). 

▪ Variabel IncomeLevel berjenis-data numerik dengan lebar 8 digit, dengan 

nama label “Income Level”, merupakan data Interval/Scale, lebar kolom di 

layar adalah 12, dicetak rata-kanan (Right). 

▪ Variabel EducationLevel berjenis-data numerik dengan lebar 8 digit, de-

ngan nama label “Education Level”, merupakan data Interval/Scale, lebar 

kolom di layar adalah 12, dicetak rata-kanan (Right). 
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Jika Anda telah selesai bekerja dengan suatu tabel maka biasakan 

untuk menutup tabel tersebut. Lakukan langkah berikut untuk keperluan 

tersebut. 

▪ Klik menu File dan pilih perintah Close, seperti ditunjukkan pada gambar 

di bawah ini.  

 

 
3. Menyimpan Tabel 

Ketika Anda membuat tabel baru atau membuka tabel yang sudah ada 

sebelumnya kemudian melakukan penambahan, pembaruan, atau peng-

hapusan terhadap data tabel tersebut, maka perubahan-perubahan tersebut 

akan direkam secara otomatis. Tabel baru secara otomatis diberi nama 

“new” dan namanya akan diminta untuk diganti ketika Anda memberi 

perintah File->Save. 

Jika Anda bermaksud untuk merekam tabel yang sedang dibuka 

dengan nama lain maka Anda dapat memberi perintah File->Save As. Hal ini 

biasanya Anda perlukan untuk membuat salinan suatu tabel atau membuat 

tabel sementara yang datanya akan Anda ubah sesuai dengan kebutuhan 

tertentu. 

Jika Anda memberikan perintah File->Save atau File->Save As maka 

Anda akan melihat kotak dialog berikut ini. 
 

 

Gambar 1.4: 
Kotak Dialog Save As 

Tuliskan nama tabel pada ruas yang tersedia dan klik tombol <Save> untuk 

merekamnya atau tombol <Cancel> untuk membatalkannya. 
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Penting untuk Anda catat bahwa nama suatu tabel hanya dapat berupa kumpulan 

huruf, angka, dan garis-bawah. Huruf pertama suatu tabel harus berupa huruf 

atau garis-bawah. 

 
4. Keluar dari Unpad SAS 

Setelah Anda menggunakan Unpad SAS dan Anda ingin mengakhi-

rinya, maka Anda dapat memberi perintah File->Exit. 
 

 

 

B. MENETAPKAN STRUKTUR DAN MEMASUKKAN DATA 

Sebelum membahas tentang bagaimana menetapkan struktur dan 

memasukkan data, penulis memandang perlu untuk membahas tentang 

skala pengukuran dan jenis data terlebih dahulu. 
 
1. Skala Pengukuran 

Pengukuran merupakan aturan-aturan pemberian angka untuk ber-

bagai objek sedemikian rupa sehingga angka ini mewakili kualitas atribut. 

Terdapat empat jenis skala yang dapat digunakan untuk mengukur atribut, 

yaitu skala nominal, skala ordinal, skala interval, dan skala ratio. 
 
a. Skala nominal 

Merupakan salah satu jenis pengukuran dimana angka dikenakan 

untuk objek atau kelas objek untuk tujuan identifikasi. Nomor jaminan sosial 

seseorang, nomor punggung pemain sepakbola, nomor loker, dan lain-lain 

adalah suatu skala nominal. Demikian juga, jika dalam suatu penelitian 

tertentu laki-laki diberikan kode 1 dan perempuan mendapat kode 2, untuk 

mengetahui jenis kelamin seseorang adalah melihat apakah orang ini 
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berkode 1 atau 2. Angka-angka tersebut tidak mewakili hal lain kecuali jenis 

kelamin seseorang. Perempuan, meskipun mendapat angka yang lebih 

tinggi, tidak berarti perempuan “lebih baik” dibanding laki-laki, atau “lebih 

banyak” dari laki-laki. Kita boleh saja membalik prosedur pemberian kode 

sehingga perempuan berkode 1 dan laki-laki berkode 2. 
 
b. Skala ordinal 

Merupakan salah satu jenis pengukuran dimana angka dikenakan 

terhadap data berdasarkan urutan dari objek. Disini angka 2 lebih besar dari 

1 dan angka 3 lebih besar dari 2 maupun 1. Angka 1, 2, 3, adalah berurut, dan 

semakin besar angkanya semakin besar propertinya. Contoh, angka 1 untuk 

mewakili mahasiswa tahun pertama, 2 untuk tahun kedua, 3 untuk tahun 

ketiga, dan 4 untuk mahasiswa senior. Namun kita juga bisa memakai angka 

10 untuk mewakili mahasiswa tahun pertama, 20 untuk tahun kedua, 25 

untuk tahun ketiga, dan 30 untuk mahasiswa senior. Cara kedua ini tetap 

mengindikasikan level kelas masing-masing mahasiswa dan relative 

standing dari dua orang, yaitu siapa yang terlebih dahulu kuliah. 
 
c. Skala interval 

Merupakan salah satu jenis pengukuran dimana angka-angka yang 

dikenakan memungkinkan kita untuk membandingkan ukuran dari selisih 

antara angka-angka. Selisih antara 1 dan 2 setara dengan selisih antara 2 dan 

3, selisih antara 2 dan 4 dua kali lebih besar dari selisih antara 1 dan 2. 

Contohnya adalah skala temperatur, misalnya temperatur yang rendah pada 

suatu hari adalah 40
0
 F dan temperatur yang tinggi adalah 80

0
 F. Disini kita 

tidak dapat mengatakan bahwa temperatur yang tinggi dua kali lebih panas 

dibandingkan temperatur yang rendah karena jika skala Fahrenheit menjadi 

skala Celsius, dimana C=(5F–160)/9, sehingga temperatur yang rendah 

adalah 4.40 C dan temperatur yang tinggi adalah 2660 C. 
 
d. Skala ratio 

Merupakan salah satu jenis pengukuran yang memiliki nol alamiah 

atau nol absolute, sehingga memungkinkan kita membandingkan magnitude 

angka-angka absolute. Tinggi dan berat adalah dua contoh nyata disini. 

Seseorang yang memiliki berat 100 kg boleh dikatakan dua kali lebih berat 
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dibandingkan seseorang yang memiliki berat 50 kg, dan seseorang yang me-

miliki berat 150 kg tiga kali lebih berat dibandingkan seseorang yang be-

ratnya 50 kg. Dalam skala ratio, nol memiliki makna empiris absolute. 
 
2. Jenis Data 

Secara umum, data yang akan diolah dibedakan menurut jenisnya, 

yaitu: 

▪ Numeric, yaitu suatu nilai berupa bilangan bulat atau pecahan; 

▪ Date, yaitu suatu nilai berupa tanggal dan waktu; dan 

▪ String, yaitu suatu nilai berupa kumpulan karakter. 

Rentang nilai yang dapat ditetapkan untuk data numerik ditentukan 

oleh jumlah/lebar angka (width) untuk data tersebut. Jenis data numeric 

berupa bilangan bulat dan pecahan dibedakan oleh jumlah digit desimal 

(dec) yang ditetapkan untuk data tersebut. Jika itu bernilai 0 maka itu 

diartikan sebagai bilangan bulat sementara jika itu bukan 0 maka itu di-

artikan sebagai bilangan pecahan. 

Data numerik dengan lebar 5 digit dan desimal 0 dipandang sebagai 

bilangan bulat dengan rentang nilai dari -9999 sampai dengan 99999. Data 

numerik dengan lebar 5 digit dan desimal 2 dipandang sebagai bilangan 

pecahan dengan rentang nilai dari -9,99 sampai dengan 99,99. 

Jenis-data Date digunakan untuk menyimpan nilai berupa tanggal dan 

waktu dalam format 

YYYY-MM-DD hh:mm:ss 

Dimana: 

YYYY adalah tahun 
MM adalah nomor bulan, 01 sampai dengan 12 
DD adalah tanggal, 01 sampai dengan 31 
hh adalah jam, 00 sampai dengan 23 
mm adalah menit, 00 sampai dengan 59 
ss adalah detik, 00 sampai dengan 59 

 

Rentang nilai yang dapat diberikan untuk jenis data Date adalah “1000-01-

01 00:00:00” sampai dengan “9999-12-31 23:59:59”. 

Jenis-data String digunakan untuk menyimpan nilai berupa kumpulan 

karakter. Jumlah karakter yang dapat ditetapkan (dianjurkan) 1 sampai 

dengan 255 karakter. 
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Didalam pengolahan data statistika dengan menggunakan bantuan 

komputer, penetapan jenis-data harus mengacu kepada skala pengukuran. 

Jenis-data String, walaupun dapat digunakan untuk nilai berskala peng-

ukuran nominal atau ordinal tetapi sebaiknya dihindarkan. Misalnya, peng-

gunaan literal “perempuan” dan “laki-laki” atau “P” dan “L” untuk variabel 

jenis kelamin sebaiknya dihindarkan dan digantikan dengan angka “1” dan 

“2” dengan penjelasan 1=perempuan dan 2=laki-laki. Apa lagi jika itu 

digunakan untuk nilai berskala pengukuran ordinal. Misalnya, penggunaan 

literal “SD”, “SMP”, “SMA”, dan “Perguruan Tinggi” sebaiknya dihindarkan 

dan digantikan dengan angka “1”, “2”, “3”, dan “4” dengan penjelasan 1=SD, 

2=SMP, 3=SMA, dan 4=Perguruan Tinggi. 

Penggunaan nilai secara literal, selain tidak sederhana, menyulitkan, 

atau lambat ketika dimasukkan. Misalnya, menuliskan nilai “1” dan “2” lebih 

sederhana, mudah, atau cepat dibandingkan dengan menuliskan “perem-

puan” dan “laki-laki”. Selain itu, penulisan nilai secara literal tidak dapat 

mencerminkan tingkatan dari nilai tersebut. Misalnya, nilai literal “SD”, 

“SMP”, “SMA”, dan “Perguruan Tinggi” kalau diurut secara alfabetis hasilnya 

adalah “Perguruan Tinggi”, “SD”, “SMA”, dan “SMP”. Urutan tersebut tentu 

menjadi tidak sesuai dengan skala pengukuran ordinal yang boleh jadi kita 

maksudkan. Oleh sebab itu, penggunaan nilai “1”, “2”, “3”, dan “4” dengan 

penjelasan bahwa 1=SD, 2=SMP, 3=SMA, dan 4=Perguruan Tinggi, selain 

lebih sederhana, mudah, atau cepat juga dapat mencerminkan tingkatan dari 

nilai tersebut. 
 
3. Menetapkan Struktur Data 

Setiap tabel data Unpad SAS terdiri dari satu atau lebih variabel. Setiap 

variabel memiliki: 

▪ Name – adalah nama pendek yang diberikan untuk variabel. Nama 

variabel dimulai oleh huruf dan dapat diikuti oleh huruf, angka, atau garis-

bawah. Nama variabel sebaiknya dibuat sependek mungkin tetapi tetap 

dapat mengingatkan pada variabelnya. Contoh, Anda dapat menggunakan 

nama “JK” untuk variabel Jenis Kelamin atau “JP” untuk variabel Jenis 

Pekerjaan. 

▪ Type – adalah jenis-data yang sesuai dengan variabel yang dimaksud, yaitu 

Numeric, Date, atau String. 
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▪ Width – adalah jumlah/lebar angka untuk jenis-data numerik atau jumlah 

huruf untuk jenis-data String. Untuk jenis-data Date, atribut ini diabaikan. 

Nilai untuk “width” sudah termasuk dengan jumlah angka desimal yang 

ditetapkan pada kolom “dec”, simbol pemisah nilai bulat dan pecahan, 

simbol pemisah nilai ribuan, serta simbol nilai negatif. 

Sebagai misal, untuk tinggi badan dalam satuan cm kita cukup me-

nentukan atribut width bernilai 3. Jika tinggi badan tersebut ditetapkan 

memiliki ketelitian 1 angka desimal maka nilai untuk width harus di-

tambah 2, yaitu 1 untuk angka desimal dan 1 untuk simbol pemisah angka 

desimal. 

▪ Dec – adalah jumlah angka di belakang titik desimal. Atribut ini hanya 

digunakan untuk jenis-data numerik. 

▪ Label – adalah nama panjang untuk variabel. Nama ini akan digunakan 

pada luaran hasil analisis. Contoh, pada kolom “Name” Anda dapat me-

nuliskan “JK” dan pada kolom “Label” Anda dapat menuliskan “Jenis 

Kelamin”. 

Label akan digunakan oleh Unpad SAS pada luaran yang dihasilkan. 

Walaupun nilai untuk label dapat diberikan secara panjang tetapi itu 

sebaiknya digunakan secara bijaksana agar tidak mengganggu luaran yang 

dihasilkan. 

▪ Values – adalah nilai literal untuk nilai variabel. Ini dapat digunakan untuk 

data nominal dan ordinal yang disandikan. Misalnya, 1=Laki-laki, 

2=Perempuan. 

▪ Missing – adalah aturan/perlakuan yang diberikan untuk nilai masukan 

tertentu. 

▪ Column – adalah lebar bidang tampilan, terutama pada Data View, yang 

ditetapkan untuk variabel. 

▪ Align – adalah mode pencetakan yang digunakan, yaitu rata-kiri (Left), 

rata-kanan (Right), atau simetris (Center). 

▪ Measure – adalah skala pengukuran data, yaitu Nominal, Ordinal, atau 

Scale (untuk data Interval dan Ratio). 

Untuk memahami cara menetapkan struktur data atau variabel, per-

hatikan baik-baik masalah di bawah dan bagaimana itu ditetapkan ke dalam 

suatu tabel. 
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Contoh 1.1: 

Sebuah penelitian dilakukan untuk mengetahui faktor-faktor yang berpe-

ngaruh terhadap perilaku anak mengucapkan terima kasih setelah diberi 

bantuan oleh orang dewasa. Penelitian dilakukan di Desa Cijengkol, me-

libatkan 50 anak usia 3, 4, 5, dan 6 tahun. 

Selama 1 minggu, semua anak diberikan tayangan lagu anak “Ucapkan 

Terima Kasih” dengan frekuensi yang berbeda-beda pada setiap anak. Ming-

gu selanjutnya, pada anak diberikan 10 situasi dimana anak menerima 

bantuan dari orang dewasa. Berapa kali anak mengucapkan terima kasih 

setelah menerima bantuan tersebut, dicatat. 

Selain itu, diukur juga Kondisi Sosial Ekonomi orang-tua yang digolongkan 

menjadi 3 golongan, yaitu “bawah”, “menengah”, dan “atas”. Kecenderungan 

Perilaku Prososial Anak yang diukur menggunakan kuesioner yang 

diberikan kepada orang-tua, berisi 20 item dengan 4 pilihan jawaban: 1=ti-

dak pernah; 2=kadang-kadang; 3=sering; dan 4=selalu. Pada variabel Jenis 

Kelamin angka 1 mewakili jenis kelamin “laki-laki”, dan angka 2 mewakili 

jenis kelamin “perempuan”. 

Berikut ini adalah hasil data yang diperoleh: 
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1 L 3 Menengah 21 7 4 

2 L 4 Atas 78 5 5 

3 L 5 Bawah 65 6 3 

4 L  Menengah 45 4 4 

5 L 3 Atas 34 5 5 

6 L 5 Bawah 65 3 6 

7 L 5 Bawah 76 4 8 

8 L 5 Atas 45 5 9 

9 L 6 Menengah 34 6 4 

10 L 6 Menengah 23 5 5 

11 L 3 Atas 65 4 6 

12 L 4 Menengah 45 3 7 

13 L 4 Atas 67 4 8 

14 L 5 Bawah 54 5 2 

15 L 5 Menengah 65 6 4 

16 L 6 Atas 34 5 5 
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17 L 3 Bawah 54 4 6 

18 L 3 Bawah 65 3 7 

19 L 4 Atas 34 4 3 

20 L 5 Menengah 23 5 4 

21 L 6 Menengah 56 6 2 

22 L 3 Atas 76 5 3 

23 L 5 Menengah 45 4 1 

24 L 5 Atas 67 3 3 

25 L 5 Bawah 54 4 4 

26 P 6 Menengah 65 5 5 

27 P 6 Atas 76 6 6 

28 P 3 Bawah 54 5 7 

29 P 4 Bawah 65 4 4 

30 P 4 Atas 45 3 2 

31 P 5 Menengah 65 4 3 

32 P 5 Menengah 45 5 4 

33 P 6 Atas 54 6 5 

34 P 3 Atas 65 4 6 

35 P 5 Bawah 65 3 7 
 

Untuk keperluan tersebut lakukan langkah-langkah sebagai berikut. 

▪ Tetapkan Name untuk variabel-variabel tersebut. Katakanlah itu secara 

berturut-turut adalah JK, Usia, SEO, Prososial, FL, dan JU. 

▪ Tetapkan Type untuk variabel-variabel tersebut. JK berjenis-data String, 

Usia berjenis-data Numeric, SEO berjenis-data String, Prososial berjenis-

data Numeric, FL berjenis-data Numeric, dan JU berjenis-data Numeric. 

▪ Tetapkan Width untuk variabel-variabel tersebut. JK 1 karakter, Usia 1 

angka, SEO 8 huruf, Prososial 2 angka, FL 2 angka, dan JU 2 angka. Nilai 

Width sekurang-kurangnya sama dengan nilai terbesar/terpanjang dari 

variabel yang dimaksud. Dalam contoh ini, nilai terpanjang variabel SEO 

adalah “Menengah”, maka nilai Width untuk variabel SEO sekurang-

kurangnya adalah 8. 

▪ Tetapkan Dec untuk variabel-variabel tersebut. Dalam hal ini semuanya 

ditetapkan bernilai 0. 

▪ Tetapkan Label untuk variabel-variabel tersebut. Label untuk JK adalah 

“Jenis Kelamin”, label untuk Usia adalah “Usia” atau kosong karena sama, 
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label untuk SEO adalah “Status Sosial Ekonomi Orang-tua”, label untuk 

Prososial adalah “Kecenderungan Perilaku Prososial Anak”, label untuk FL 

adalah “Frekuensi Penanyangan Lagu Ucapkan Terima Kasih Selama 1 

Minggu”, dan label untuk JU adalah “Jumlah Ucapan Terima Kasih yang di-

ucapkan anak saat menerima bantuan”. 

▪ Tetapkan Values untuk variabel-variabel tersebut. Untuk JK, L=Laki-laki 

dan P=Perempuan. 

▪ Tetapkan Missing untuk variabel-variabel tersebut. Dalam contoh ini tidak 

ada. 

▪ Tetapkan Column untuk variabel-variabel tersebut. Untuk JK 4, Usia 4, SEO 

10, Prososial 10, FL 4, dan JU 4. 

▪ Tetapkan Align untuk variabel-variabel tersebut. Untuk JK adalah Left, 

untuk Usia adalah Right, untuk SEO adalah Left, untuk Prososial adalah 

Right, untuk FL adalah Right, dan untuk JU adalah Right. 

▪ Tetapkan Measure untuk variabel-variabel tersebut. Untuk JK adalah 

Nominal, untuk Usia adalah Scale, untuk SEO adalah Ordinal, untuk 

Prososial adalah Scale, untuk FL adalah Scale, dan untuk JU adalah Scale. 

Setelah Anda memahami nilai untuk setiap atribut variabel di atas 

maka selanjutnya adalah memberikan perintah untuk membuat tabel baru 

dan menetapkan semua variabel dan atributnya ke dalam tabel. Lakukan 

langkah-langkah berikut untuk keperluan tersebut. 

▪ Berikan perintah File->New. Atas perintah tersebut Anda akan melihat 

jendela Variable View di bidang kerja, yaitu seperti di bawah ini. 
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Gambar 1.5: 
Jendela Variable View 

Berikut ini adalah kegunaan sejumlah tombol keyboard di dalam 

penetapan variabel. 

Gunakan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

berikutnya. 

Gunakan tombol panah-kiri untuk memindahkan sel aktif ke kolom 

sebelumnya. 

Gunakan tombol panah-bawah untuk memindahkan sel aktif ke baris 

berikutnya. Jika posisi sel aktif berada di baris terakhir, itu digunakan 

untuk menambah variabel baru. 

Gunakan tombol panah-atas untuk memindahkan sel aktif ke baris 

sebelumnya. 

Gunakan tombol Insert untuk menyisipkan variabel baru se-

belum variabel yang berada sel aktif. 

Gunakan tombol Esc/Escape untuk membatalkan perubahan yang 

dilakukan terhadap sel aktif. 

Gunakan tombol Ctrl+Del untuk menghapus variabel yang 

berada di baris aktif. 
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Berikutnya, cobalah Anda tambahkan semua variabel di atas, sesuai 

dengan atributnya masing-masing, sehingga hasilnya adalah seperti ditun-

jukkan di dalam gambar berikut ini. 

 

Untuk keperluan tersebut lakukan langkah-langkah sebagai berikut. 

▪ Pastikan Anda berada pada sel ID (baris pertama kolom Name). 

▪ Tekan tombol panah-bawah untuk memindahkan sel aktif ke baris 

berikutnya. Tulis “JK” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Type. Atribut Type adalah drop-down list jadi Anda cukup meng-klik 

bagian kanan nilai pada kolom tersebut untuk menampilkan daftar pilihan 

dan memilih nilai yang telah tersedia. Berikut ini adalah contoh menam-

pilkan daftar pilihan untuk kolom Type. 
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▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Width. Tulis “1” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Dec. Tulis “0” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Label. Tulis “Jenis Kelamin” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Values. Atribut Values adalah ellipsis, Anda harus meng-klik bagian 

kanan nilai pada kolom tersebut untuk menampilkan kotak dialog untuk 

keperluan penetapan nilai kolom tersebut. Berikut ini adalah contoh me-

nampilkan kotak dialog untuk kolom Values. 

 

• Klik simbol ellipsis (...) maka Anda akan melihat kotak dialog berikut. 

 

• Masukkan simbol “L” pada ruas Value dan “Laki-laki” pada ruas Label 

kemudian klik tombol <Add>. 

• Masukkan simbol “P” pada ruas Value dan “Perempuan” pada ruas Label 

kemudian klik tombol <Add>. 

• Kemudian klik tombol <OK>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Missing. Atribut Missing adalah ellipsis, Anda harus meng-klik bagian 

kanan nilai pada kolom tersebut untuk menampilkan kotak dialog untuk 
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keperluan penetapan nilai kolom tersebut. Berikut ini adalah contoh 

menampilkan kotak dialog untuk kolom Missing. 

 

• Klik simbol ellipsis (...) maka Anda akan melihat kotak dialog berikut. 

 

• Untuk sementara Anda dapat mengabaikan penetapan Missing Values ini. 

• Klik tombol <OK>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Column. Tulis “4” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Align. Atribut Align adalah drop-down list jadi Anda cukup meng-klik 

bagian kanan nilai pada kolom tersebut untuk menampilkan daftar pilihan 

dan memilih nilai yang telah tersedia. Berikut ini adalah contoh me-

nampilkan daftar pilihan untuk kolom Align. 

 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Measure. Atribut Measure adalah drop-down list jadi Anda cukup 

meng-klik bagian kanan nilai pada kolom tersebut untuk menampilkan 

daftar pilihan dan memilih nilai yang telah tersedia. Berikut ini adalah 

contoh menampilkan daftar pilihan untuk kolom Measure. 
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▪ Tekan tombol panah-bawah untuk memindahkan sel aktif ke baris 

berikutnya. 

▪ Ulangi langkah-langkah di atas untuk menambahkan variabel-variabel 

lainnya. 
 
4. Memasukkan Data 

 

Untuk memasukkan data ke dalam tabel, pastikan Anda meng-klik 

“Data View”. Gambar di atas menunjukkan tabel sesudah datanya dima-

sukkan. Jika data untuk tabel tersebut belum dimasukkan, Anda akan me-

lihat tabel tersebut hanya memiliki judul kolom tanpa ada baris-baris nilai 

di bawahnya. 

Berikut ini akan dibahas bagaimana cara memasukkan nilai ke dalam 

tabel tersebut secara manual dan melalui proses copy-paste. 
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Memasukkan Data Secara Manual 

▪ Klik sel kosong yang tepat berada di bawah kolom ID. Masukkan angka “1” 

dan tekan tombol <Enter> pada keyboard. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

JK. Masukkan huruf “L” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Usia. Masukkan angka “3” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

SEO. Masukkan kata “Menengah” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

Prososial. Masukkan angka “21” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

FL. Masukkan angka “7” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-kanan untuk memindahkan sel aktif ke kolom 

JU. Masukkan angka “4” dan tekan tombol <Enter>. 

▪ Tekan tombol panah-bawah untuk memindahkan sel aktif ke baris 

berikutnya. 

▪ Ulangi langkah pertama untuk memasukkan data kedua dan seterusnya. 
 
Memasukkan Data Secara Copy-Paste 

Jika Anda telah memiliki data dalam bentuk tabel MS-Word, MS-Excel, 

atau yang sejenis lainnya, Anda dapat menyalin (copy) data tersebut dan 

menempelkannya (paste) ke dalam tabel Unpad SAS yang sedang dibuka. 

Untuk keperluan tersebut, pastikan jumlah kolom yang disalin sama 

dengan tabel Unpad SAS dan nilai-nilainya sesuai dengan jenis-data kolom-

kolom tabel Unpad SAS. 

Apabila sudah selesai, simpanlah tabel tersebut dengan nama 

“penelitian_1”. 

 

C. BEKERJA DENGAN DATA 

Pada bagian ini, Anda akan belajar berbagai perintah yang dapat di-

gunakan dalam Unpad SAS untuk mengubah, mentransformasi, dan mem-

perbaiki data yang Anda miliki. Perintah-perintah ini sangat bermanfaat 

terutama apabila Anda memiliki data yang cukup banyak atau variabel yang 

cukup banyak untuk setiap subjek. 
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1. Mengatur Urutan Data 

Perintah ini digunakan ketika Anda ingin mengatur urutan data ber-

dasarkan variabel atau aturan tertentu. Tabel data yang akan digunakan 

adalah tabel “penelitian_1”. Misalnya terhadap data tersebut kita ingin 

mengatur urutan data berdasarkan jenis kelamin. 

Untuk keperluan tersebut, Anda harus melakukan langkah-langkah 

sebagai berikut. 

▪ Buka tabel “penelitian_1”. 

▪ Pilih perintah Data->Sort Cases ... 

 

▪ Atas perintah tersebut maka Anda akan melihat kotak dialog Sort Cases 

ditampilkan. 

 

▪ Pilih variabel yang akan diurutkan. Misalnya JK. 

▪ Klik tombol  untuk menetapkan variabel yang dipilih ke dalam kotak 

“Sort by” 

▪ Klik tombol-radio pada bidang “Sort Order” untuk menetapkan apakah 

data akan diurut secara menaik (ascending) atau menurun (descending). 

▪ Klik tombol <OK> 
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▪ Perhatikan bahwa setelah diurutkan, urutan nomor respondennya (ID) 

berubah, mengikuti jenis kelamin. 

 

 
2. Pemilihan Kasus 

Untuk memilih kasus tertentu dan melakukan analisis secara 

terpisah pada kasus yang sudah dipilih tersebut adalah dengan menggu-

nakan perintah “Select Cases”. 

Contohnya, jika pada data yang telah kita miliki Anda hanya akan 

mengolah data pada kelompok responden yang skor kecenderungan peri-

laku prososialnya adalah 40 ke atas (prososial ≥ 40), maka langkah-

langkahnya adalah sebagai berikut: 

▪ Pilih perintah Data->Select Cases 
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▪ Kotak dialog Select Cases akan ditampilkan. 

 

▪ Pilih “If condition is satisfied”  

▪ Tekan tombol <If>, sehingga muncul kotak dialog “Select cases: If” sebagai 

berikut. 
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▪ Pilih variabel “Kecenderungan perilaku prososial [prososial]” 

▪ Tekan tombol <Continue> dan klik tombol <OK> 
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▪ Data yang tidak terpilih akan dicoret dan berwarna merah, seperti gambar 

di atas. 
 
3. Mengidentifikasi Data Duplikat 

Kasus “duplikat” mungkin terjadi di data Anda karena berbagai alasan, 

termasuk: 

▪ Kesalahan entri data dimana kasus yang sama tidak sengaja masuk lebih 

dari satu kali. 

▪ Beberapa kasus memiliki nilai kode-primer yang sama namun memiliki 

nilai kode-sekunder yang berbeda, seperti anggota keluarga yang semua-

nya tinggal di rumah yang sama. 

▪ Beberapa kasus mewakili kasus yang sama namun dengan nilai yang 

berbeda untuk variabel selain yang mengidentifikasi kasus tersebut, se-

perti beberapa pembelian yang dilakukan oleh orang atau perusahaan 

yang sama untuk produk yang berbeda atau pada waktu yang berbeda. 

Identifikasi Kasus Duplikat memungkinkan Anda menentukan kasus 

duplikat dan memberikan status secara otomatis atas duplikasi kasus dup-

likat tersebut. Sebagai contoh, perhatikan data pada tabel berikut. 

ID JK Umur OlahRaga AsalDaerah 

1 L 13 Renang DKI Jakarta 

2 P 14 Basket Jawa Barat 

3 P 12 Basket Jawa Barat 

4 L 13 Renang DKI Jakarta 

5 P 14 Renang Jawa Barat 

▪ Jika kita ingin mengetahui adanya duplikasi data berdasarkan variabel 

OlahRaga maka secara manual kita dapat mengurut data tersebut berda-

sarkan variabel OlahRaga. Hasilnya adalah sebagai berikut. 

ID JK Umur OlahRaga AsalDaerah Dup 

2 P 14 Basket Jawa Barat 0 

3 P 12 Basket Jawa Barat 0 

1 L 13 Renang DKI Jakarta 0 

4 L 13 Renang DKI Jakarta 0 

5 P 14 Renang Jawa Barat 0 

▪ Variabel Dup kita tambahkan untuk menyimpan status duplikasi data. Nilai 

variabel Dup kita tetapkan 0, yang artinya adalah bahwa variabel OlahRaga 

pada baris tersebut memiliki duplikasi dengan baris lainnya. 
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▪ Jika kita ingin mengetahui adanya duplikasi data berdasarkan variabel 

OlahRaga dan Umur maka secara manual kita dapat mengurut data ter-

sebut berdasarkan variabel OlahRaga dan Umur. Hasilnya adalah sebagai 

berikut. 

ID JK Umur OlahRaga AsalDaerah Dup 

3 P 12 Basket Jawa Barat 1 

2 P 14 Basket Jawa Barat 1 

1 L 13 Renang DKI Jakarta 0 

4 L 13 Renang DKI Jakarta 0 

5 P 14 Renang Jawa Barat 1 

▪ Pada contoh di atas, nilai variabel Dup kita tetapkan 1 untuk menyatakan 

bahwa variabel OlahRaga + Umur pada baris tersebut tidak memiliki dup-

likasi dengan baris lainnya dan kita tetapkan 0 untuk menyatakan bahwa 

variabel OlahRaga + Umur pada baris tersebut memiliki duplikasi dengan 

baris lainnya. 

Untuk keperluan mengidentifikasi data duplikat secara otomatis, Un-

pad SAS menyediakan perintah Data->Identify Duplicate Cases. Lakukan 

langkah-langkah berikut untuk keperluan tersebut. 

▪ Pastikan Anda sedang membuka tabel “penelitian_1”. 

▪ Berikan perintah Data->Identify Duplicate Cases. Atas perintah ini Anda 

akan melihat jendela dialog berikut. 
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▪ Jika Anda bermaksud untuk mengidentifikasi data duplikat untuk variabel 

Prososial (Kecenderungan Perilaku Prososial Anak) maka pilih itu dan 

tetapkan untuk kotak daftar “Define matching cases by:”. 

▪ Jika Anda bermaksud untuk mengatur urutan data, sesudah proses ini, 

berdasarkan variabel Usia, maka pilih itu dan tetapkan untuk kotak daftar 

“Sort within matching group by:”. 

▪ Tetapkan nama variabel untuk menyimpan status duplikasi. Misalnya 

PrimaryFirst.  

▪ Klik <OK> 

Hasil dari perintah tersebut adalah seperti ditunjukkan dalam gambar 

berikut. 
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Pada Data View Anda akan melihat ada variabel baru bernama Pri-

maryFirst dengan nilai 0 atau 1, yang mengindikasikan status duplikasi atas 

kasus tersebut berdasarkan variabel yang ditentukan di atas. 

Variabel yang ditetapkan untuk mengidentifikasai data duplikat boleh 

lebih dari satu. Kasus dianggap duplikat jika nilainya cocok untuk semua 

variabel terpilih. Jika Anda ingin mengidentifikasi hanya kasus yang cocok 

100% dalam semua hal, pilih semua variabel. 

Variabel yang ditetapkan untuk mengatur urutan data boleh lebih dari 

satu. 

▪ Tetapkan itu sesuai kebutuhan agar duplikasi data mudah dilihat secara 

kasat mata. 

▪ Untuk setiap pilihan variabel, Anda dapat menyortir urutan naik atau 

turun. 
 
4. Menghitung Variabel 

Nilai suatu variabel boleh jadi ingin ditetapkan berdasarkan nilai-nilai 

variabel lainnya atau berdasarkan ekspresi tertentu. Variabel tersebut boleh 
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jadi adalah berupa variabel yang telah dibuat sebelumnya atau berupa 

variabel baru. Untuk kebutuhan tersebut Anda dapat menggunakan perintah 

Compute Variables yang terdapat di dalam menu Transform. 

 

Atas perintah tersebut maka Anda akan melihat kotak dialog sebagai 

berikut. 

 

Lakukan langkah-langkah berikut untuk keperluan tersebut: 

▪ Tuliskan nama variabel di dalam ruas Target Variable. Itu boleh berupa 

variabel baru atau variabel yang telah ada sebelumnya. 

▪ Klik tombol  yang berada di sebelahnya. Misalnya Anda menuliskan 

variabel Rata2, maka setelah tombol  di-klik akan Anda lihat tulisan 

Rata2 = di ruas sebelah kanannya. 

▪ Pilih variabel yang akan ditetapkan dan klik tombol  yang berada di 

sebelahnya. 

▪ Klik tombol lambang operasi, angka, dan atau fungsi yang sesuai dengan 

kebutuhan Anda. Misalnya Anda akan menuliskan Rata2 = (UAS + UTS)/2 
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▪ Klik tombol <Continue> untuk menetapkan ekspresi tersebut ke dalam 

variabel yang ditetapkan. 

 

D. MENGIMPOR DAN MENGEKSPOR TABEL 

Sampai saat ini Unpad SAS baru dapat mengimpor dan mengekspor 

tabel dari dan ke dalam file teks yang berisi tabel data dengan simbol pe-

misah berupa tabulator (tab delimited) atau berupa skrip SQL. 
 
1. File Teks Tab delimited 

File-file teks tab delimited dapat dibuat secara manual atau file-file 

Microsoft Excel yang direkam sebagai file teks tab delimited. Baris pertama 

file teks tersebut harus berupa nama-nama variabel yang dipisahkan oleh 

simbol tab, dan baris-baris berikutnya berupa nilai untuk variabel-variabel 

tersebut yang juga dipisahkan oleh simbol tabs. Jangan lupa, variabel per-

tama harus bernama ID (lihat subbab B.3 di atas). Atribut Type, Width, 

Columns, dan Align untuk masing-masing variabel akan ditetapkan secara 

otomatis sesuai dengan nilai-nilai yang ditetapkan pada baris-baris beri-

kutnya. 

Berikut ini Anda dapat mencoba membuat file teks tab delimited se-

cara manual. Jalankan aplikasi Notepad atau aplikasi penyunting teks lain-

nya. 

▪ Pada baris pertama, tuliskan nama variabel ID, SMA, JALUR, KUOTA, dan 

PENDAFTAR. Gunakan tombol tab sebagai pemisah antara nama-nama 

variabel tersebut, yaitu seperti contoh berikut. 

ID SMA JALUR KUOTA PENDAFTAR 

1 1 1 3 1 

2 2 1 2 1 

3 3 1 0 0 

4 4 1 3 0 

5 5 1 0 0 

6 6 1 2 2 

7 7 1 2 1 

8 8 1 3 0 

9 9 1 5 1 

10 10 1 5 0 

11 11 1 0 4 

12 12 1 3 0 

13 13 1 0 0 

14 14 1 0 0 

15 15 1 3 0 



MANAJEMEN BASISDATA 

31 

16 16 1 3 0 

17 17 1 1 0 

18 18 1 5 0 

19 19 1 1 0 

20 20 1 4 0 

▪ Pada baris kedua dan seterusnya, tuliskan nilai-nilai untuk setiap variabel. 

Gunakan tombol tab sebagai pemisah antara nilai-nilai tersebut, yaitu 

seperti contoh di atas. 

▪ Rekam itu dengan nama “contoh.txt”. 

File “contoh.txt” tersebut merupakan file teks tab delimited dan dapat 

Anda impor dari Unpad SAS. 
 
2. File skrip SQL 

File skrip SQL berisi perintah-perintah SQL yang dapat dijalankan oleh 

MySQL. Setiap tabel data Unpad SAS secara internal terdiri dari 2 (dua) buah 

tabel, yaitu: 

▪ Tabel struktur –  terdiri dari kolom ID, Name, Type, Width, Dec, Label, 

Values, Missing, Columns, Align, dan Measure. Nama tabel struktur diawali 

dengan tulisan “st_” dan diikuti oleh nama untuk tabel datanya. Misalnya, 

jika Anda bermaksud membuat tabel data dengan nama “contoh”, maka 

nama tabel strukturnya adalah “st_contoh”. 

Perhatikan contoh perintah Data Definition Language (DDL) untuk mem-

buat tabel struktur untuk tabel data bernama “contoh”. 

CREATE TABLE `st_contoh` ( 

  `ID` smallint(6) NOT NULL, 

  `Name` varchar(50) DEFAULT NULL, 

  `Type` tinyint(4) DEFAULT NULL, 

  `Width` tinyint(4) DEFAULT NULL, 

  `Dec` tinyint(4) DEFAULT NULL, 

  `Label` varchar(255) DEFAULT NULL, 

  `Values` text, 

  `Missing` varchar(200) DEFAULT NULL, 

  `Columns` tinyint(4) DEFAULT NULL, 

  `Align` tinyint(4) DEFAULT NULL, 

  `Measure` tinyint(4) DEFAULT NULL 

) ENGINE=MyISAM DEFAULT CHARSET=latin1; 

Variabel-variabel untuk tabel data ditetapkan pada setiap baris data tabel 

struktur dengan ketentuan baris pertama data tabel struktur adalah untuk 

variabel ID pada tabel data dan baris-baris berikutnya adalah untuk va-

riabel-variabel lainnya. 
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Perhatikan pula contoh perintah Data Manipulation Language (DML) 

untuk menetapkan variabel. 

INSERT INTO `st_contoh` (`ID`, `Name`, `Type`, `Width`, `Dec`, 

`Label`, `Values`, `Missing`, `Columns`, `Align`, `Measure`) 

VALUES  

  (1,'ID',0,8,0,'','','',8,1,0), 

  (2,'Metode',0,8,3,NULL,'1=\"Praktikum\"\r\n2=\"Teori\"\r\n', 

  NULL,15,1,0), 

  (3,'Rangking',0,8,3,NULL,NULL,NULL,15,1,2); 

Nilai untuk kolom ID adalah 1, 2, dan seterusnya yang menunjukkan urut-

an kolom variabel tersebut di dalam tabel data. 

Nilai untuk kolom Type adalah 0=Numeric, 4=Date, dan 7=String. 

Nilai untuk kolom Align adalah 0=Left, 1=Right, dan 2=Center. 

Nilai untuk kolom Measure adalah 0=Nominal, 1=Ordinal, dan 2=Scale. 

▪ Tabel data – terdiri dari n+1 kolom, dimana n adalah jumlah variabel yang 

ditetapkan ke dalam tabel struktur. Kolom pertama adalah S. Nilai kolom 

ini digunakan Unpad SAS sebagai tanda untuk kasus yang dipilih atau 

tidak. (Lihat C.2). Kolom kedua dan seterusnya adalah nama-nama variabel 

sesuai dengan yang ditetapkan ke dalam tabel struktur. 

Sebagai contoh, di atas ditunjukkan bahwa variabel-variabel yang dite-

tapkan untuk tabel struktur adalah ID, Metode, dan Rangking, maka pe-

rintah Data Definition Language (DDL) untuk membuat tabel data bernama 

“contoh” adalah sebagai berikut. 

CREATE TABLE `contoh` ( 

  `S` tinyint(4) DEFAULT '1', 

  `ID` double(8,0) DEFAULT NULL, 

  `Metode` double(8,3) DEFAULT NULL, 

  `Rangking` double(8,3) DEFAULT NULL, 

  UNIQUE KEY `ID` (`ID`) 

) ENGINE=MyISAM DEFAULT CHARSET=latin1; 

Berikut ini adalah contoh perintah Data Manipulation Language (DML) 

untuk menetapkan menambahkan 10 baris data untuk tabel “contoh”. 

INSERT INTO `contoh` (`S`, `ID`, `Metode`, `Rangking`) VALUES  

  (1,1,1.000,16.000), 

  (1,2,1.000,4.000), 

  (1,3,1.000,5.000), 

  (1,4,1.000,2.000), 

  (1,5,1.000,1.000), 

  (1,6,1.000,12.000), 

  (1,7,1.000,11.000), 

  (1,8,1.000,13.000), 
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  (1,9,1.000,23.000), 

  (1,10,1.000,8.000); 

 
3. Mengimpor Tabel 

Lakukan langkah-langkah berikut untuk mengimpor file/tabel. 

▪ Klik menu File, pilih submenu Import Table, seperti ditunjukkan pada 

gambar di bawah ini. 

  

▪ Atas perintah tersebut maka akan ditampilkan kotak dialog seperti di-

tunjukkan pada gambar di bawah ini. 

 

• Tetapkan jenis file pada ruas “File of type” untuk memfilter daftar file 

yang akan dipilih. 
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• Pilih file yang akan di-impor dari daftar yang tersedia dan klik tombol 

<Open>. 

▪ Atas perintah tersebut maka akan ditampilkan jendela Import Table , yaitu 

seperti ditunjukkan pada gambar di bawah ini. 

 

Jika itu berupa file teks tab delimited. Atau 
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Jika itu berupa file skrip SQL. 

▪ Untuk mengimpor data atau skrip tersebut maka klik tombol berikut. 

 

digunakan untuk membuat tabel baru. Pastikan baris pertama ada-

lah berupa nama-nama variabel dan baris selebihnya adalah berupa 

nilai-nilai untuk variabel tersebut. 

 

digunakan untuk menambahkan nilai-nilai ke dalam tabel yang 

sedang dibuka. Pastikan baris pertama adalah berupa nama-nama 

variabel yang sesuai dengan tabel yang sedang dibuka, dan baris 

selebihnya adalah berupa nilai-nilai untuk variabel tersebut. 

 

digunakan untuk membuat tabel baru berdasarkan skrip yang 

diberikan. 
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4. Mengekspor Tabel 

Lakukan langkah-langkah berikut untuk mengimpor file/tabel. 

▪ Klik menu File, pilih submenu Export Table, seperti ditunjukkan pada 

gambar di bawah ini. 

  

▪ Atas perintah tersebut maka akan ditampilkan kotak dialog seperti di-

tunjukkan pada gambar di bawah ini. 

 

• Tetapkan jenis file pada ruas “File of type” untuk memfilter daftar file 

yang akan dipilih. 
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• Pilih atau tulis nama file yang akan di-impor dari daftar yang tersedia 

dan klik tombol <Open>. 

 

E. LATIHAN 

Fakultas Psikologi Universitas XYZ melakukan penelitian pada 40 

orang mahasiswa angkatan 2015 yang mengambil mata kuliah Statistika I 

dengan hasil data berikut. 
 

N
O

 

JK
 

IQ
 

S
A

M
 SKOR ITEM TASK COMMITMENT 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 

1 L 118 T 3 4 4 4 4 4 4 3 3 4 4 4 4 4 4 3 

2 P 110 S 2 4 4 3 3 4 3 2 3 3 3 4 3 4 3 4 

3 L 113 T 3 3 3 4 3 3 2 2 3 3 2 4 3 4 3 3 

4 P 110 T 2 4 3 3 4 3 2 1 3 3 3 4 1 3 4 3 

5 L 113 S 3 4 4 4 4 4 3 2 4 4 3 4 3 4 4 3 

6 L 118 S 3 4 4 4 3 4 3 2 3 4 4 4 4 4 4 3 

7 L 123 S 3 4 4 3 2 4 4 2 4 3 4 4 3 4 4 3 

8 L 121 T 3 4 4 3 3 4 2 2 4 3 1 4 4 4 4 3 

9 P 116 S 2 4 4 3 4 4 3 2 4 2 3 4 4 4 4 3 

10 P 119 R 4 3 4 3 4 4 2 3 4 4 3 4 3 4 3 3 

11 P 116 R 3 4 4 3 2 4 2 2 4 4 3 4 4 4 3 4 

12 L 119 T 2 3 2 3 4 3 1 2 3 4 1 4 4 3 4 3 

13 P 116 T 3 4 3 3 4 3 3 3 3 3 4 4 4 4 3 4 

14 L 123 R 3 3 3 3 2 3 3 2 3 2 3 3 3 3 3 3 

15 P 125 T 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 

16 L 110 S 2 3 3 3 2 3 2 1 2 2 2 3 3 3 2 2 

17 L 113 S 2 4 3 3 3 4 3 3 3 3 3 4 4 4 2 3 

18 L 123 R 3 4 3 3 3 3 4 2 3 3 3 4 3 4 3 3 

19 L 120 S 3 4 4 4 4 3 4 3 4 3 3 4 3 3 4 3 

20 P 126 R 3 4 4 4 3 4 3 3 3 3 4 4 4 4 3 2 
 

Keterangan: 

▪ Jenis Kelamin: terdiri dari laki-laki (L) dan perempuan (P) 

▪ Kecemasan terhadap Statistika diukur melalui SAM (Statistics Anxiety 

Measure), dimana hasil pengukurannya dapat dikategorikan menjadi 

R=Rendah, S=Sedang dan T=Tinggi 

▪ Skor item Task Commitment adalah skor komitmen murid terhadap tugas 

yang diberikan padanya, yang diukur melalui 16 item dan masing-masing 

item merupakan pernyataan dengan 4 pilihan jawaban. Jawaban di-skor 

sebagai berikut: Selalu=4, Sering=3, Kadang-kadang=2, dan Tidak per-

nah=1. 
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Dari data yang didapatkan, lakukanlah hal-hal berikut: 

1. Input data 

2. Urutkanlah data berdasarkan variabel di bawah ini: 

a. Jenis kelamin 

b. IQ (dari besar ke kecil) 

3. Pilihlah data dari peserta yang memiliki IQ yang lebih rendah dari 125 

4. Hitunglah skor total Task Commitment 

 



 

39 

2 
Statistik Deskriptif 

 

 

A. PENDAHULUAN 

Dalam kegiatan penelitian, data yang kita peroleh melalui survey, sen-

sus, atau sumber-sumber lain biasanya masih bersifat mentah (raw data). 

Dengan menggunakan statistik deskriptif, maka kita dapat memberikan 

gambaran dari suatu data mentah dengan lebih ringkas dan teratur. Hal ter-

sebut dapat kita lakukan dengan menggunakan tabel atau diagram. Ber-

dasarkan tampilan tabel atau diagram tersebut, kita dapat menganalisis data 

yang diperoleh. 

Selain menggunakan tabel atau diagram, dalam statistik deskriptif kita 

juga dapat mendeskripsikan suatu data melalui ukuran statistik atau yang 

biasa dikenal dengan istilah summary statistics (ringkasan statistik). Ada be-

berapa ukuran yang biasa digunakan dalam statistik deskriptif, yaitu: 

1. Ukuran gejala pusat: Mean dan Modus. 

2. Ukuran letak atau posisi: Median, Kuartil, Desil, dan Persentil. 

3. Ukuran dispersi: Index of Qualitative Variation, Range, Interquartile 

Range, Semi Interquartile Range, Standar deviasi, dan Varians. 

4. Ukuran distribusi: Skewness dan Kurtosis. 

Untuk menampilkan tabel dan ukuran statistik, dalam Unpad SAS di-

sediakan submenu Descriptive Statistics (di dalam menu Analyze) yang ter-

diri dari perintah Frequencies, Descriptive, Explore, dan Crosstabs. 

 

B. FREQUENCIES 

Frequencies menampilkan tabel frekuensi dan ringkasan statistik dari 

suatu variabel. Ringkasan yang ditampilkan antara lain berupa ukuran gejala 

pusat, ukuran letak, ukuran dispersi, dan ukuran distribusi. 
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Contoh 2.1: 

Suatu penelitian dilakukan untuk mengetahui faktor-faktor yang berhu-

bungan dengan penguasaan materi mata kuliah Statistika pada mahasiswa 

Fakultas MIPA Universitas Siswa Bangsa. Faktor-faktor yang diduga ber-

hubungan dengan penguasaan materi Statistika adalah tingkat kecerdasan 

(IQ), sikap mahasiswa terhadap Statistika (SATS), dan kecemasan terhadap 

Statistika (SAM). Berikut ini adalah data penelitian yang diperoleh: 
 

NO UAS UTS IQ SATS SAM JK  NO UAS UTS IQ SATS SAM JK 

1 50 70 118 68 3 1  16 65 75 110 98 2 1 

2 50 70 110 65 2 1  17 65 80 113 90 2 1 

3 55 75 113 60 3 1  18 70 85 123 80 1 1 

4 55 75 110 70 3 1  19 70 90 120 102 2 1 

5 55 70 113 86 2 1  20 70 90 126 107 1 1 

6 60 75 118 89 2 1  21 70 70 118 98 1 2 

7 60 70 123 90 2 1  22 70 70 126 90 2 2 

8 60 70 121 80 3 1  23 75 75 120 80 2 2 

9 60 70 116 98 2 1  24 75 80 120 85 2 2 

10 60 80 119 97 1 1  25 75 85 123 85 1 2 

11 65 80 116 89 1 1  26 75 90 121 80 1 2 

12 65 85 119 85 3 1  27 75 90 128 100 1 2 

13 65 85 116 95 3 1  28 75 95 130 105 2 2 

14 65 85 123 100 1 1  29 80 95 130 110 1 2 

15 65 80 125 100 3 1  30 80 90 129 107 2 2 
 

Keterangan: 

▪ Penguasaan materi Statistika diukur dengan Nilai UTS dan UAS Statistika 

▪ Tingkat kecerdasan mahasiswa diukur dengan IQ 

▪ Sikap terhadap Statistika diukur melalui SATS (Student Attitude toward 

Statistics) dimana SATS merupakan alat ukur yang terdiri dari 30 per-

nyataan dengan skala penilaian sebagai berikut: 1=sangat tidak setuju, 

2=tidak setuju, 3=setuju, dan 4=sangat setuju. 

▪ Kecemasan terhadap Statistika diukur melalui SAM (Statistics Anxiety 

Measure) dimana hasil pengukurannya dapat dikategorikan menjadi ting-

katan berikut ini: 1=Rendah, 2=Sedang, dan 3=Tinggi. 

▪ JK = Jenis kelamin (1=Laki-laki, 2=Perempuan) 

Masalah 1: 

Peneliti ingin melihat jumlah responden pada masing-masing kategori Jenis 

Kelamin dan SAM. Selain itu, ia juga ingin menampilkan diagram batang 

untuk masing-masing kategori berdasarkan frekuensinya. 
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Untuk keperluan tersebut lakukan langkah-langkah sebagai berikut. 

1. Buat berkas dengan nama file datasiswa menggunakan data di atas. 

2. Pilih perintah Analyze->Descriptive Statistics->Frequencies 

 

3. Pilih variabel JK dan SAM seperti pada gambar di bawah ini. 

  

4. Beri tanda contreng pada “Display frequency tables”. 

5. Klik tombol Chart... untuk menampilkan kotak dialog Frequencies: 

Charts. 

 

5. Pilih tombol Bar charts dan klik tombol <Continue>. 

6. Klik tombol <OK>. 
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Luaran yang dihasilkan adalah sebagai berikut. 
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Masalah 2: 

Peneliti ingin mengetahui ukuran gejala pusat, ukuran letak, ukuran dispersi, 

dan ukuran distribusi dari variabel yang skala pengukurannya sesuai dengan 

ukuran yang akan dihitung (misal: mean dari variabel Nilai UAS, IQV dari 

variabel JK, dsb). Selain itu, ia juga ingin menghitung setiap ukuran dengan 

rumus secara manual dan menggunakan Program Unpad SAS. 
 
Berikut ini adalah langkah-langkah pengerjaannya: 
 
1. Ukuran gejala pusat 

Ukuran gejala pusat yang dapat digunakan untuk mewakili himpunan data 

diberikan dalam tabel berikut: 
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No. Skala Pengukuran Ukuran GejalaPusat 

1 Nominal Modus 

2 Ordinal Median dan Modus 

3 Interval atau Rasio Mean, Median dan Modus 
 
Penghitungan ukuran gejala pusat secara manual. 

a. Mean (rata-rata nilai) 

 Mean adalah suatu nilai pusat (keseimbangan) untuk suatu variabel 

kontinu. Mean populasi disimbolkan dengan µ, sedangkan mean sampel 

disimbolkan dengan 𝑥̅. Penghitungan rata-rata dilakukan dengan men-

jumlahkan seluruh nilai data suatu kelompok sampel, kemudian dibagi 

dengan ukuran sampel tersebut. Jadi jika suatu sampel acak dengan 

ukuran sampel n, maka bisa dihitung rata-rata dari sampel tersebut 

dengan rumus sebagai berikut: 

𝑥̅ =  
𝑥1 + 𝑥2 + ⋯ + 𝑥𝑛

𝑛
 

dimana: 

𝑥̅ = rata-rata hitung;  

𝑥𝑖  = nilai sampel ke-i;  

n = jumlah sampel 

Data UAS dapat juga disajikan seperti dalam tabel berikut: 
 

UAS Frekuensi 

50 2 

55 3 

60 5 

65 7 

70 5 

75 6 

80 2 

Berikut ini adalah penghitungan mean variabel UAS: 

𝑥̅ =  
50 + 50 + 55 + ⋯ + 75 + 80 + 80

30
 

𝑥̅ =  
1980

30
 

𝑥̅ =  66,0 
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b. Median  

Median adalah nilai yang terletak di tengah dari suatu kumpulan data yang 

sudah diurutkan dari kecil ke besar. Penghitungan median dilakukan 

dengan cara sebagai berikut. 

▪ Urutkan data mulai dari nilai terkecil sampai nilai terbesar. Pengaturan 

urutan terhadap variabel UAS adalah sebagai berikut. 

50 50 55 55 55 60 60 60 60 60 65 65 65 65 65 65 65 70 70 70 70 70 75 75 75 75 75 75 80 80 

▪ Nilai median dihitung menurut rumus Me = x(n+1)/2 

▪ Dalam contoh di atas, jumlah sampel adalah 30, maka Me = x(30+1)/2 atau 

Me = x15,5 atau Me berada di antara x15 dan x16. 

▪ Nilai Me dihitung dengan menjumlahkan x15 dan x16 kemudian dibagi 2. 

Me = (65 + 65) / 2 atau Me = 65 

▪ Data UAS dapat juga disajikan seperti dalam tabel berikut: 

UAS Frekuensi Frekuensi Kumulatif 

50 2 2 

55 3 5 

60 5 10 

65 7 17 

70 5 22 

75 6 28 

80 2 30 

▪ Median terletak pada urutan di antara x15 dan x16. 

▪ Me = 65 
 
c. Modus 

Modus adalah nilai yang paling banyak muncul atau nilai yang memiliki 

frekuensi paling tinggi dari suatu kelompok data. Suatu kelompok data 

yang memiliki hanya satu modus disebut unimodal, kelompok data yang 

mempunyai dua modus disebut bimodal, kelompok data yang memiliki 

lebih dari dua modus disebut multimodal, sementara kelompok data 

yang tidak memiliki modus disebut sebagai no mode. 

 Penghitungan modus dilakukan dengan cara sebagai berikut. 

▪ Buatlah distribusi data untuk variabel yang dimaksud. Untuk variabel 

UAS distribusi datanya adalah sebagai berikut. 
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UAS Frekuensi 

50 2 

55 3 

60 5 

65 7 

70 5 

75 6 

80 2 

▪ Dari distribusi data tersebut terlihat bahwa frekuensi yang paling besar 

adalah 7. Jadi modus variabel UAS adalah 65. 
 
Penghitungan ukuran gejala pusat dengan menggunakan Unpad SAS. 

▪ Buka file data_mahasiswa pada program Unpad SAS Anda. 

▪ Pilih perintah Analyze->Descriptive Statistics->Frequencies 

▪ Pilih variabel Nilai UAS seperti pada gambar di bawah ini. 

  

▪ Untuk memilih ukuran statistik, maka Klik Statistics … 
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▪ Untuk menghitung ukuran gejala pusat maka beri tanda contreng pada 

Mean, Median, dan Modus seperti gambar di atas. 

▪ Klik <Continue>, kemudian klik <OK>. Setelah itu akan muncul luaran 

seperti gambar di bawah ini. 
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Ternyata kita dapat melihat bahwa penghitungan ukuran gejala pusat (mean, 

median, dan modus) dari variabel UAS secara manual dan Unpad SAS me-

nunjukkan hasil yang sama, yaitu Mean=66,0, Median=65,0, dan Modus= 

65,0. 
 
2. Ukuran Letak atau Posisi 

Penghitungan ukuran letak secara manual. 

a. Kuartil  (Quartile) 

 Kuartil adalah data yang membagi posisi sekumpulan data yang telah 

diurutkan dari kecil ke besar, menjadi empat bagian. Dalam satu urutan 

data terdapat 3 kuartil, yaitu kuartil bawah, kuartil tengah, dan kuartil 

atas. 

 
Cara menentukan kuartil adalah sebagai berikut. 

▪ Kuartil bawah adalah data pada posisi ¼ dari kumpulan data yang telah 

diurutkan. Kuartil bawah disimbolkan dengan Q1. 
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▪ Kuartil tengah adalah data pada posisi 2/4 dari kumpulan data yang 

telah diurutkan. Kuartil tengah sama dengan median. Kuartil tengah 

disimbolkan dengan Q2. 

▪ Kuartil atas adalah data pada posisi ¾ dari kumpulan data yang telah 

diurutkan. Kuartil atas disimbolkan dengan Q3. 

▪ Posisi atau Letak kuartil dihitung berdasarkan rumus 

𝑄𝑖  =  𝑥𝑖(𝑛+1)/4 

dimana: 

i = indeks kuartil yaitu 1, 2, 3 

n = banyaknya data 

▪ Berikut ini adalah penghitungan posisi kuartil untuk variabel UAS. 

𝑄1 =  𝑥1(30+1)/4  = 𝑥 31/4  =  𝑥7,75 

𝑄2 =  𝑥2(30+1)/4  = 𝑥 62/4  =  𝑥15,5 

𝑄3 =  𝑥3(30+1)/4  = 𝑥 93/4  =  𝑥23,25 

atau 

Posisi Q1= 7,75 

Posisi Q2= 15,50 

Posisi Q3= 23,25 

▪ Berdasarkan posisi kuartil pada urutan data maka dapat ditentukan 

ketiga kuartilnya, yaitu: 

50 50 55 55 55 60 60 60 60 60 65 65 65 65 65 65 65 70 70 70 70 70 75 75 75 75 75 75 80 80 

▪ Jadi, Q1 adalah 60, Q2 adalah 65, dan Q3 adalah 75. 

b. Desil (Decile) 

Desil adalah data yang membagi posisi sekumpulan data yang telah 

diurutkan dari kecil ke besar menjadi sepuluh bagian. Dalam satu urutan 

data terdapat 9 desil, masing masing disebut D1 sampai D9. 

Cara menentukan desil adalah sebagai berikut. 

▪ Posisi atau Letak desil dihitung berdasarkan rumus 

𝐷𝑖  =  𝑥𝑖(𝑛+1)/10 

dimana: 

i = indeks desil yaitu 1, 2, 3, 4, 5, 6, 7, 8, 9 

n = banyaknya data 

▪ Berikut ini adalah penghitungan posisi desil untuk variabel UAS. 



BELAJAR STATISTIKA DENGAN UNPAD SAS 

50 

𝐷1 =  𝑥1(30+1)/10  = 𝑥31/10  =  𝑥3,1 
𝐷2 =  𝑥2(30+1)/10  = 𝑥62/10  =  𝑥6,2 
𝐷3 =  𝑥3(30+1)/10  = 𝑥93/10  =  𝑥9,3 
𝐷4 =  𝑥4(30+1)/10  = 𝑥124/10  =  𝑥12,4 
𝐷5 =  𝑥5(30+1)/10  = 𝑥155/10  =  𝑥15,5 
𝐷6 =  𝑥6(30+1)/10  = 𝑥186/10  =  𝑥18,6 
𝐷7 =  𝑥7(30+1)/10  = 𝑥217/10  =  𝑥21,7 
𝐷8 =  𝑥8(30+1)/10  = 𝑥248/10  =  𝑥24,8 

𝐷9 =  𝑥9(30+1)/10  = 𝑥279/10  =  𝑥27,9 
atau 

Posisi D1= 3,1 

Posisi D2= 6,2 

Posisi D3= 9,3 

Posisi D4= 12,4 

Posisi D5= 15,5 

Posisi D6= 18,6 

Posisi D7= 21,7 

Posisi D8= 24,8 

Posisi D9= 27,9 

▪ Berdasarkan posisi desil pada urutan data maka dapat ditentukan 

kesembilan desilnya, yaitu: 

50 50 55 55 55 60 60 60 60 60 65 65 65 65 65 65 65 70 70 70 70 70 75 75 75 75 75 75 80 80 

▪ Jadi, D1 adalah 55, D2 adalah 60, dan D3 adalah 60, D4 adalah 65, D5 

adalah 65, D6 adalah 70, D7 adalah 70, D8 adalah 75, dan D9 adalah 75. 

c. Persentil (Percentile) 

Persentil adalah data yang membagi posisi sekumpulan data yang telah 

diurutkan dari kecil ke besar menjadi seratus bagian. Dalam satu data, 

terdapat 99 persentil. Posisi Persentil dapat dirumuskan sebagai berikut: 

𝑃𝑖 =  
𝑖(𝑛 + 𝑖)

100
 

dimana: 

Pi  = persentil ke-i 

i = indeks persentil yaitu angka 1-99 

n = jumlah data 
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Contohnya, ketika kita ingin mencari tahu nilai persentil ke-50 dan ke-60 

dari UAS statistika, maka letak P50 dan P60 dapat dihitung dengan: 

Posisi P50 = 50(30+1)/100 = 15,5 

Posisi P60 = 60(30+1)/100 = 18,6 

Berdasarkan urutan, Persentil ke-50 dan ke-60 adalah: 

50 50 55 55 55 60 60 60 60 60 65 65 65 65 65 65 65 70 70 70 70 70 75 75 75 75 75 75 80 80 
 
Penghitungan ukuran letak dengan menggunakan Unpad SAS 

▪ Buka file datasiswa. 

▪ Pilih perintah Analyze->Descriptive Statistics->Frequencies 

▪ Pilih variabel Nilai UAS seperti pada gambar di bawah ini. 

 

▪ Untuk memilih ukuran statistik, maka Klik Statistics … 
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▪ Untuk menghitung ukuran letak maka beri tanda contreng pada Quartile, 

Decile, dan Percentile seperti gambar di atas. 

▪ Klik Continue, kemudian klik OK. Setelah itu akan muncul luaran seperti 

gambar di bawah ini. 
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Ternyata kita dapat melihat bahwa penghitungan ukuran letak (kuartil dan 

desil) dari variabel UAS secara manual dan Unpad SAS menunjukkan hasil 

yang sama, baik posisi maupun nilainya, seperti dapat dilihat pada peng-

hitungan di atas. 
 
3. Ukuran Dispersi 

Ukuran dispersi yang dapat digunakan untuk mewakili himpunan data 

diberikan dalam tabel berikut: 
 

No Skala Pengukuran Ukuran Dispersi 

1 Nominal Index of Qualitative Variations 

2 Ordinal Range, Inter Quartile Range, Semi Inter Quartile Range, Index of 
Qualitative Variations 

3 Interval/Rasio Standar Deviasi, Varians, Range, Inter Quartile Range, Semi Inter 
Quartile Range, Index of Qualitative Variations 

 
Penghitungan ukuran dispersi secara manual 

a. Varians 

Varians merupakan rata-rata dari kuadrat jarak setiap nilai data dari nilai 

mean (𝑥̅). Varians populasi disimbolkan dengan 𝜎2 sedangkan Varians 

Sampel disimbolkan oleh s2. Varians dihitung dengan rumus sebagai 

berikut. 

𝑠2 =  
∑ (𝑥𝑖 − 𝑥̅)2𝑛

𝑖=1

𝑛 − 1
 

dimana: 

𝑠2
 = varians 

𝑥𝑖 = nilai x yang ke-i 

𝑥̅ = rata-rata 

n = jumlah data 
 

Berikut ini adalah penghitungan varians UAS Statistika. 

𝑠2 =  
(50 − 66)2 + (50 − 66)2 + ⋯ + (80 − 66)2 + (80 − 66)2

29
 

𝑠2 =  
256 + 256 + ⋯ + 196 + 196

29
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𝑠2 =  
2020

29
 

𝑠2 =  69,6552 

 
b. Simpangan Baku (Standar Deviasi) 

Simpangan baku merupakan akar dari varians. Simpangan baku populasi 

disimbolkan dengan 𝜎 sedangkan simpangan baku sampel disimbolkan 

oleh s. Simpangan baku dihitung dengan rumus sebagai berikut. 

𝜎 = √𝜎2 

𝑠 = √𝑠2 

Berikut ini adalah penghitungan simpangan baku untuk variabel UAS. 

𝑠 = √69,6552 

𝑠 = 8,3460 

 
c. Nilai minimun, Nilai Maksimum, dan Range 

▪ Nilai minimum adalah nilai terkecil dan nilai maksimum adalah nilai 

terbesar dari variabel tertentu. Untuk variabel UAS di atas, nilai mini-

mum adalah 50 dan nilai maksimum adalah 80. 

▪ Range adalah selisih nilai maksimum dengan nilai minimum dari 

variabel tertentu. 

R = Nilai maksimum – Nilai minimum 

▪ Untuk variabel UAS di atas, nilai range adalah: 

R = 80 – 50 

R = 30 
 
d. Standard Error of Mean 

▪ Standard Error of Mean adalah ukuran seberapa jauh nilai mean ber-

variasi dari satu sampel ke sampel lainnya yang diambil dari distribusi 

yang sama. 

▪ Standard Error of Mean dihitung menurut rumus 

𝑆𝐸 =  
𝑠

√𝑛
 

Untuk variabel UAS di atas, nilai SE adalah: 

𝑆𝐸 =  
8,3460

√30
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𝑆𝐸 =  1,5238 

 
e. Interquartile Range 

▪ IR (interquartile range) digunakan untuk menghitung ukuran penyim-

pangan untuk data ordinal. IR dihitung menurut rumus: 

IR = Q3 - Q1 

▪ Untuk variabel UAS di atas, nilai IR adalah: 

IR = 75 – 60 

IR = 15 
 
f. Semi-Interquartile Range 

▪ Semi-Interquartile Range dihitung menurut rumus: 

SIR = ½(Q3 - Q1) 

▪ Untuk variabel UAS di atas, nilai SIR adalah: 

SIR = ½(75-60) 

SIR = ½(15) 

SIR = 7,5 
 
g. Index of Qualitative Variation 

▪ Selanjutnya, dalam penghitungan ukuran dispersi terdapat satu istilah 

lagi, yaitu Index of Qualitative Variation (IQV). Penghitungan IQV adalah 

salah satu keunggulan Unpad  SAS yang  tidak  ada  dalam program  sta-

tistika lainnya, termasuk SPSS. IQV merupakan penghitungan ukuran 

dispersi untuk data yang bersifat nominal. Penghitungan IQV berda-

sarkan rasio dari jumlah perbedaan dalam suatu distribusi dengan ke-

mungkinan terbesar perbedaan dalam distribusi tersebut. Nilai yang 

dihasilkan memiliki rentang dari 0 sampai 1. IQV dihitung menurut 

rumus: 

𝐼𝑄𝑉 =
𝐾(1002 − ∑ 𝑃𝑐𝑡𝑖

2𝐾
𝑖=1 )

1002(𝐾 − 1)
 

dimana: 

K = jumlah kelas 

Pcti = persentasi kelas yang ke-i 

i = nomor kelas 
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▪ Berikut adalah penghitungan IQV untuk variabel Jenis Kelamin secara 

manual. 
 

JK Frekuensi Persen 

1 20 66,6667% 

2 10 33,3333% 

 

𝐼𝑄𝑉 =
2(1002 − (66,66672 + 33,33332)

1002(1)
 

𝐼𝑄𝑉 = 0,8889 

 
Penghitungan ukuran dispersi menggunakan Unpad SAS 

▪ Buka file datasiswa pada program Unpad SAS Anda. 

▪ Pilih perintah Analyze->Descriptive Statistics->Frequencies 

▪ Pilih variabel UAS seperti pada gambar di bawah ini. 

 

▪ Untuk memilih ukuran statistik, maka Klik Statistics … 
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▪ Klik <Continue>, kemudian klik <OK>. Setelah itu akan muncul luaran 

seperti gambar di bawah ini. 

 
 

Ternyata kita dapat melihat bahwa penghitungan ukuran dispersi dari 

variabel UAS secara manual dan program Unpad SAS menunjukkan hasil 

yang sama, seperti dapat dilihat pada penghitungan di atas. 
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Penghitungan IQV menggunakan Unpad SAS 

▪ Buka file datasiswa pada program Unpad SAS Anda. 

▪ Pilih perintah Analyze->Descriptive Statistics->Frequencies 

▪ Pilih variabel JK seperti pada gambar di bawah ini. 

 

▪ Untuk memilih ukuran statistik, maka Klik Statistics … 

 

▪ Klik <Continue>, kemudian klik <OK>. Setelah itu akan muncul luaran 

seperti gambar di bawah ini. 
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Ternyata kita dapat melihat bahwa penghitungan ukuran dispersi IQV 

dari variabel JK secara manual dan program Unpad SAS menunjukkan hasil 

yang sama, seperti dapat dilihat pada penghitungan di atas. 
 
4. Ukuran Distribusi 

Penghitungan ukuran distribusi secara manual. 

1. Skewness (kemiringan) 

Skewness (kemiringan) suatu kurva dapat dillihat dari perbedaan letak 

mean, median, dan modusnya. Ukuran kemiringan data terbagi atas 3 bagian, 

yaitu : 

▪ Kemiringan data ke arah kiri (negatively skewed) dimana nilai modus > 

median > mean 

▪ Kemiringan data simetris dimana nilai modus = median = mean  

▪ Kemiringan data ke arah kanan (positively skewed) dimana nilai modus < 

median < mean. 

 

Gambar 2.1: 
Grafik Kemiringan  

Ada beberapa rumus yang digunakan dalam perhitungan skewness, yaitu: 

▪ Skewness Pearson I: 

𝑠𝑘 =
𝑥̅ − 𝑀𝑜

𝑠
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▪ Skewness Pearson II: 

𝑠𝑘 =
∑ (𝑥𝑖 − 𝑥̅)3𝑛

𝑖=1

𝑛𝑠3
 

▪ Skewness Bowley: 

𝑠𝑘 =
𝑄3 − 2𝑄2 + 𝑄1

𝑄3 − 𝑄1
 

▪ Skewness Percentile: 

𝑠𝑘 =
𝑃90 − 2𝑃50 + 𝑃10

𝑃90 − 𝑃10
 

▪ Skewness Moment: 

𝛼3 =
𝑀3

𝑠3
=

1

2
∑ (𝑥𝑖 − 𝑥̅)3𝑓𝑖

𝑘
𝑖=1

𝑠3
 

▪ Skewness Fisher-Pearson: 

𝛼3 =
𝑛

(𝑛 − 1)(𝑛 − 2)
∑ (

𝑥𝑖 − 𝑥̅

𝑠
)

3𝑛

𝑖=1

 

Berikut adalah penghitungan skewness untuk variabel UAS secara manual. 

▪ Skewness Pearson I: 

𝑠𝑘 =
66,0−65

8,3460
 = 0,1198 

▪ Skewness Pearson II: 

𝑠𝑘 =
(50 − 66,0)3 + ⋯ + (80 − 66,0)3

30 8,34603
 

𝑠𝑘 =
4096 + 4096 + ⋯ + 2744 + 2744

17440,19
 

𝑠𝑘 =
−3090

17440,19
 

𝑠𝑘 = −0,1772 

▪ Skewness Bowley: 

𝑠𝑘 =
75 − 2 ∗ 65 + 60

75 − 60
 

𝑠𝑘 =
5

15
 = 0,3333 

▪ Skewness Percentile: 
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𝑠𝑘 =
75 − 2 ∗ 65 + 55

75 − 55
 

𝑠𝑘 =
0

20
 = 0 

▪ Skewness Moment: 

𝛼3 =

1

2
((50 − 66,0)32 + ⋯ + (80 − 66,0)32)

8,34603
 

𝛼3 =
1

2
(−3090)

581,3398
 = -2,6576 

▪ Skewness Fisher-Pearson: 

𝛼3 =
30

(30 − 1)(30 − 2)
((

50 − 66

8,3460
)

3

+  … + (
80 − 66

8,3460
)

3

) 

𝛼3 =
30

812
(−7,0458 + … + 4,7201) 

𝛼3 =
30

812
(−5,3153) 

𝛼3 = −0,1964 

 
2. Kurtosis (kelancipan) 

Kurtosis (kelancipan) dinilai sebagai bentuk distorsi dari kurva nor-

mal. Tingkat kelancipan diukur dengan membandingkan bentuk kerun-

cingan kurva distribusi data dengan kurva normal. Kurva yang lebih lebih 

runcing dari distribusi normal dinamakan leptokurtik, yang lebih datar 

platikurtik, dan distribusi normal disebut mesokurtik. Distribusi normal 

memiliki kurtosis = 3, sementara distribusi yang leptokurtik memiliki 

kurtosis > 3 dan distribusi yang platikurtik memiliki kurtosis < 3 
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Gambar 2.2: 
Grafik Kurtosis 

Ada beberapa rumus yang digunakan dalam perhitungan kurtosis, 

yaitu: 

▪ Koefisien Keruncingan: 

𝛼4 =

1

𝑛
∑ (𝑥𝑖 − 𝑥̅)4𝑓𝑖

𝑘
𝑖=1

𝑠4
 

▪ Koefisien Kurtosis Persentil: 

𝐾 =

1

2
(𝑄3 − 𝑄1)

𝑃90 − 𝑃10
 

▪ Kurtosis Fisher-Pearson: 

𝛼4 =
𝑛(𝑛 + 1)

(𝑛 − 1)(𝑛 − 2)(𝑛 − 3)
 ∑ (

𝑥𝑖 − 𝑥̅

𝑠
)

4

−
3(𝑛 − 1)2

(𝑛 − 2)(𝑛 − 3)

𝑛

𝑖=1

 

Berikut adalah penghitungan kurtosis untuk variabel UAS secara manual. 

▪ Koefisien Keruncingan: 

𝛼4 =

1

30
((50 − 66,0)42 + ⋯ + (80 − 66,0)42)

8,34604
 

𝛼4 =

1

30
(298960)

4851,8430
 

𝛼4 =
9965,3333

4851,8430
= 2,0539 
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▪ Koefisien Kurtosis Persentil: 

𝐾 =

1

2
(75 − 60)

75 − 55
 

𝐾 =
7,5

20
= 0,3750 

▪ Kurtosis Fisher-Pearson: 

𝛼4 =
930

21924
((

50−66

8,3460
)

4
+. . + (

80−66

8,3460
)

4
 ) −

2523

756
  

𝛼4 = 0,0424(13,5074+. . +7,9178) − 3,3373 

𝛼4 = 0,0424 ∗ 61,6178 − 3,3373 

𝛼4 = −0,7236 

Penghitungan ukuran distribusi dengan Unpad SAS. 

▪ Buka tabel data_mahasiswa.  

▪ Pilih menu Analyze->Descriptive Statistics->Frequencies 

▪ Pilih variabel Nilai UAS seperti pada gambar di bawah ini. 

 

▪ Untuk memilih ukuran statistik, maka Klik Statistics. 
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▪ Karena kita akan melihat ukuran distribusi dari variabel UAS maka pilih 

Skewness dan Kurtosis seperti gambar di atas ini. 

▪ Klik <Continue>, kemudian klik <OK>. Setelah itu akan muncul luaran 

seperti gambar di bawah ini. 
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Ternyata kita dapat melihat bahwa penghitungan ukuran distribusi (skew-

ness dan kurtosis) dari UAS Statistika dengan menggunakan rumus secara 

manual dan program Unpad SAS menunjukkan hasil yang sama. 
 
5. Diagram 

Diagram adalah penyajian simbolis atas informasi untuk memper-

lihatkan atau menerangkan suatu kelompok data. Ada beberapa model 

diagram yang sering digunakan, yaitu diagram garis, diagram batang, dia-

gram lingkaran (pie), dan histogram. 

 
Gambar 2.3: 

Contoh Diagram Batang 
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Diagram batang atau grafik batang adalah bagan atau grafik yang 

menyajikan data dalam bentuk batang (bilah persegi panjang) dengan tinggi 

atau panjang yang sebanding dengan nilai yang mereka wakili. Batang dapat 

diplot secara vertikal atau horizontal. Setiap batang mewakili suatu kategori 

tertentu dan tinggi atau panjang batang menyatakan frekuensi atau proporsi 

kategori tersebut. Unpad SAS menampilkan diagram batang secara vertikal, 

yaitu seperti ditunjukkan pada Gambar 2.3. 

 
Gambar 2.4: 

Contoh Pi Chart (Diagram Lingkaran) 
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Pie Chart (diagram lingkaran) adalah grafik statistik berupa lingkaran 

yang dibagi menjadi irisan-irisan untuk menggambarkan proporsi setiap 

kategori. Dalam diagram lingkaran, panjang busur masing-masing irisan 

sebanding dengan kuantitas yang diwakilinya. Diagram ini diberi nama 

seperti itu karena kemiripannya dengan pie yang telah diiris. Unpad SAS 

menampilkan diagram lingkaran dengan nama kategori dan proporsinya di 

sebelah kanan gambar tersebut, yaitu seperti ditunjukkan pada Gambar 2.4. 
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Gambar 2.5: 

Contoh Histogram 

Histogram diperkenalkan oleh Karl Pearson. Histogram mirip dengan 

diagram batang tetapi setiap batangnya merepresentasikan distribusi data 

secara lebih akurat, yaitu: 

▪ Setiap batang histogram mewakili suatu kelas interval dari variabel ter-

tentu. 

▪ Setiap kelas interval memiliki lebar yang sama dan antar setiap batang 

tidak ada jarak (pemisah). 

▪ Frekuensi setiap batang histogram merupakan jumlah frekuensi dari 

kategori yang berada di dalam kelas interval dari variabel tersebut. 

Unpad SAS menampilkan histogram secara vertikal, yaitu seperti ditun-

jukkan pada Gambar 2.5. 

Beberapa aturan yang digunakan untuk membuat histogram adalah 

sebagai berikut. 

▪ Tetapkan nilai minimum (Min), maksimum (Max), dan hitung nilai rentang 

(R) dari variabel yang akan dibuatkan histogram-nya. Dalam contoh di 

atas, Min = 60, Max = 110, dan R = Max – Min = 50. 

▪ Jumlah kelas dihitung dengan menggunakan rumus 

𝑘 = 3,33 𝑙𝑜𝑔(𝑛) + 1 

dimana n adalah jumlah data dan nilai k dibulatkan ke atas. 



STATISTIK DESKRIPTIF 

69 

Dalam contoh di atas, n = 30 maka: 
 

k = 3,33 *  log(30) + 1 

k = 3,33 * 1,4471 + 1 

k = 5,919 
 

dibulatkan ke atas, k = 6. 

▪ Interval kelas dihitung dengan menggunakan rumus 

𝐼 =  
𝑅

𝑘 − 1
 

dimana R adalah rentang-nilai (range) dari variabel yang dimaksud. 

Untuk contoh di atas, nilai interval kelas (I) adalah: 

𝐼 =  
50

6 − 1
= 10 

▪ Setiap kelas interval memiliki batas-kelas. Untuk keperluan tersebut perlu 

ditetapkan dulu nilai satuan terkecil (tanpa diikuti angka 0) dari nilai 

variabel yang dimaksud. 

Batas-bawah kelas interval dihitung berdasarkan rumus: 

𝐵𝐾𝑖 = 𝑀𝑖𝑛 + (𝑖 − 1)𝐼 −
𝑛𝑠𝑡

2
 

Untuk contoh di atas, nst adalah 1 maka batas-bawah masing-masing kelas 

interval adalah: 

𝐵𝐾1 = 60 − 0,5 = 59,5 

𝐵𝐾2 = 60 + 10 − 0,5 = 69,5 

𝐵𝐾3 = 60 + 20 − 0,5 = 79,5 

𝐵𝐾4 = 60 + 30 − 0,5 = 89,5 

𝐵𝐾5 = 60 + 40 − 0,5 = 99,5 

𝐵𝐾6 = 60 + 50 − 0,5 = 109,5 

▪ Kecuali untuk kelas interval pertama, batas-bawah suatu kelas interval 

merupakan batas-atas dari kelas interval sebelumnya dan batas-atas 

untuk kelas interval terakhir adalah batas-bawah kelas tersebut ditambah 

interval kelas (I). 
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Gambar 2.6: 
Kotak Dialog Frequencies-Chart 

Luaran diagram dalam bentuk bar chart, pie chart, atau histogram 

dapat ditampilkan melalui perintah Analyze->Descriptive Statistics->Fre-

quencies dengan memilih tombol Chart. Perintah tersebut akan menam-

pilkan kotak dialog Frequencies: Charts seperti ditunjukkan pada Gambar 

2.6. Pilih tipe diagram yang Anda inginkan dan klik tombol <Continue>. 

 

C. DESCRIPTIVES 

Modul Descriptives menyediakan ringkasan statistik untuk variabel 

yang berbentuk numerik kontinu. Ringkasan yang ditampilkan antara lain 

berupa ukuran gejala pusat, ukuran dispersi, dan ukuran distribusi. Selain 

itu, kita juga dapat menyimpan skor Z dari suatu distribusi data. Skor Z atau 

yang biasa disebut standard score merupakan nilai relatif skor terhadap 

mean (seberapa jauh dia berada di atas atau di bawah rata-rata dalam satuan 

simpangan baku). Biasanya standard score kita gunakan ketika kita akan 

membandingkan skor yang berasal dari populasi yang berbeda. 
 
Contoh 3.2: 

Data yang digunakan sama dengan contoh sebelumnya. Namun, kali ini kita 

akan mengerjakan penghitungan dengan menggunakan menu Descriptives. 
 
Masalah 1: 

Peneliti ingin mengetahui ukuran gejala pusat, ukuran dispersi, dan ukuran 

distribusi dari variabel Nilai. 
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Berikut adalah langkah-langkah penghitungan dengan Unpad SAS. 

▪ Buka file data_mahasiswa.  

▪ Pilih perintah Analyze->Descriptive Statistics->Descriptives 

▪ Pilih variabel Nilai UAS seperti pada gambar di bawah ini. 

 

▪ Untuk memilih ukuran statistik, maka Klik Option … 

 

▪ Pilih Mean, Std.Deviation, dan Skewness serta Kurtosis seperti gambar 

di atas. 

▪ Klik Continue, kemudian klik OK. Setelah itu akan muncul luaran seperti 

gambar di bawah ini. 
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Hasil yang diperoleh dari penghitungan menggunakan Descriptives sama 

seperti hasil penghitungan pada contoh 3.1 Masalah 2. 
 
Standard Score 

Seperti telah dijelaskan, salah satu fungsi dari descriptives adalah 

untuk menyimpan skor Z atau standard score dari suatu distribusi data. 

Standard score memiliki dua rumus. 

Rumus pertama digunakan jika data merupakan sampel: 

𝑧 =
𝑥 − 𝑥̅

𝑠
 

dimana: 

z = nilai standar sampel 

𝑥 = nilai pada sampel 

𝑥̅ = rata-rata sampel 

s = simpangan baku sampel 
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Rumus kedua digunakan jika data merupakan populasi: 

𝑧 =
𝑥 − 𝜇

𝜎
 

dimana: 

z = nilai standar sampel 

𝑥 = nilai pada populasi 

𝜇 = rata-rata populasi 

𝜎 = simpangan baku populasi 
 

Penggunaan rata-rata dan simpangan baku secara bersama-sama 

merupakan cara efisien untuk menggambarkan suatu distribusi data dan 

memungkinkan untuk melakukan perbandingan secara langsung antara 

distribusi yang mempunya skala yang berbeda. Sebagai contoh jika kita 

mengkur panjang benda dengan satuan meter, hasil pengukuran meaning-

ful. Panjang benda yang diperoleh akan sama kalau kita menggunakan 

meteran yang mana pun dan kita memiliki pemahaman yang sama mengenai 

panjang benda tersebut. 

Dalam pengukuran psikologis, tidak ada unit pengukuran yang stan-

dar mengenai raw scores (skor mentah). Tidak seperti mengukur panjang 

benda, alat pengukuran kecerdasan yang digunakan akan berbeda antara 

satu orang dengan orang yang lain. Dalam hal ini Z score dapat digunakan 

untuk membandingkan skor yang berasal dari unit pengukuran yang ber-

beda. 

Z score atau standar skor menggambarkan posisi skor terhadap skor 

kelompoknya, apakah di atas atau di bawah rata-rata dan berapa jauh di atas 

dan di bawah rata-rata tersebut. Suatu standar skor menyatakan posisi skor 

dalam hubungan dengan rata-rata distribusi, dengan menggunakan sim-

pangan baku sebagai unit pengukuran, berapa simpangan baku di atas atau 

di bawah rata-rata. 

Misalkan skor tes numerikal anda adalah 60 dan skor tes verbal adalah 

30. Dalam tes yang mana anda mempunyai kemampuan yang lebih baik? 

▪ Pertama, kita membutuhkan nilai tes dari orang-orang lain pada tes ter-

sebut. Misalkan rata-rata skor tes numerikal adalah 50 dan rata-rata skor 

tes verbal adalah 20. 

▪ Skor anda 10 poin di atas skor rata-rata kelompok. 
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▪ Dapatkah dikatakan bahwa anda mempunyai kemampuan yang sama pada 

kedua tes tersebut? 

▪ Tidak tahu, karena kita tidak tahu apakah 10 poin pada tes numerikal sama 

dengan 10 poin pada tes verbal 

Misalkan skor tes numerikal anda adalah 60 dan skor tes verbal adalah 30.  

Dalam tes yang mana anda mempunyai kemampuan yang lebih baik? 

▪ Misalkan simpangan baku tes numerikal adalah 15 dan simpangan baku 

tes verbal adalah 5. 

▪ Apakah sekarang dapat ditentukan pada tes yang mana anda mempunyai 

kemampuan yang lebih baik? 

Untuk mencari berapa simpangan baku suatu skor berjarak dari rata-

ratanya, digunakan rumus Z: 

Z untuk tes numerikal: 

𝑧 =  
60 − 50

15
= 0,667 

Z untuk tes verbal: 

𝑧 =  
30 − 20

5
= 2 

Maka nilai skor tes verbal lebih baik dari skor tes numerikal. 

 

Gambar 2.7: 
Distribusi Skor Numerical Test dan verbal Test 

Z akan mempunyai rata-rata = 0 dan simpangan baku =1. 

Transformasi skor mentah ke Z akan mengubah rata-rata menjadi 0 dan 

simpangan baku 1, akan tetapi tidak akan mengubah bentuk distribusi.  
 
Pada Masalah 2 berikut ini kita akan melakukan perhitungan Z. 
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Masalah 2:  

Adi adalah peserta dalam penelitian ini yang mempunyai nilai UAS 70 dan 

nilai UTS 85 (Responden 18). Apakah dapat disimpulkan bahwa Adi 

mempunyai nilai UTS yang lebih baik dibandingkan nilai UAS? 
 
Perhitungan manual Z-Score 

Z untuk UAS 

𝑧 =  
70 − 66

8,3460
 

𝑧 =  0,4792 

Z untuk UTS 

𝑧 =  
85 − 80

8,3045
 

𝑧 =  0,6020 

Maka nilai UAS Adi lebih baik dari nilai UTS nya 
 
Perhitungan Z-Score dengan Unpad SAS 

▪ Buka tabel data_mahasiswa.  

▪ Berikan perintah Analyze->Descriptive Statistics->Descriptives 

▪ Pilih variabel UAS dan UTS seperti pada gambar di bawah ini. 

 

▪ Contreng “save standardized value as variables” seperti pada gambar di 

atas. 

▪ Untuk memilih ukuran statistik, maka Klik Option … 

▪ Pilih saja sesuai keperluan, misalnya Mean dan Std. Deviation. 
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▪ Klik <Continue>, kemudian klik <OK>. Setelah itu akan muncul luaran 

seperti gambar di bawah ini. 

 

▪ Perhatikan pada DataView Anda, sekarang telah muncul variabel baru, 

yaitu zUAS dan zUTS yang merupakan standard score dari Nilai UAS dan 

Nilai UTS. 
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D. EXPLORE 

Explore digunakan untuk memeriksa lebih teliti mengenai sekelompok 

data. Banyak fungsi yang bisa dimanfaatkan dari bagian ini, misalnya untuk 

melakukan data screening (seperti melihat angka yang tidak lazim, nilai yang 

terlalu ekstrim, perbedaan di antara data). 

Boxplot merupakan salah satu fitur yang terdapat pada perintah ex-

plore. Boxplot adalah cara untuk menampilkan distribusi data berdasarkan 

lima acuan, yaitu: minimum, kuartil satu, median, kuartil tiga, dan mak-

simum. Melalui boxplot, kita juga dapat melihat data yang bersifat ekstrim, 

baik terlalu tinggi, maupun terlalu rendah. Data tersebut termasuk pada 

kategori outlier. 
 
Contoh 3.4: 

Dalam contoh ini kita akan mengerjakan kembali contoh mengenai variabel 

Nilai. Kali ini, dengan menggunakan Explore kita akan melihat apakah ter-

dapat data-data ekstrim atau keliru, melihat distribusi data, ringkasan sta-

tistik. 
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Berikut ini adalah langkah-langkah pengerjaan dengan Unpad SAS. 

▪ Buka berkas data_mahasiswa. 

▪ Pilih Analyze->Descriptive Statistics->Explore.. 

▪ Pilih variabel Nilai UAS seperti pada gambar di bawah ini. 

 

▪ Klik <Continue>, kemudian klik <OK>. Setelah itu akan muncul luaran 

seperti gambar di bawah ini. 
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Dari box plot tersebut dapat diketahui bahwa: 

1. Nilai terkecil distribusi (MIN)= 50 

2. Nilai terbesardistribusi (MAX)= 80 

3. Kuartil bawah (LQ)= 60 

4. Median (MQ)= 65 

5. Kuartil atas (UQ)=75 

6. Interquartile range (IR)= 15 

7. Nilai-nilai Inner fence 

a. Lower Inner Fence (LIF)= 37,5 

 LIF = LQ–1,5*IR 

b. UpperInner Fence (UIF)= 97,5 

 UIF = UQ+ 1,5*IR 

c. Lower Outer Fence (LIF2)= 15 

 LIF2 = LQ–3*IR 

d. Upper Outer Fence (UIF2)= 120 

 UIF2 = UQ+ 3*IR 
 
Nilai-nilai yang berada di luar kedua sisi inner fence merupakan mild outlier. 

Nilai-nilai yang berada di luar kedua sisi outer fence merupakan extreme 

outlier. 
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E. CROSSTABS 

Crosstabs digunakan untuk menyajikan deskripsi data kategorikal da-

lam bentuk tabulasi silang (crosstab), yang terdiri atas baris dan kolom. 

Crosstabs merupakan tabel kontingensi yang digunakan untuk mengukur 

hubungan antara dua variabel. 
 
Contoh 3.5: 

Pihak fakultas ingin melihat gambaran Nilai UAS Statistika pada mahasiswa 

laki-laki dan perempuan dalam bentuk tabulasi silang. 
 
Berikut ini adalah langkah-langkah pengerjaan dengan Unpad SAS. 

▪ Buka berkas data_mahasiswa. 

▪ Pilih Analyze ->Descriptive Statistics->Crosstabs 

 

▪ Pada Row(s), masukkan variabel JenisKelamin (JK). Pada Column (s), 

masukkan variabel Nilai UAS. 

▪ Klik tombol <OK>. Setelah itu akan muncul luaran seperti gambar di bawah 

ini. 
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Anda boleh menetapkan beberapa variabel ke dalam ruas Row(s) maupun 

Column (s) untuk mendapatkan beberapa tabel-silang secara sekaligus. 

Sebagai contoh, ikuti langkah-langkah berikut. 

▪ Buka berkas data_mahasiswa. 

▪ Pilih Analyze ->Descriptive Statistics->Crosstabs 

 

▪ Pada Row(s), masukkan variabel JK dan Nilai. Pada Column (s), masukkan 

variabel SAM dan STATS. 

▪ Klik tombol <OK>. Setelah itu akan muncul luaran seperti gambar di bawah 

ini. 
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F. LATIHAN 

Soal 1: 

Berikut ini adalah daftar permintaan lanjutan dari Fakultas. Silahkan di-

cermati dan dikerjakan sesuai dengan petunjuk yang diberikan. 

1. Pihak Fakultas ingin memperoleh ringkasan statistik secara lengkap me-

ngenai ukuran gejala pusat, ukuran letak, ukuran dispersi, dan ukuran 

distribusi dari variabel UTS dan IQ pada data tersebut. 

2. Pihak Fakultas juga ingin Anda menghitung standard score dari IQ. 

3. Kemudian, pihak Fakultas ingin Anda melihat gambaran Statistics Anxiety 

Measure (SAM) pada mahasiswa laki-laki dan perempuan dalam bentuk 

tabulasi silang. 
 
Soal 2: 

Suatu penelitian dilakukan untuk mengetahui perbedaan hasil belajar siswa 

yang belajar Matematika dengan tiga metode yang berbeda. Kelompok per-

tama adalah kelompok  yang belajar Matematika dengan menggunakan me-

tode SCL (Student Centered Learning). Kelompok kedua adalah kelompok 

yang belajar Matematika dengan menggunakan metode TCL (Teacher Cen-

tered Learning). Adapun kelompok ketiga adalah kelompok yang belajar 

Matematika menggunakan metode gabungan SCL dan TCL.  

Hasil belajar Matematika pada ketiga kelompok tersebut dapat dilihat pada 

tabel di bawah ini: 

SCL TCL SCL + TCL  SCL TCL SCL + TCL 

85 75 98  63 84 87 

64 65 76  75 76 89 
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SCL TCL SCL + TCL  SCL TCL SCL + TCL 

65 78 87  83 77 84 

78 56 78  65 64 81 

82 76 78  82 71 98 

75 56 75  65 67 77 

83 74 85  76 65 87 

65 66 65  77 63 90 

84 64 78  88 75 87 

76 55 71  88 87 91 

84 54 82  67 76 82 

94 54 76  74 79 96 

73 64 84  75 76 87 

61 73 78  77 87 88 

64 84 86  84 77 90 

Jika peneliti mengkategorikan Hasil Belajar Matematika menjadi 2 kategori: 

Tinggi: untuk Hasil Belajar Matematika yang nilainya 25% tertinggi 

Rendah: untuk Hasil Belajar Matematika yang nilainya 25% terrendah  

a. Berapakah batas minimal Hasil Belajar Matematika untuk dikategorikan 

menjadi tinggi?  

b. Berapakah batas maksimal Hasil Belajar Matematika untuk dikatego-

rikan menjadi rendah?  

c. Ada berapa siswa yang mempunyai Hasil Belajar Matematika dengan 

kategori rendah?  

d. Ada berapa siswa yang mempunyai Hasil Belajar Matematika dengan 

kategori tinggi? 
 
Soal 3: 

Hasil Tes masuk pada Ujian Masuk ke Program Magister Fakultas Psikologi 

di suatu Universitas di kota Bandung adalah sebagai berikut:  

678 688  653 691 700 712 700 674 

670 676 688 716  676 658 662 680 

690 676 689 692 700 702 721 670 

a. Bagaimana bentuk hubungan antara rata-rata, median dan modus serta 

bentuk distribusi dari data tersebut? 

b. Gambarkan boxplot dari data tersebut, apakah terdapat data outlier 

(ekstrim dan sangat ekstrim)? 

c. Nilai-nilai apa yang paling tepat digunakan sebagai suatu ukuran untuk 

menggambarkan data tersebut? Berapa besarnya nilai-nilai tersebut? 
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Soal 4: 

Data di bawah ini adalah data mengenai hasil pengukuran intelegensi 

dengan menggunakan alat tes IST pada berbagai kelompok usia: 
 

No Pendidikan Jenis Kelamin/Pekerjaan Rata-rata IQ Simpangan Baku IQ 

1 SLA Laki-laki 119 18.5 

2 SLA Perempuan 122 15.7 

3 Sarjana Laki-laki 120 17.3 

4 Sarjana Perempuan 116 15.0 
 

Berdasarkan data tersebut, hitunglah: 

a. Berapa nilai tertinggi dari 25% nilai IQ yang terendah untuk masing-

masing kelompok tersebut! 

b. Berapa nilai yang terendah dari 25% nilai yang tertinggi untuk masing-

masing kelompok tersebut! 

c. Berapa nilai median untuk masing-masing kelompok tersebut! 

d. Apa yang dapat Saudara simpulkan dari hasil perhitungan tersebut! 
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3 
Sampling 

 

 

A. PENDAHULUAN 

Dalam suatu penelitian, hampir jarang dilakukan penelitian dengan 

mengambil seluruh unit analisis yang ada dalam populasi. Pada umumnya 

penelitian dilakukan pada sebagian unit analisis yang ada dalam populasi 

(sampel). Penelitian dengan menggunakan sampel biasanya dilakukan ka-

rena: 

▪ Tidak mungkin melakukan penelitian pada seluruh anggota populasi  

▪ Mengurangi bias 

▪ Masalah waktu dan biaya  

▪ Penelitian yang sifatnya merusak  

▪ Feasibility  

Akan tetapi walaupun penelitian dilakukan pada sampel, sampel yang 

diambil harus representatif dan menggambarkan keadaan populasi. Oleh 

karena itu pengambilan sampel membutuhkan suatu teknik tertentu yang 

harus diikuti oleh peneliti agar memberikan hasil penelitian yang baik. 

Sebelum dibahas mengenai berbagai teknik sampling, akan dibahas dulu 

beberapa pengertian dasar dalam teknik sampling.  

Beberapa pengertian dasar dalam teknik sampling: 

▪ Karakteristik: ciri/keadaan yang akan diperiksa/dipelajari  

▪ Unit analisis: sesuatu yang berdasarkan tujuannya atau berdasar per-

aturan tertentu dijadikan sebuah kesatuan yang karakteristiknya akan 

diukur  

▪ Populasi: keseluruhan unit analisis/hasil pengukuran yang dibatasi oleh 

suatu kriteria tertentu  

▪ Populasi sasaran: populasi yang akan diteliti. Seorang peneliti menyim-

pulkan hasil penelitiannya hanya berlaku untuk populasi sasaran yang ia 

tetapkan. 
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▪ Sampling: sebuah prosedur/cara untuk memilih sebagian unit yang ada 

dalam populasi  

▪ Sampel: sebagian unit analisis dalam populasi yang diperoleh melalui 

sampling tertentu  

▪ Kerangka sampling: daftar yang berisi semua unit analisis yang ada 

dalam populasi  

Dilihat dari peluang (probability) pemilihannya, sampling terdiri dari: 

1. Sampling non peluang (sampling tidak acak):  

Dalam sampling non peluang, proses pemilihan unit analisis yang masuk 

ke dalam sampel sangat sederhana, tetapi kesederhanaan ini harus 

dibayar mahal sebab terhadap data yang dikumpulkan melalui sampling 

non peluang, analisis statistik yang menyangkut test of significant  tidak 

diperkenankan, karena test of significant melibatkan peluang (), padahal 

samplingnya tidak melibatkan peluang.  

Jenis-jenis sampling non peluang: 

a. Haphazard sampling/Accidental sampling 

b. Voluntary sampling 

c. Judgment sampling/Purposive sampling/Expert choice 

d. Snowball sampling 

e. Quota sampling  

2. Sampling peluang (sampling acak): 

Pada sampling peluang peneliti sangat memperhatikan unsur peluang 

saat melakukan pemilihan unit analisis yang masuk ke dalam sampel, 

dimana peluang unit analisis terpilih ke dalam sampel  0. 

Jenis-jenis sampling peluang: 

a. Sampling acak sederhana (simple random sampling) 

b. Sampling sistematik (systematic sampling) 

c. Sampling stratifikasi (stratified sampling) 

d. Sampling klaster (cluster sampling) 

 

B. SAMPLING ACAK SEDERHANA (SIMPLE RANDOM SAMPLING) 

Sampling acak sederhana adalah proses sampling yang memenuhi 

persyaratan bahwa setiap unit analisis yang ada dalam populasi mempunyai 
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peluang yang sama besar untuk terpilih ke dalam sampel. Jika ukuran po-

pulasi N, maka setiap unit populasi mempunyai peluang 1/N untuk terpilih 

ke dalam sampel. 

Sampling acak sederhana merupakan dasar dari sampling-sampling 

lainnya, tetapi penggunaannya terbatas sekali, terutama dalam penelitian 

survey yang ruang lingkupnya luas. Sampling acak sederhana dapat di-

gunakan jika peneliti berhadapan dengan populasi yang relatif homogen dan 

kerangka sampling harus lengkap dan tersedia. 

Dalam sampling acak sederhana, proses sampling dilakukan dengan ta-

hapan:  

1. Tentukan ukuran sampel  

2. Ambil kerangka sampling 

3. Lakukan proses pengacakan dengan menggunakan undian, tabel bi-

langan acak atau random generator dalam Unpad SAS, untuk memilih 

unit analisis yang masuk ke dalam sampel 

Populasi berukuran N 

                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  

Diambil sampel berukuran n secara 
acak 

                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  

Gambar 3.1: 
Proses Sampling Acak Sederhana 
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Tabel 3.1 
Tabel Bilangan Acak 

1 2 3 4 5 

49486 93775 88744 80091 92732 

94860 36746 04571 13150 65383 

10169 95685 47585 53247 60900 

12018 45351 15671 23026 55344 

45611 71585 61487 87434 07498 

89137 30984 18842 69619 53872 

94541 12057 30771 19598 96069 

89920 28843 87599 30181 26839 

32472 32796 15255 39636 90819 

 

1. Penghitungan Ukuran Sampel Minimal untuk Estimasi Rata-
Rata pada Sampling Acak Sederhana 

Penghitungan ukuran sampel minimal untuk sampling acak sederhana 

dapat dilakukan menggunakan rumus: 

𝑛 =
𝑁𝜎2

(𝑁 − 1)𝐷 + 𝜎2
 

dimana: 

D = B2/4 

B = bound of error 

σ = simpangan baku populasi untuk variabel yang rata-ratanya akan ditaksir 

Rumus di atas mengandung sebuah parameter σ , padahal σ  hanya dapat 

diketahui apabila dilakukan sensus. Dalam praktek nilai σ  dapat diperoleh 

dari: 

1. Atas dasar hasil sensus yang telah dilakukan 

2. Pendapat/pertimbangan pakar (expert judgement) 

3. Penelitian pendahuluan 

4. Gunakan aturan empirik yang diberikan oleh Edward Demins, yang 

mengatakan adanya hubungan antara besarnya rentang (range) dengan 

simpangan baku suatu variabel 

a. Jika variabel X berdistribusi simetri, maka hubungan antara rentang 

dengan simpangan baku adalah : σ   0.24 R 

b. Jika variabel X berdistribusi miring (positif maupun negatif), maka 

hubungan antara rentang dengan simpangan baku adalah : σ   0.21 R 
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c. Jika variabel X berdistribusi uniform, maka hubungan antara rentang 

dengan simpangan baku adalah : σ   0.29 R 
 
Contoh Masalah 

Suatu penelitian dilakukan oleh PT Asuransi Garuda untuk meng-

estimasi rata-rata besar asuransi kesehatan yang dikeluarkan suatu ke-

luarga. Data terdahulu yang ada menunjukkan bahwa besar asuransi ke-

sehatan yang dikeluarkan sangat beragam dengan rentang (range) = 100 

juta rupiah. Apabila populasi penelitian ada 1.000 orang, berapa besar 

sampel minimal yang diperlukan untuk melakukan penelitian ini apabila 

diambil bound of error = 3 juta rupiah? 
 
Pengerjaan Secara Manual 

Soal ini akan diselesaikan dengan menggunakan rumus ukuran 

sampel minimal untuk estimasi rata-rata pada sampling acak sederhana. 

Untuk menyelesaikan soal ini dibutuhkan nilai varians (𝜎2). Karena tidak 

ada informasi apapun, maka nilai simpangan baku akan diambil 0,24 R = 

0,24 (100) = 24.  

𝑛 =
1000 ∗ 242

(1000 − 1) ∗ 2,25 + 242
 

𝑛 = 203,98 

Jadi ukuran sampel minimal yang harus diambil dalam penelitian ini 

adalah 204 orang. 
 
Pengerjaan dengan Menggunakan UNPAD SAS 

▪ Pilih menu Analyze->Sampling->Simple Random Sampling->Sample 

Size Required to Estimate Mean. 

 



BELAJAR STATISTIKA DENGAN UNPAD SAS 

92 

Perintah tersebut akan menampilkan kotak dialog sebagai berikut. 

 

▪ Masukkan 1000 untuk ruas Population size (N), 24 untuk ruas Deviation 

Standard (σ), dan 3 untuk ruas Bound of error (B). Setelah itu klik tombol 

<Calc>. 

 

Hasil perhitungan ukuran sampel akan ditampilkan di dalam ruas Sample 

size (n), yaitu 204. 

▪ Klik <Copy to clipboard> untuk menyalin nilai-nilai tersebut sehingga 

Anda dapat menempelkannya ke dalam dokumen lain.. 
 
2. Penghitungan Ukuran Sampel Minimal untuk Estimasi 

Proporsi pada Sampling Acak Sederhana 

Penghitungan ukuran sampel minimal untuk estimasi proporsi pada 

sampling acak sederhana dapat dilakukan menggunakan rumus: 

𝑛 =
𝑁𝑝𝑞

(𝑁 − 1)𝐷 + 𝑝𝑞
 

dimana: 

D = B2/4  

p = besarnya perkiraan proporsi yang akan ditaksir 

B = bound of error 
 
Apabila p tidak diketahui berdasarkan penelitian sebelumnya ataupun 

pendapat pakar, maka p diambil sama dengan 0.5. 
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Contoh Masalah 

Suatu universitas sedang mengusulkan kode etik bagi mahasiswanya. 

Senat di universitas tersebut ingin melakukan survey untuk mengetahui 

persentase mahasiswa yang mendukung kode etik tersebut. Ada 2.000 

mahasiswa di universitas ini. Melakukan wawancara terhadap seluruh 

mahasiswa akan memakan waktu yang sangat lama, oleh karena itu akan 

dipilih sejumlah mahasiswa yang menjadi sampel penelitian survey ini. 

Berapa ukuran sampel yang dibutuhkan apabila diinginkan bound of error = 

0,05? 
 
Pengerjaan Secara Manual 

Untuk menyelesaikan soal ini dibutuhkan nilai p. Karena tidak ada 

informasi apapun, maka nilai p akan diambil 0,5.  

𝑛 =
2000 ∗ 0,5 ∗ 0,5

(2000 − 1) ∗ 0,000625 + 0,5 ∗ 0,5
 

𝑛 =
500

1,499375
 

𝑛 = 333,47228 

Jadi ukuran sampel minimal yang harus diambil dalam penelitian ini adalah 

334 orang. 
 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Pilih menu Analyze->Sampling->Simple Random Sampling->Sample 

Size Required to Estimate Proportion. 

 

Perintah tersebut akan menampilkan kotak dialog sebagai berikut. 
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▪ Masukkan 2000 untuk ruas Population size (N), 0,5 untuk ruas Proportion 

(p), dan 0,05 untuk ruas Bound of error (B). Setelah itu klik tombol <Calc>. 

 

Hasil perhitungan ukuran sampel akan ditampilkan di dalam ruas Sample 

size (n), yaitu 334. 

▪ Klik <Copy to clipboard> untuk menyalin nilai-nilai tersebut sehingga 

Anda dapat menempelkannya ke dalam dokumen lain.. 
 
3. Penghitungan Ukuran Sampel Minimal untuk Estimasi 

Korelasi dan Regresi pada Sampling Acak Sederhana 

Penghitungan ukuran sampel minimal untuk sampling acak sederhana 

dapat dilakukan menggunakan rumus: 

𝑛 =
(𝑍1−∝ + 𝑍1−𝛽)2

(𝑈𝜌)2
+ 3 

𝑈𝜌 = 0,5 𝑙𝑛 (
1 + 𝜌

1 − 𝜌
) 

dimana: 

ρ = besarnya koefisien korelasi 
 
Apabila besarnya koefisien korelasi tidak diketahui, maka dapat diambil ρ = 

0,5. 
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Contoh Masalah 

Suatu penelitian akan dilakukan untuk mengetahui hubungan antara 

tingkat kecerdasan dengan prestasi belajar mahasiswa di suatu perguruan 

tinggi. Data tahun sebelumnya menunjukkan bahwa besarnya hubungan 

antara tingkat kecerdasan dengan prestasi belajar mahasiswa adalah 0,40. 

Berapa ukuran sampel yang harus diambil untuk melakukan penelitian ini 

jika diambil taraf nyata = 0,05? 
 
Pengerjaan Secara Manual 

𝑛 =  
(1,645 + 1,645)2

{0,5 𝑙𝑛
1,4

0,6
}

2 + 3 

𝑛 =  63 

 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Pilih menu Analyze->Sampling->Simple Random Sampling->Sample 

Size Required to Estimate Correlation and Regression. 

 

Perintah tersebut akan menampilkan kotak dialog sebagai berikut. 

 

▪ Masukkan 0,4 untuk ruas Correlation (ρ), 0,05 untuk ruas Type 1 error (α), 

dan 0,05 untuk ruas Type 2 error (β). Setelah itu klik tombol <Calc>. 
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Hasil perhitungan ukuran sampel akan ditampilkan di dalam ruas Sample 

size (n), yaitu 63. 

▪ Klik <Copy to clipboard> untuk menyalin nilai-nilai tersebut sehingga 

Anda dapat menempelkannya ke dalam dokumen lain.. 

 

 

B. SAMPLING STRATIFIKASI (STRATIFIED SAMPLING) 

Sampling stratifikasi biasanya dilakukan dalam keadaan populasi 

yang sangat heterogen sehingga populasi dibagi ke dalam sub populasi (yang 

disebut strata). Tujuan stratifikasi adalah membentuk strata yang ke-

adaannya relatif homogen sehingga tujuan utama memperoleh hasil analisis 

yang mempunyai presisi tinggi dapat tercapai. Variabel stratifikasi yang 

paling ideal adalah variabel yang sedang diteliti, tetapi tentu saja hal ini tidak  

mungkin dilakukan. Dalam penelitian biasanya variabel stratifikasi yang 

digunakan adalah variabel yang erat hubungannya dengan variabel yang 

sedang diteliti. 

Banyaknya strata yang diperlukan merupakan masalah tersendiri da-

lam sampling acak stratifikasi. Teori sampling mengatakan bahwa ada hu-

bungan antara banyaknya strata dengan kenaikan presisi. Berdasarkan data 

empirik kenaikan presisi masih berarti apabila banyaknya strata 6 buah, 

lebih dari itu kenaikan presisi sudah tidak proporsional lagi (the magic six). 
 
Dalam sampling stratifikasi, proses sampling dilakukan dengan tahapan:  

1. Definisikan kelompok strata 

2. Tentukan daftar unit analisis dalam setiap strata 

3. Tentukan ukuran sampel untuk setiap strata 
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3. Pilih unit analisis dari setiap strata menggunakan alokasi tertentu 

(proporsional atau non proporsional) dengan menggunakan undian, 

tabel bilangan acak atau random generator dalam Unpad SAS 

Populasi mempunyai h strata yang 
masing-masing berukuran Nh 

                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
Gunakan sampling acak sederhana 

pada setiap strata 

                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  

Gambar-3.2: 
Proses Sampling Stratifikasi 

 
1. Penghitungan Ukuran Sampel Minimal untuk Estimasi Rata-

Rata pada Sampling Stratifikasi 

Penghitungan ukuran sampel minimal untuk estimasi rata-rata pada 

sampling stratifikasi dapat menggunakan rumus berikut: 
 
Estimasi rata-rata: 

𝑛 =
∑

𝑁𝑖
2𝜎𝑖

2

𝑤𝑖

𝑁2𝐷 + ∑ 𝑁𝑖𝜎𝑖
2 

dimana: 

D = B2/4 
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Wi = alokasi 

B = bound of error 

σi
2 = varians strata ke-i 

Contoh Masalah 

Suatu perusahaan periklanan akan melakukan survey untuk me-

ngetahui rata-rata waktu yang dihabiskan setiap minggu oleh ibu rumah 

tangga untuk menonton TV di wilayah Kencana. Wilayah Kencana terbagi 

atas area perkotaan (A), area pedesaan (B), serta area perbatasan desa-kota 

(C). Di area perkotaan terdapat 155 ibu rumah tangga, di area pedesaan 

terdapat 62 ibu rumah tangga dan di area perbatasan desa-kota terdapat 93 

ibu rumah tangga. Survey pendahuluan di wilayah Kencana menghasilkan  

𝜎2
A = 25, 𝜎2

B= 225 dan 𝜎2
C = 100. Berapa besarnya ukuran sampel yang 

harus diambil untuk survey ini jika diambil bound of error 2? 
 
Pengerjaan Secara Manual 

Karena tidak ada informasi apapun, maka soal ini akan diselesaikan 

dengan menggunakan rumus ukuran sampel minimal untuk estimasi rata-

rata pada sampling stratifikasi dengan alokasi yang sama pada setiap strata. 

 

𝑛 =

(1552)(25)

1/3
+

(622)(225)

1/3
+

(932)(100)

1/3

(3102)(1) + (155)(25) + (62)(225) + (93)(100)
 

𝑛 = 56,7 

 
Jadi ukuran sampel minimal yang harus diambil dalam penelitian ini adalah 
57 orang 

 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Pilih menu Analyze->Sampling->Stratified Sampling->Sample Size 

Required to Estimate Mean. 
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Perintah tersebut akan menampilkan kotak dialog sebagai berikut. 

 

▪ Masukkan 3 untuk ruas Amount of strata dan klik tombol . 

Atas perintah ini maka tabel penetapan nilai untuk ketiga strata akan 

disiapkan. 

 

▪ Masukkan 155, 62, dan 93 ke ruas Size untuk strata 1, 2, dan 3. Masukkan 

5, 15, dan 10 ke ruas  Standard deviation  untuk strata 1, 2, dan 3. Masukkan 

2 ke ruas Bound of error. Tetapkan “Equal” untuk Wi Method. Setelah itu klik 

tombol <Calc>. 
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Hasil perhitungan ukuran sampel akan ditampilkan di dalam ruas Sample 

size (n), yaitu 57. 

▪ Klik <Copy to clipboard> untuk menyalin nilai-nilai tersebut sehingga 

Anda dapat menempelkannya ke dalam dokumen lain.. 
 
2. Penghitungan Ukuran Sampel Minimal untuk Estimasi 

Proporsi pada Sampling Stratifikasi 

Penghitungan ukuran sampel minimal untuk estimasi proporsi pada 

sampling stratifikasi dapat menggunakan rumus berikut: 

𝑛 =
∑

𝑁𝑖
2𝑃𝑖(1−𝑃𝑖)

𝑤𝑖

𝑁2𝐷 + ∑ 𝑁𝑖𝑃𝑖(1 − 𝑃𝑖)
 

dimana: 

D = B2/4 

Wi = alokasi 

B = bound of error 

Pi = proporsi pada strata ke-i 
 
Contoh Masalah 1 

Perusahaan periklanan ingin mengetahui proporsi ibu rumah tangga 

yang menonton tayangan berita di wilayah Kencana. Wilayah Kencana 

terbagi atas area perkotaan (A), area pedesaan (B), serta area perbatasan 

desa kota (C). Di area perkotaan terdapat 155 ibu rumah tangga, di area 

pedesaan terdapat 62 ibu rumah tangga dan di area perbatasan desa-kota 

terdapat 93 ibu rumah tangga. Survey pendahuluan di wilayah Kencana 

menghasilkan proporsi ibu rumah tangga yang menonton tayangan berita 
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adalah pA = 0,80, pB= 0,25 dan 𝑝C = 0,50. Berapa besarnya ukuran sampel 

yang harus diambil untuk survey ini jika diambil bound of error 0,1? 
 
Pengerjaan Secara Manual 

𝑛 =  

1552(0,80)(0,20)

1/3
+ 

622(0,25)(0,75)

1/3
+ 

932(0,50)(0,50)

1/3

3102(0,0025) + 155(0,80)(0,20) + 62(0,25)(0,75) + 93(0,50)(0,50)
 

𝑛 =  68 

dengan alokasi sebagai berikut: 

nA = 23 

nB = 23 

nC = 23 
 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Pilih menu Analyze->Sampling->Stratified Sampling->Sample Size 

Required to Estimate Proportion. 

 

Perintah tersebut akan menampilkan kotak dialog sebagai berikut. 

 

▪ Masukkan 3 untuk ruas Amount of strata dan klik tombol . 
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Atas perintah ini maka tabel penetapan nilai untuk ketiga strata akan 

disiapkan. 

 

▪ Masukkan 155, 62, dan 93 ke ruas Size untuk strata 1, 2, dan 3. Masukkan 

0,8, 0,25, dan 0,5 ke ruas Proportion untuk strata 1, 2, dan 3. Masukkan 0,1 

ke ruas Bound of error. Tetapkan “Equal” untuk Wi Method. Setelah itu klik 

tombol <Calc>. 

 

Hasil perhitungan ukuran sampel akan ditampilkan di dalam ruas Sample 

size (n), yaitu 68. 

▪ Klik <Copy to clipboard> untuk menyalin nilai-nilai tersebut sehingga 

Anda dapat menempelkannya ke dalam dokumen lain. 
 
Contoh Masalah 2 

Sebuah perusahaan periklanan ingin mengetahui proporsi ibu rumah 

tangga yang menonton tayangan berita di wilayah Kencana. Wilayah Ken-

cana terbagi atas area perkotaan (A), area pedesaan (B), serta area per-

batasan desa kota (C). Di area perkotaan terdapat 155 ibu rumah tangga, di 

area pedesaan terdapat 62 ibu rumah tangga dan di area perbatasan desa-
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kota terdapat 93 ibu rumah tangga. Survey pendahuluan di wilayah Kencana 

menghasilkan proporsi ibu rumah tangga yang menonton tayangan berita 

adalah p = 0,4. Berapa besarnya ukuran sampel yang harus diambil untuk 

survey ini jika diambil bound of error 0,1 dan menggunakan alokasi 

proporsional untuk meminimumkan biaya? 
 
Pengerjaan Secara Manual 

𝑛 =  

1552(0,40)(0,60)

0,50
+ 

622(0,40)(0,60)

0,20
+ 

932(0,40)(0,60)

0,30

3102(0,0025) + 155(0,40)(0,60) + 62(0,40)(0,60) + 93(0,40)(0,60)
 

n = 74 

dengan alokasi sebagai berikut: 

nA = 37 

nB = 15 

nC = 23 
 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Pilih menu Analyze->Sampling->Stratified Sampling->Sample Size 

Required to Estimate Proportion. 

 

Perintah tersebut akan menampilkan kotak dialog sebagai berikut. 
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▪ Masukkan 3 untuk ruas Amount of strata dan klik tombol . 

Atas perintah ini maka tabel penetapan nilai untuk ketiga strata akan 

disiapkan. 

 

▪ Masukkan 155, 62, dan 93 ke ruas Size untuk strata 1, 2, dan 3. Masukkan 

0,4, 0,4, dan 0,4 ke ruas Proportion untuk strata 1, 2, dan 3. Masukkan 0,1 

ke ruas Bound of error. Tetapkan “Not equal” untuk Wi Method. Setelah itu 

klik tombol <Calc>. 
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Hasil perhitungan ukuran sampel akan ditampilkan di dalam ruas Sample 

size (n), yaitu 74. 

▪ Klik <Copy to clipboard> untuk menyalin nilai-nilai tersebut sehingga 

Anda dapat menempelkannya ke dalam dokumen lain. 

 

C. SAMPLING KLASTER (CLUSTER SAMPLING) 

Seperti sudah diketahui unit analisis adalah sebuah kesatuan yang 

karakteristiknya akan diukur. Unit analisis bisa merupakan sebuah kesatuan 

yang berdiri sendiri (tidak dapat dibagi-bagi) seperti: orang, atau dapat juga 

merupakan sebuah kesatuan yang di dalamnya mengandung unit-unit ana-

lisis lainnya (yang disebut klaster) seperti: keluarga, RT, kelurahan, dsb.  

Berlawanan dengan pembentukan strata, klaster dibentuk dengan 

tujuan memperoleh keadaan seheterogen mungkin. Jika dalam klaster ke-

adaan heterogen, maka antar klaster menjadi homogen. Bila pembentukan 

klaster seperti ini dapat tercapai, maka banyaknya klaster yang digunakan 

untuk menentukan sampel penelitian cukup 2 buah saja (karena homogen). 

Dalam praktek di lapangan, klaster yang biasa diambil adalah daerah 

administratif seperti: RT, RW, kelurahan, kecamatan, dsb. Akibat pem-

bentukan klaster seperti ini, maka keadaan di dalam klaster relatif he-

terogen dan antar klaster relatif homogen. Oleh karena itu disarankan me-

lakukan pembentukan klaster menggunakan daerah administratif  

Pada umumnya sampling klaster dapat dibedakan atas sampling satu 

tahap dan sampling klaster dua tahap. Dalam sampling klaster satu tahap, 

proses sampling dilakukan dengan tahapan:  

1. Tentukan daftar klaster yang terbentuk  

2. Gunakan teknik sampling acak sederhana untuk memilih klaster  

3. Semua unit analisis dalam klaster yang terpilih akan diteliti 
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Sampling klaster satu tahap dimana populasi mepunyai N klaster 

                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    Gunakan sampling acak sederhana untuk memilih klaster dan 

semua anggota klaster yang terpilih diteliti 

                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    Gambar 3.3: 

Proses Sampling Klaster Satu Tahap 

Dalam sampling klaster dua tahap, proses sampling dilakukan dengan 

tahapan: 

1. Tentukan daftar klaster yang terbentuk  

2. Gunakan teknik sampling acak sederhana untuk memilih klaster  

3. Pilih unit analisis secara acak dari setiap klaster yang terpilih 
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Sampling klaster dua tahap dengan N klaster 

                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  

Gunakan sampling acak sederhana untuk memilih klaster. 

                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  

Gunakan sampling acak sederhana untuk memilih unit analisis 
dari klaster yang terpilih yang masuk menjadi anggota sampel 

                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  
                  

Gambar 3.4: 
Proses Sampling Klaster Dua Tahap 

Tidak ada suatu aturan yang mudah yang dapat digunakan untuk 

menentukan ukuran sampel minimal apabila penelitian survey dilakukan 

dengan menggunakan teknik sampling klaster. Suatu pendekatan yang pa-

ling mudah digunakan adalah dengan menggunakan pendekatan sampling 

acak sederhana dan kemudian mengalikan dengan design effect untuk men-

dapatkan ukuran sampel yang dibutuhkan pada sampling klaster. Design 

effect adalah rasio varians sampling klaster dengan varians sampling acak 

sederhana. Biasanya design effect diambil sebesar 2. 
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Modul Cluster Sampling digunakan untuk menghitung ukuran sampel 

minimal untuk teknik sampling klaster. Metoda yang digunakan untuk 

keperluan ini terdiri dari: 

▪ Sample size required to Estimate Mean 

▪ Sample size required to Estimate Proportion 

Disain input-output untuk menghitung ukuran sampel untuk meng-

estimasi rata-rata adalah seperti ditunjukkan dalam gambar berikut. 

 

Disain input-output untuk menghitung ukuran sampel untuk meng-

estimasi proporsi adalah seperti ditunjukkan dalam gambar berikut. 

 

 

D. SAMPLING SISTEMATIK (SYSTEMATIC SAMPLING) 

Sampling sistematik biasanya banyak digunakan dalam trafic survey 

atau marketing research. Ada beberapa peneliti yang menganggap sampling 

sistematik bukan merupakan sampling acak, padahal sampling sistematik 

merupakan sampling acak karena pemilihan pertama dilakukan secara acak. 

Beberapa peneliti menyebut sampling sistematik sebagai Quasi random 

sampling atau Pseudo random sampling. 

Sampling sistematik dapat dilakukan tanpa adanya kerangka sampling 

yang lengkap, misalnya dalam penelitian untuk populasi bergerak (mobile 

population). Kerugian sampling sistematik adalah jika dalam kerangka sam-

pling terdapat periodicity (letak satuan sampling yang mempunyai interval 

tetap dan mempunyai karakteristik yang sama). Cara mengatasi hal ini  
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adalah dengan mengubah atau mengambil random start beberapa kali 

(paling banyak 3 kali). 

Dalam sampling sistematik, proses sampling dilakukan dengan tahapan: 

1. Tentukan ukuran sampel 

2. Pilih random start dan interval 

3. Mulai dengan random start yang terpilih, dan tambahkan dengan interval 

sampai batas yang ditentukan  

4. Apabila terdapat periodicity, random start boleh diubah sampai 3 kali 

 

Gambar 3.5: 
Proses Sampling Sistematik 

Sampling sistematik merupakan alternatif dari sampling acak se-

derhana akan tetapi metode pemilihan data sampel berbeda. Sampling acak 

sederhana melakukan pemilihan sampel menggunakan tabel bilangan acak 

atau random generator, akan tetapi sampling sistematik melakukan pemi-

lihan sampel menggunakan random start dan interval. Oleh karenanya 

rumus ukuran sampel minimal untuk sampling sistematik dapat meng-

gunakan rumus ukuran sampel minimal untuk sampling acak sederhana. 
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Modul Systematic Sampling digunakan untuk menghitung ukuran 

sampel minimal untuk teknik sampling sistematik. Metode yang digunakan 

untuk keperluan ini terdiri dari: 

▪ Sample size required to Estimate Mean 

▪ Sample size required to Estimate Proportion 

▪ Sample size required to Estimate Correlation and Regression 

Disain input-output untuk menghitung ukuran sampel untuk meng-

estimasi rata-rata adalah seperti ditunjukkan dalam gambar berikut. 

 

Disain input-output untuk menghitung ukuran sampel untuk meng-

estimasi proporsi adalah seperti ditunjukkan dalam gambar berikut. 

 

Disain input-output untuk menghitung ukuran sampel untuk meng-

estimasi korelasi dan regresi adalah seperti ditunjukkan dalam gambar 

berikut. 
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E. RANDOM GENERATOR 

Seperti telah dijelaskan sebelumnya, proses pengacakan (pemilihan 

unit analisis dalam populasi yang terpilih menjadi anggota sampel) dapat 

dilakukan dengan undian, tabel bilangan atau random generator. Dengan 

menggunakan random generator proses pengacakan menjadi mudah dan 

cepat. 
 
Contoh Masalah  

Suatu populasi berukuran 100. Dari populasi tersebut akan diambil 

sampel berukuran 10. Tentukan nomor-nomor unit analisis yang terambil 

ke dalam sampel tersebut apabila pemilihan dilakukan secara acak. 
 
Pengerjaan dengan Menggunakan Unpad SAS 

Lakukan langkah-langkah berikut untuk menyelesaikan masalah di 

atas. 

▪ Pilih menu Analyze->Sampling->Stratified Sampling->Random Gene-

rator. 

 

Perintah tersebut akan menampilkan kotak dialog sebagai berikut. 
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▪ Masukkan 100 untuk ruas Population size, 10 untuk ruas Sample size, dan 

klik tombol <Generate>. 

Atas perintah ini maka nomor-nomor unit analisis yang terambil akan 

ditampilkan didalam tabel, yaitu seperti ditunjukkan di bawah ini. 

 

Nomor-nomor unit analisis yang terambil akan selalu berubah setiap kali 

perintah <Generate> diberikan. 

▪ Klik <Copy to clipboard> untuk menyalin nilai-nilai tersebut sehingga 

Anda dapat menempelkannya ke dalam dokumen lain.. 
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4 
Uji Nonparametrik 

 

 

A. UJI CHI-SQUARE UNTUK SATU SAMPEL 

Uji chi-kuadrat digunakan untuk menguji kasus satu sampel dengan 

data nominal. Uji ini dinamakan juga uji kecocokan distribusi.  
 
Contoh Masalah  

Sebuah penelitian dilakukan untuk mengetahui perbedaan minat 

pemilihan jurusan pada lulusan kelas satu Sekolah Menengah Atas.  

Data 45 siswa yang mengikuti tes didapatkan data sebagai berikut:  

ID Minat  ID Minat  ID Minat 

1 1  16 3  31 1 

2 1  17 2  32 1 

3 3  18 2  33 1 

4 3  19 2  34 1 

5 3  20 2  35 1 

6 3  21 2  36 1 

7 3  22 2  37 3 

8 3  23 2  38 3 

9 3  24 2  39 3 

10 3  25 2  40 3 

11 3  26 2  41 2 

12 3  27 1  42 2 

13 3  28 1  43 2 

14 3  29 1  44 2 

15 3  30 1  45 2 

Keterangan: 
Minat: 1=IPA, 2=IPS, 3=BAHASA 

 

Dengan taraf nyata 10%, 5%, dan 1%, ujilah apakah terdapat perbedaan 

minat pemilihan jurusan pada siswa SMA tersebut? 
 
Pengerjaan Secara Manual 

1. Rumuskan hipotesis. 

H0: Tidak terdapat perbedaan minat pemilihan jurusan pada siswa SMA  
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H1 :  Terdapat perbedaan minat pemilihan jurusan pada siswa SMA 

2. Statistik Uji 

▪ Tetapkan V untuk variabel yang akan diuji. 

▪ Hitunglah: 

• N = jumlah seluruh sampel 

• k = jumlah kategori 

• df = jumlah kategori – 1 

Untuk contoh masalah di atas, N = 45, k = 3, dan df = 2. 

▪ Buatlah tabel kontingensi untuk nilai O (observasi) yang menggam-

barkan frekuensi tiap kategori. 

V O 

1 O1 

.. .. 

k Ok 

Untuk contoh masalah di atas adalah: 

Minat Observasi 

1 12 

2 18 

3 15 

▪ Hitunglah nilai harapan E (ekspektasi) dari keseluruhan kategori de-

ngan rumus E = N/k 

V O E 

1 O1 E1 

.. .. .. 

K Ok Ek 

Untuk contoh masalah di atas adalah: 

Minat Observasi Ekspektasi 

1 12 15 

2 18 15 

3 15 15 

▪ Hitunglah nilai χ2 dengan rumus: 

𝜒2 =  ∑
(𝑂𝑖 −  𝐸𝑖)2

𝐸𝑖

𝑘

𝑖=1

 

Untuk contoh masalah di atas adalah: 

𝜒2 =  
(12 − 15)2 + (18 − 15)2 + (15 − 15)2

15
 

𝜒2 =  1,2 
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▪ Cari χ2tabel untuk df dan α = 0,10, 0,05, dan 0,01 dari tabel chi-square. 

Untuk contoh masalah di atas, df = 2, maka nilai χ2tabel untuk α = 0,10, 

0,05, dan 0,01 adalah: 

χ2
(2; 0,10) = 4,60517 

χ2(2; 0,05) = 5,99146 

χ2(2; 0,01) = 9,21034 

3. Kriteria uji  

Tolak H0 jika nilai  p <  nilai α=0,05.  

Dari tabel Chi-Square dengan nilai χ2=1,2 dan nilai df= 2 didapatkan nilai 

p value = diantara 0,3 – 0,5, sehingga dapat dikatakan nilai p value > 0,3.  

4. Kesimpulan  

Karena nilai χ2 = 1,2 > 0,5, maka H0 diterima. 

Artinya, tidak terdapat perbedaan minat pemilihan jurusan pada siswa 

SMA 
 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Buka tabel contoh np_chi 

▪ Pilih menu Analyze->Nonparametric Test->Chi-Square 

▪ Pilih variabel Minat untuk untuk test variable seperti pada gambar di 

bawah ini. 
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▪ Pilih Get from data untuk Expected Range dan All categories equal untuk 

Expected Values. 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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B. UJI RUNTUN UNTUK SATU SAMPEL 

Uji runtun digunakan untuk menguji keacakan sampel. 
 
Contoh Masalah  

Seorang peneliti tertarik untuk melihat apakah barisan yang terjadi di 

sebuah bioskop bersifat random atau tidak. Data di peroleh dengan sangat 

sederhana yaitu dengan melakukan hitungan terhadap urutan barisan yang 

terjadi di bioskop tersebut.  

Dari 50 orang yang mengantri di bioskop tersebut didapatkan data 

sebagai berikut : [np_runs] 
 

ID JK  ID JK  ID JK  ID JK  ID JK 

1 1  11 0  21 1  31 0  41 0 

2 0  12 1  22 0  32 1  42 1 

3 1  13 0  23 1  33 0  43 1 

4 0  14 1  24 0  34 1  44 1 

5 1  15 0  25 1  35 0  45 1 

6 1  16 1  26 1  36 1  46 0 

7 1  17 1  27 0  37 1  47 1 

8 0  18 1  28 0  38 0  48 0 

9 0  19 1  29 0  39 1  49 1 

10 1  20 0  30 1  40 1  50 1 
Keterangan: 
JK (Jenis Kelamin): 0=Perempuan, 1=Laki-laki 

 

Dengan taraf nyata 10%, 5%, dan 1% ujilah apakah barisan tersebut bersifat 

atau tidak ? 
 
Pengerjaan Secara Manual  

1. Rumuskan hipotesis. 

H0: Urutan laki-laki dan perempuan di pada barisan antrian bioskop 

bersifat acak 

H1: Urutan laki-laki dan perempuan di pada barisan antrian bioskop 

bersifat tidak acak 

2. Statistik Uji 

▪ Hitunglah: 

• N = jumlah sampel 

• n = jumlah sampel kategori pertama (perempuan) 

• m = jumlah sampel kategori kedua (laki-laki) 

• r = jumlah runtun 
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Untuk contoh masalah di atas, N = 50, n = 20, m = 30, dan r = 35 

▪ Karena jumlah m atau n lebih dari 20 maka digunakan rumus dengan 

pendekatan distribusi normal: 

𝑍 =  
𝑟 + ℎ − (

2𝑚𝑛

𝑁+1
)

√
(2𝑚𝑛(2𝑚𝑛−𝑁))

(𝑁2 (𝑁−1))

 

dimana: 

• h = 0,5 jika 𝑟 < (
2𝑚𝑛

𝑁+1
) 

• h = -0,5 jika 𝑟 > (
2𝑚𝑛

𝑁+1
) 

Untuk contoh masalah di atas adalah: 

𝑍 =  
35 − 0,5 − (

2∗30∗20

50+1
)

√
(2∗30∗20(2∗30∗20−50))

(502 (50−1))

 

𝑍 =  2,976 

▪ Cari nilai Ztabel dari tabel distribusi normal untuk taraf nyata 10%, 5%, 

dan 1%. Dari tabel diperoleh: 

Z0,10 = 1,6448 

Z0,05 = 1,9600 

Z0,01 = 2,5760 

3. Kriteria uji  

Tolak H0 jika nilai Zhitung > Ztabel. 

Untuk contoh masalah di atas, karena nilai Zhitung > Ztabel maka H0 ditolak. 

4. Kesimpulan 

Urutan laki-laki dan perempuan di pada barisan antrian bioskop bersifat 

tidak acak. 
 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Buka tabel contoh np_run 

▪ Pilih menu Analyze->Nonparametric Test->Runs 

▪ Pilih variabel JK untuk untuk test variable seperti pada gambar di bawah 

ini. 
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▪ Pilih/contreng Median untuk Test Type. 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 

 

 

C. 2-INDEPENDENT SAMPLES 

1. Uji Mann Whitney 

Uji Mann Whitney digunakan untuk menguji kasus 2 sampel in-

dependen dengan variabel yang memiliki skala pengukuran ordinal. 
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Contoh Masalah  

Suatu penelitian dilakukan untuk mengetahui apakah ada perbedaan 

hasil belajar IPA antara kelas yang belajar dengan metode praktikum dan 

teori. Setelah mengikuti ujian pelajaran IPA didapatkan data peringkat siswa 

di kelas sebagai berikut: 
 

ID Metode Peringkat  ID Metode Peringkat  ID Metode Peringkat 

1 1 15  21 1 10  41 2 34 

2 2 29  22 2 28  42 2 45 

3 1 23  23 2 51  43 1 12 

4 2 3  24 1 1  44 2 38 

5 1 53  25 1 6  45 1 8 

6 1 22  26 2 46  46 1 9 

7 2 33  27 2 43  47 2 56 

8 1 18  28 1 2  48 2 50 

9 1 52  29 1 54  49 1 32 

10 2 24  30 2 25  50 2 35 

11 1 16  31 2 20  51 1 4 

12 1 21  32 1 31  52 2 47 

13 2 44  33 1 5  53 1 7 

14 2 37  34 2 19  54 1 13 

15 2 48  35 1 14  55 1 41 

16 1 17  36 2 27  56 1 11 

17 2 49  37 2 39     

18 1 40  38 1 30     

19 2 36  39 2 55     

20 2 42  40 2 26     
 KETERANGAN 
 Metode: 1=praktikum, 2=teori 

Dengan taraf nyata 10%, 5%, dan 1% ujilah apakah terdapat perbedaan hasil 

belajar IPA antara kelas yang belajar dengan praktikum dan teori? 
 
Pengerjaan Secara Manual 

1. Rumuskan Hipotesis 

H0: Tidak terdapat perbedaan nilai IPA antara metode belajar prak-

tikum dengan metode belajar teori 

H1: Terdapat perbedaan nilai IPA antara metode belajar praktikum 

dengan metode belajar teori. 

2. Statistik Uji 

▪ N = Jumlah keseluruhan sampel 

▪ Ranking data untuk variabel Peringkat. 
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ID Metode Peringkat  ID Metode Peringkat  ID Metode Peringkat 

 1 1   1 21   1 41 

 1 2   1 22   2 42 

 2 3   1 23   2 43 

 1 4   2 24   2 44 

 1 5   2 25   2 45 

 1 6   2 26   2 46 

 1 7   2 27   2 47 

 1 8   2 28   2 48 

 1 9   2 29   2 49 

 1 10   1 30   2 50 

 1 11   1 31   2 51 

 1 12   1 32   1 52 

 1 13   2 33   1 53 

 1 14   2 34   1 54 

 1 15   2 35   2 55 

 1 16   2 36   2 56 

 1 17   2 37     

 1 18   2 38     

 2 19   2 39     

 2 20   1 40     

▪ Jumlahkan nilai Ranking untuk setiap kategori Metode, yaitu “prak-

tikum” dan “teori”. Dalam contoh masalah ini, jumlah nilai rangking 

untuk kategori “praktikum” adalah 567 dan untuk kategori “teori” 

adalah 1.029. 

▪ Tetapkan nilai Wx, yaitu jumlah ranking yang lebih kecil. Dalam contoh 

masalah ini Wx = 567 (Metode Praktikum). 

▪ Tetapkan nilai m, yaitu jumlah sampel kelompok yang lebih kecil. 

▪ Tetapkan nilai n, yaitu jumlah sampel kelompok yang lebih besar. 

▪ Gunakan rumus Wilcoxon-Mann Whitney dengan pendekatan distri-

busi normal: 

𝑍 =  
𝑊𝑥  ± 0,5 −

𝑚(𝑁+1)

2

√
𝑚𝑛(𝑁+1)

12

 

Keterangan: 

Z ditambah 0,5 jika Wx < m(N+1)/2 

Z dikurangi 0,5 jika Wx > m(N+1)/2 

▪ Untuk contoh masalah di atas, nilai Z adalah 
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𝑍 =  
567 ± 0,5 −

28(56+1)

2

√
28∗28(56+1)

12

 

𝑍 =  −3,77717 

▪ Cari Ztabel untuk α=0,10, 0,05, dan 0,01 dari tabel distribusi normal. 

Z(0,10) = 1,6448 uji dua pihak 

Z(0,05) = 1,9600 uji dua pihak 

Z(0,01) = 2,5760 uji dua pihak 

Z(0,10) = 1,2816 uji satu pihak 

Z(0,05) = 1,6448 uji satu pihak 

Z(0,01) = 2,3263 uji satu pihak 

3. KriteriaUji 

Kriteria uji tolak H0 jika Z > Ztabel. 

Dengan nilai α = 10%, 5%, maupun 1% maka H0 = ditolak. 

4. Kesimpulan 

Dapat disimpulkan bahwa “Terdapat perbedaan nilai IPA antara metode 

belajar praktikum dengan metode belajar teori”. 
 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Buka tabel contoh np_2inde 

▪ Pilih menu Analyze->Nonparametric Test->2-Independent Samples 

▪ Pilih variabel Metode untuk grouping variables dan variabel Peringkat 

untuk test variable seperti pada gambar di bawah ini. 
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▪ Pilih/contreng Mann-Whitney U untuk Test Type. 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 

 
 
2. Uji Chi-square 

Uji ini dapat digunakan untuk menguji dua kelompok yang inde-

penden dengan variabel yang memiliki skala pengukuran paling sedikit 

nominal dan berbentuk data kategori. 
 
Contoh Masalah  

Suatu penelitian dilakukan untuk mengetahui apakah ada perbedaan jenis 

pekerjaan yang dipilih laki-laki dengan perempuan. Pengambilan terhadap 

18 orang memberikan hasil sebagai berikut. 

ID JK JP  ID JK JP  ID JK JP 

1 1 1  7 1 3  13 2 2 

2 1 1  8 1 3  14 2 2 

3 1 1  9 2 1  15 2 2 

4 1 2  10 2 1  16 2 2 

5 1 2  11 2 1  17 2 3 

6 1 2  12 2 1  18 2 3 
KETERANGAN 
JK (Jenis Kelamin): 1=Laki-laki, 2=Perempuan 
JP (Pekerjaan): 1: PNS, 2: Swasta, 3: Lainnya 
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Dengan taraf nyata 10%, 5%, dan 1% ujilah apakah terdapat perbedaan jenis 

pekerjaan yang dipilih antara laki-laki dengan perempuan? 
 
Pengerjaan Secara Manual 

1. Rumuskan Hipotesis 

H0: Tidak terdapat perbedaan jenis pekerjaan yang dipilih antara laki-

laki dengan perempuan. 

H1: Terdapat perbedaan jenis pekerjaan yang dipilih laki-laki dengan 

perempuan. 

2. Statistik Uji 

▪ Tetapkan: 

• V1 = variabel yang akan diuji 

• V2 = variabel kelompok 

Untuk contoh masalah di atas, V1 = JP dan V2 = JK. 

▪ Hitunglah: 

• N = jumlah data 

• c = jumlah kategori JP 

• r = jumlah kategori JK 

• df =(r-1)(c-1) 

Untuk contoh masalah di atas, N = 18, c = 3, r = 2, dan df = 2. 

▪ Buat tabel kontingensi V2-V1 dengan nilai O (observasi) berupa 

frekuensi pasangan V2-V1. 
 

  V1 
Total 

 i     j 1 .. c 

V2 

1 O11 .. O1j m1 

.. .. .. .. .. 

R Or1 .. Orc mr 

Total n1 .. nc N 

𝑚𝑟 = ∑ 𝑂𝑟𝑗

𝑐

𝑗=1

 

𝑛𝑐 = ∑ 𝑂𝑐𝑖

𝑟

𝑖=1

 

Untuk contoh masalah di atas, tabel kontingensinya adalah: 
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Pekerjaan 

Total 
1 2 3 

Jenis Kelamin 
1 3 3 2 8 

2 4 4 2 10 

Total 7 7 4 18 
 

▪ Buat tabel bantu untuk mendapatkan nilai E (ekspektasi) dari setiap 

nilai O (observasi). 

  V1 

 i     j 1 .. c 

V2 

1 E11 .. E1j 

.. .. .. .. 

r Er1 .. Erc 

𝐸𝑖𝑗 =
𝑚𝑖 ∗ 𝑛𝑗

𝑁
 

Untuk contoh masalah di atas, tabel bantunya adalah: 

 
Pekerjaan 

1 2 3 

Jenis Kelamin 
1 3,1111 3,1111 1,7778 

2 3,8889 3,8889 2,2222 
 

▪ Hitung χ2 dengan rumus 

𝜒2 =  ∑ ∑
(𝑂𝑖𝑗 − 𝐸𝑖𝑗)

2

𝐸𝑖𝑗

𝑐

𝑗=1

𝑟

𝑖=1

 

Untuk contoh masalah di atas adalah sebagai berikut. 

𝜒2 = 0,0040 + 0,0040 + 0,0278 + 0,0032 + 0,0032 + 0,0222 
𝜒2 = 0,0643 

▪ Cari χ2tabel untuk df=2 dan α=0,10, 0,05, dan 0,01 dari tabel chi-square. 

χ2(2; 0,10) = 4,60517 

χ2(2; 0,05) = 5,99146 

χ2(2; 0,01) = 9,21034 

3. KriteriaUji 

Kriteria uji tolak H0 jika χ2hitung > χ2tabel. 

Untuk contoh kasus di atas, dengan nilai α = 10%, 5%, dan 1% maka H0  

diterima. 

4. Kesimpulan 

Dapat disimpulkan bahwa “Tidak terdapat perbedaan jenis pekerjaan yang 

dipilih antara laki-laki dengan perempuan”. 
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Pengerjaan dengan Menggunakan Unpad SAS 

▪ Buka tabel contoh np_2inde_5 

▪ Pilih menu Analyze->Nonparametric Test->2-Independent Samples 

▪ Pilih variabel JK untuk grouping variables dan variabel JP untuk test 

variable seperti pada gambar di bawah ini. 

 

▪ Pilih/contreng Chi-square untuk Test Type. 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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D. K-INDEPENDENT SAMPLES 

1. Uji Kruskal Wallis H 

Uji Kruskal Wallis dapat digunakan untuk menguji kasus k sampel 

independen dengan variabel yang memiliki skala pengukuran ordinal. 
 
Contoh Masalah 

Seorang guru olahraga ingin mengetahui mengenai minat muridnya 

menjadi atlet olahraga. Diasumsikan bahwa anak-anak yang memiliki minat 

baik di bidang olahraga akan mendapatkan nilai yang baik dan memiliki 

peluang untuk menjadi atlet olahraga yang lebih besar. Terdapat tiga 

kelompok murid yang dibedakan berdasarkan minatnya, yaitu murid yang 

hanya menyukai mata pelajaran ilmiah, murid yang menyukai pelajaran 

ilmiah dan olahraga, dan murid yang hanya menyukai bidang olahraga. Guru 
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tersebut pun mengambil 14 sampel anak yang dibagi menjadi 3 kategori di 

atas. 

Data minat siswa dituliskan dalam tabel berikut (data fiktif) beserta 

skor minatnya terhadap olahraga. 

ID Minat Skor  ID Minat Skor 

1 3 149  8 1 101 

2 1 83  9 2 82 

3 2 132  10 1 96 

4 1 128  11 3 166 

5 2 124  12 2 135 

6 1 61  13 3 115 

7 2 109  14 3 147 
Minat: 1=Olahraga, 2=Ilmiah, 3=Olahraga dan Ilmiah 

 
Penyelesaian Secara Manual 

1. Hipotesis. 

H0 : Tidak ada perbedaan yang signifikan antara nilai rata-rata minat 

kelompok murid dari ketiga kategori tersebut 

H1 : Terdapat perbedaan yang signifikan antara nilai rata-rata minat 

kelompok murid dari ketiga kategori tersebut 

2. Sort Data berdasarkan nilai dan beri ranking 

ID Minat Skor Ranking 

8 1 61 1 

3 2 82 2 

6 1 83 3 

2 1 96 4 

10 1 101 5 

12 2 109 6 

1 3 115 7 

5 2 124 8 

4 1 128 9 

7 2 132 10 

9 2 135 11 

14 3 147 12 

11 3 149 13 

13 3 166 14 

3. Kelompokkan Data Berdasarkan Skor-Minat 

Skor-Minat 

1 2 k 

96 82 115 

128 124 149 

83 132 166 

61 135 147 

101 109   
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4. Kelompokkan Data Berdasarkan Ranking-Minat 

Rangking-Minat 

1 2 K 

4 2 7 

9 8 13 

3 10 14 

1 11 12 

5 6   

5. Hitung n1 sampai nk, R1 sampai Rk. 

 1 2 k 

n 5 5 4 

R 22 37 46 

6. Hitung Hhitung dan Htable 

𝐻ℎ𝑖𝑡𝑢𝑛𝑔 =  
12

𝑁(𝑁 + 1)
 ∑

𝑅𝑗

𝑛𝑗

2𝑘

𝑗=1
− 3(𝑁 + 1) 

Untuk contoh masalah di atas adalah sebagai berikut. 

𝐻ℎ𝑖𝑡𝑢𝑛𝑔 =  
12

14(14 + 1)
 (

222

5
+

372

5
+

462

4
) − 3(14 + 1) 

𝑯𝒉𝒊𝒕𝒖𝒏𝒈 = 𝟔, 𝟒𝟎𝟓𝟕𝟏𝟒 

𝐻𝑡𝑎𝑏𝑒𝑙 = 𝜒(𝑑𝑓; 0,05) 

𝐻𝑡𝑎𝑏𝑒𝑙 = 𝜒(2; 0,05) 

𝑯𝒕𝒂𝒃𝒆𝒍 = 𝟓, 𝟗𝟗𝟏𝟒𝟔𝟓 

7. Uji Hipotesis 

H0 diterima jika Hhitung < Htabel. 

Dalam contoh masalah di atas, Hhitung ≥ Htabel (6,405714 ≥ 5,9915),  maka H0 

ditolak.  

8. Kesimpulan 

Terdapat perbedaan yang signifikan antara nilai rata-rata minat 

kelompok murid dari ketiga kategori tersebut 

9. Uji Lanjutan 

Pada kasus ini, ketiga kelompok tersebut memiliki rata-rata nilai minat 

yang berbeda. Oleh karena itu, dilakukanlah pengujian lanjutan untuk 

mengetahui rata-rata nilai minat mana saja yang berbeda. Pengujian 

tersebut dilakukan dengan mengambil 2 kelompok, lalu diuji.  
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Karena kasus di atas ada 3 kelompok, maka pengujian ini dilakukan 

sebanyak 3 kali, yaitu kelompok 1 (olahraga) dengan kelompok 2 (ilmiah), 

kelompok 2 (ilmiah) dengan kelompok 3 (keduanya) dan kelompok 1 

(olahraga) dengan kelompok 3 (keduanya). 

Jika, 

 |
𝑅𝑖

𝑛𝑖
−  

𝑅𝑗

𝑛𝑗
| ≤  𝑍𝛼/[𝑘(𝑘−1)]√

𝑁(𝑁+1)

12
 (

1

𝑛𝑖
+

1

𝑛𝑗
) 

Maka kedua kelompok tersebut tidak memiliki perbedaan rata rata nilai 

yang signifikan 

Dan jika,  

 |
𝑅𝑖

𝑛𝑖
−  

𝑅𝑗

𝑛𝑗
| > 𝑍1−𝛼/[𝑘(𝑘−1)]√

𝑁(𝑁+1)

12
 (

1

𝑛𝑖
+

1

𝑛𝑗
) 

 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Buka tabel contoh np_kinde_1 

▪ Pilih menu Analyze->Nonparametric Test->K-Independent Samples 

▪ Pilih variabel Minat untuk grouping variables dan variabel Skor untuk test 

variable seperti pada gambar di bawah ini. 

 

▪ Pilih/contreng Kruskal-Wallis H untuk Test Type. 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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E. 2-RELATED SAMPLES 

1. Uji Wilcoxon 

Uji Wilcoxon dapat digunakan untuk menguji kasus 2 sampel yang 

berpasangan dengan variabel yang memiliki skala pengukuran ordinal. 
 
Contoh Masalah 

Seorang peneliti ingin mengetahui efek dari pelatihan terhadap 

motivasi berprestasi siswa SMA. Terdapat 12 orang siswa yang mengikuti 

pelatihan tersebut. Sebelum dan sesudah pelatihan, siswa tersebut mengisi 

kuesioner mengenai motivasi berprestasi.  

Kuesioner ini terdiri dari 20 pernyataan dimana siswa harus memilih 

jawaban 1: Jika tidak setuju pada pernyataan, jawaban 2: Jika ragu-ragu 

terhadap pernyataan, dan jawaban 3: Jika setuju pada pernyataan yang 

diberikan.  

Skor total dari 20 pertanyaan tersebut adalah sebagai berikut: 
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No 
Siswa 

Sebelum 
Pelatihan 

Sesudah 
Pelatihan 

 No 
Siswa 

Sebelum 
Pelatihan 

Sesudah 
Pelatihan 

1 22 44  7 30 44 

2 28 32  8 29 21 

3 18 24  9 20 36 

4 26 38  10 44 42 

5 20 44  11 18 36 

6 19 29  12 35 55 

Dengan taraf nyata 10%, 5%, dan 1% ujilah apakah terdapat per-

bedaan motivasi berprestasi siswa antara sebelum dan setelah pelatihan? 
 
Pengerjaan Secara Manual 

1. Rumuskan Hipotesis 

H0: Tidak terdapat perbedaan perbedaan motivasi berprestasi siswa 

antara sebelum dan setelah pelatihan 

H1: Terdapat perbedaan motivasi berprestasi siswa antara sebelum dan 

setelah pelatihan. 

2. Statistik Uji 

▪ Hitunglah: 

• N = jumlah responden 

Untuk contoh masalah di atas, N = 12 

▪ Tetapkan: 

• V1 = Sebelum 

• V2 = Sesudah 

▪ Buat tabel bantu dengan menambahkan variabel D, yang nilainya 

merupakan beda (selisih) dari V1 dengan V2. 

D = V2 – V1 

n V1 V2 D 

1 .. .. .. 

.. .. .. .. 

N .. .. .. 

Untuk contoh masalah di atas adalah sebagai berikut. 

n Sebelum Sesudah D 

1 22 44 22 

2 28 32 4 

3 18 24 6 

4 26 38 12 

5 20 44 24 

6 19 29 10 

7 30 44 14 
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n Sebelum Sesudah D 

8 29 21 -8 

9 20 36 16 

10 44 42 -2 

11 18 36 18 

12 35 55 20 

▪ Tambahkan variabel r dan R terhadap tabel bantu tersebut. Lakukan pe-

ranking-an terhadap tabel bantu tersebut, berdasarkan variabel D 

tanpa mempertimbangkan nilai positip atau negatipnya, dan nilai 

ranking-nya ditetapkan terhadap variabel r. 

Untuk contoh masalah di atas adalah sebagai berikut. 

ID V1 V2 D r 

10 44 42 -2 1 

2 28 32 4 2 

3 18 24 6 3 

8 29 21 -8 4 

6 19 29 10 5 

4 26 38 12 6 

7 30 44 14 7 

9 20 36 16 8 

11 18 36 18 9 

12 35 55 20 10 

1 22 44 22 11 

5 20 44 24 12 

▪ Jumlahkan ranking yang memiliki perbedaan positif (T⁺) dan yang 

memiliki perbedaan negatif (T⁻) 

Untuk contoh masalah di atas adalah: 

• T⁺ = 73 

• T⁻ = 5 

▪ Hitung Z dengan rumus: 

𝑍 =
𝑇+ −

𝑁(𝑁+1)

4

√
𝑁(𝑁+1)(2𝑁+1)

24

 

Untuk contoh masalah di atas, perhitungannya adalah: 

𝑍 =
73 −

12(12+1)

4

√
12(12+1)(2∗12+1)

24

 

𝑍 =
73 − 39

√162,5
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𝑍 =
34

12,7476
 

𝑍 = 2,6672 

▪ Cari Ztabel untuk α=0,10, 0,05, dan 0,01 dari tabel distribusi normal. 

Z(0,10) = 1,6448 uji dua pihak 

Z(0,05) = 1,9600 uji dua pihak 

Z(0,01) = 2,5760 uji dua pihak 

Z(0,10) = 1,2816 uji satu pihak 

Z(0,05) = 1,6448 uji satu pihak 

Z(0,01) = 2,3263 uji satu pihak 

3. Kriteria Uji  

Kriteria uji, tolak H0 jika nilai Z > Ztabel. 

Untuk contoh masalah di atas, dengan nilai α = 10%, 5%, maupun 1% 

maka H0 = ditolak. 

4. Kesimpulan  

Dapat disimpulkan bahwa terdapat perbedaan motivasi beprestasi siswa 

antara sebelum pelatihan dan sesudah pelatihan. 
 
Pengerjaan dengan Menggunakan Unpad SAS 

▪ Buka tabel contoh np_2rel_1 

▪ Pilih menu Analyze->Nonparametric Test->2-Related Samples 

▪ Untuk pasangan 1 (Pair 1), pilih variabel Sebelum untuk Variable1 dan 

variabel Sesudah untuk Variable2 seperti pada gambar di bawah ini. 
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▪ Pilih/contreng Wilcoxon untuk Test Type. 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 

 
 
2. Uji McNemar 

Uji McNemar dapat digunakan untuk menguji kasus 2 sampel yang 

berpasangan dengan variabel yang memiliki skala pengukuran nominal. 
 
Contoh Masalah  

Partai politik A mengadakan kampanye yang dihadiri oleh 75 orang peserta. 

Sebelum dilakukan kampanye panitia mengadakan penelitian mengenai 

pilihan peserta terhadap partai politik A. Setelah diadakan kampanye panitia 

kembali mengambil data untuk melihat pilihan peserta terhadap partai 

politik A kembali. 

ID Sebelum Sesudah  ID Sebelum Sesudah  ID Sebelum Sesudah 

1 1 0  26 1 1  51 0 0 

2 1 0  27 1 1  52 0 0 

3 1 0  28 1 1  53 0 0 

4 1 0  29 1 1  54 0 0 

5 1 0  30 1 1  55 0 0 

6 1 0  31 1 1  56 0 0 

7 1 0  32 1 1  57 0 0 

8 1 0  33 1 1  58 0 0 

9 1 0  34 1 1  59 0 1 
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ID Sebelum Sesudah  ID Sebelum Sesudah  ID Sebelum Sesudah 

10 1 0  35 1 1  60 0 1 

11 1 0  36 1 1  61 1 1 

12 1 0  37 0 0  62 1 1 

13 1 0  38 0 0  63 1 1 

14 1 1  39 0 0  64 1 1 

15 1 1  40 0 0  65 1 1 

16 1 1  41 0 0  66 0 0 

17 1 1  42 0 0  67 0 0 

18 1 1  43 0 0  68 0 0 

19 1 1  44 0 0  69 0 0 

20 1 1  45 0 0  70 0 0 

21 1 1  46 0 0  71 0 1 

22 1 1  47 0 0  72 0 1 

23 1 1  48 0 0  73 0 1 

24 1 1  49 0 0  74 0 1 

25 1 1  50 0 0  75 0 1 
Keterangan :  
1 = Memilih, 0 = Tidak Memilih 
 
Dengan taraf nyata 10%, 5%, dan 1% ujilah apakah terdapat perbedaan 

pilihan peserta terhadap partai politik A? 
 
Penyelesaian Secara Manual 

1. Rumuskan Hipotesis 

H0: Tidak ada perbedaan pilihan peserta terhadap partai politik A baik 

sebelum ataupun sesudah kampanye 

H1: Terdapat perbedaan pilihan peserta terhadap partai politik A baik 

sebelum ataupun sesudah kampanye 

2. Statistik Uji 

▪ Hitunglah: 

• N = jumlah responden 

• k = jumlah kategori 

• df = k-1 

Untuk contoh masalah di atas, N = 75, k = 2, dan df = 1; 

▪ Tetapkan: 

• V1 = Sebelum 

• V2 = Sesudah 

▪ Buat tabel kontingensi 2 x 2 untuk pasangan V1-V2: 
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V1 
V2 

1 2 

1 C D 

2 A B 

• A adalah subjek dimana sebelum perlakuan responden memilih pi-

lihan 2 dan sesudah perlakuan memilih pilihan 1. 

• D adalah subjek dimana sebelum perlakuan responden memilih 

pilihan 1 dan sesudah perlakukan memilih pilihan 2, sedangkan 

• B dan C adalah subjek yang tidak mengalami perubahan respon 

sebelum dan sesudah perlakuan. 

Untuk contoh masalah di atas, tabel kontingensinya adalah: 

Sebelum 
Sesudah 

Tidak Memilih Memilih 

Tidak Memilih 27 7 

Memilih 13 28 

▪ Hitunglah χ2 dengan rumus di bawah ini :  

𝜒2 =
(|𝐴 − 𝐷| − 1)2

𝐴 + 𝐷
 

Untuk contoh masalah di atas, perhitungannya adalah: 

𝜒2 =
(|13 − 7| − 1)2

13 + 7
 

𝜒2 =
52

20
= 1,25 

▪ Cari χ2tabel untuk df dan α = 0,10, 0,05, dan 0,01 dari tabel chi-square. 

Untuk contoh masalah di atas, df = 1, maka nilai χ2tabel untuk α = 0,10, 

0,05, dan 0,01 adalah: 

χ2(1; 0,10) = 2,70554 

χ2
(1; 0,05) = 3,84146 

χ2
(1; 0,01) = 6,6349 

3. Kriteria Uji  

Kriteria uji tolak H0 jika χ2 > χ2
tabel. 

Untuk contoh masalah di atas, dengan nilai α = 10%, 5%, maupun 1% 

maka H0 = diterima. 

4. Kesimpulan  

Dapat disimpulkan bahwa “tidak ada perbedaan pilihan peserta terhadap 

partai politik A baik sebelum ataupun sesudah kampanye”. 
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Pengerjaan dengan Menggunakan Unpad SAS 

▪ Buka tabel contoh np_2rel_3 

▪ Pilih menu Analyze->Nonparametric Test->2-Related Samples 

▪ Untuk pasangan (Pair 1), pilih variabel Sebelum untuk Variabel1 dan 

variabel Sesudah untuk Variable2 seperti pada gambar di bawah ini. 

 

▪ Pilih/contreng McNemar untuk Test Type. 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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F. K-RELATED SAMPLES 

1. Uji Friedman 

Uji Friedman adalah uji digunakan untuk membandingkan skor (nilai 

pengamatan) dari k sampel atau kondisi yang berpasangan (banyaknya pe-

ngamatan setiap sampel atau kondisi sama) dimana perlakuan yang dite-

rapkan terhadap obyek lebih dari 2 kali.  

Uji ini sama dengan 2 ways anova pada statistic parametric dan di-

gunakan pada data dengan skala ordinal.  

Dilakukan ranking (peringkat) terhadap seluruh perlakuan/kondisi 

pada setiap responden. 
 
Contoh Masalah 

Dilakukan sebuah penelitian pada 15 responden tentang perbedaan 3 

shift kerja terhadap kinerja perawat sebuah RS Swasta di Jakarta.  

Berikut data yang diperoleh: 

ID Shift 1 Shift 2 Shift 3 

1 76 70 75 

2 71 65 77 

3 56 57 74 

4 67 60 59 

5 70 56 76 

6 77 71 73 

7 45 47 78 

8 60 67 62 

9 63 60 75 

10 60 59 74 

11 61 57 60 

12 56 60 75 

13 59 54 70 

14 74 72 71 

15 66 63 65 
 
Pengerjaan Secara Manual 

1. Rumuskan hipotesis. 

H0: Tidak ada perbedaan kinerja perawat pada masing-masing shift 

kerja 

H1: Ada perbedaan kinerja perawat pada masing-masing shift kerja 

2. Lakukan ranking pada nilai yang diperoleh masing-masing responden 

pada semua shift kerja.  
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Ranking ditentukan berdasarkan banyaknya k dari responden 1 dalam 

semua perlakuan/kondisi. Misal: responden 1 mendapat nilai kinerja 

pada shift 1, 2, dan 3 masing-masing 76, 70 dan 75. Maka ranking-nya 

ditentukan berdasarkan nilai terkecil, yaitu 70, 75, dan 76 masing-masing 

peringkat 1, 2, dan 3. Hasilnya seperti pada tabel berikut ini.  

ID V1 ... Vk SR1 ... SR3 

1 76 70 75 3 1 2 

2 71 65 77 2 1 3 

3 56 57 74 1 2 3 

4 67 60 59 3 2 1 

5 70 56 76 2 1 3 

6 77 71 73 3 1 2 

7 45 47 78 1 2 3 

8 60 67 62 1 3 2 

9 63 60 75 2 1 3 

10 60 59 74 2 1 3 

11 61 57 60 3 1 2 

12 56 60 75 1 2 3 

13 59 54 70 2 1 3 

14 74 72 71 3 2 1 

15 66 63 65 3 1 2 

Jumlah 961 918 1064 32 22 36 

    R1 ... Rk 

3. Hitung dengan rumus uji Friedman.  

𝜒2 =  [
12

𝑛𝑘 (𝑘 + 1)
(∑ 𝑅𝑗

2)] − 3𝑛 (𝑘 + 1) 

Untuk contoh masalah di atas hasilnya adalah sebagai berikut. 

𝜒2 = [
12

(15)(3)(3 + 1)
((322 + 222 +  362)] − 3(15)(3 + 1) 

𝜒2 =  
12

180
 (2804) − 180 

𝜒2 = 186,93 − 180 

𝜒2 =  6,93 

Jadi, diperoleh nilai χ2 adalah 6,93. 

4. Kriteria uji  

Terima H0 jika χ2 ≤ χ2(df; α) 

Tolak H0 jika χ 2 ≥ χ2(df; α) 

Dengan α = taraf signifikan (taraf nyata) dan df (degree of freedom) = k–1 
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5. Kesimpulan  

Dengan df = k-1 =3-1=2, pada α =0,05 dan CI (confidence interval) 95% , 

maka nilai chi square pada tabel adalah = 5,59. Ternyata nilai χ2 > nilai χ2 

tabel, yaitu  6,93 > 5,59, maka H0 ditolak. Artinya, ada perbedaan kinerja 

perawat pada masing-masing shift kerja. 
 
Pengerjaan Dengan Menggunakan Unpad SAS 

▪ Buka tabel contoh np_krel_1 

▪ Pilih menu Analyze->Nonparametric Test->K-Related Samples 

▪ Pilih variabel S1, S2, dan S3 untuk test variables seperti pada gambar di 

bawah ini. 

 

▪ Pilih/contreng Friedman untuk Test Type. 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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2. Uji Q Cochran 

Uji Q Cochran dapat digunakan untuk menguji kasuk k sampel yang 

berpasangan dengan variabel yang memiliki skala pengukuran nominal. 

Adapun uji Friedman dapat digunakan untuk menguji kasus k sampel yang 

berpasangan dengan variabel yang memiliki skala pengukuran ordinal. 
 
Contoh Masalah 

Untuk mengetahui selera konsumen di kota Bandung, Manajer 

Pemasaran DUTA MAKMUR mengambil sampel 12 orang di kota tersebut 

yang pernah mengkonsumsi roti produksi DUTA MAKMUR, yaitu roti rasa 

coklat, nanas, kacang, dan durian. Kepada 12 responden tersebut diberi 

hanya 2 alternatif pendapat, yakni suka atau tidak suka terhadap masing 

masing rasa roti tersebut.  

Berikut ini adalah data sikap responden: Tabel [np_krel_3] 



UJI NONPARAMETRIK 

143 

Konsumen 
Rasa 

Coklat Nanas Kacang Durian 

1 Tidak suka Suka Tidak suka Tidak suka 

2 Tidak suka Tidak suka Suka Suka 

3 Tidak suka Suka Tidak suka Tidak suka 

4 Tidak suka Suka Tidak suka Tidak suka 

5 Suka Tidak suka Suka Suka 

6 Suka Suka Tidak suka Tidak suka 

7 Suka Suka Tidak suka Suka 

8 Tidak suka Tidak suka Tidak suka Suka 

9 Suka Suka Suka Tidak suka 

10 Tidak suka Suka Tidak suka Suka 

11 Suka Suka Suka Suka 

12 Tidak suka Suka Tidak suka Suka 
 
Pengerjaan Secara Manual  

1. Rumuskan hipotesis. 

H0: Tidak ada perbedaan sikap konsumen terhadap keempat rasa roti 

DUTA MAKMUR. 

H1: Ada perbedaan sikap konsumen terhadap keempat rasa roti DUTA 

MAKMUR. 

2. Statistik Uji 

▪ Ubah kategori respon untuk contoh masalah di atas, yaitu 0 untuk 

“tidak suka” dan 1 untuk “suka”, sehingga tabel contoh masalah di atas 

menjadi: 

ID Coklat Nanas Kacang Durian 

1 0 1 0 0 

2 0 0 1 1 

3 0 1 0 0 

4 0 1 0 0 

5 1 0 1 1 

6 1 1 0 0 

7 1 1 0 1 

8 0 0 0 1 

9 1 1 1 0 

10 0 1 0 1 

11 1 1 1 1 

12 0 1 0 1 

▪ Buat tabel dengan variabel sebanyak k buah 

ID V1 ... Vk 

1 .. .. .. 

.. .. .. .. 

N .. .. .. 
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• N = jumlah data 

• k = jumlah variabel yang akan diolah 

• df = k - 1 

• V1 .. Vk = variabel pertama sampai variabel ke-k 

Untuk contoh masalah di atas: 

• N = 12 

• k = 4 

• df = 3 

• V1 = Coklat 

• V2 = Nanas 

• V3 = Kacang 

• V4 = Durian 

Sehingga tabelnya adalah sebagai berikut. 

ID V1 V2 V3 V4 

1 0 1 0 0 

2 0 0 1 1 

3 0 1 0 0 

4 0 1 0 0 

5 1 0 1 1 

6 1 1 0 0 

7 1 1 0 1 

8 0 0 0 1 

9 1 1 1 0 

10 0 1 0 1 

11 1 1 1 1 

12 0 1 0 1 

▪ Hitung jumlah skor 1 pada setiap baris untuk L1 dan kuadrat dari 

jumlah skor 1 pada setiap baris untuk L12, yaitu seperti berikut. 

ID V1 V2 V3 V4 L1 L12 

1 0 1 0 0 1 1 

2 0 0 1 1 2 4 

3 0 1 0 0 1 1 

4 0 1 0 0 1 1 

5 1 0 1 1 3 9 

6 1 1 0 0 2 4 

7 1 1 0 1 3 9 

8 0 0 0 1 1 1 

9 1 1 1 0 3 9 

10 0 1 0 1 2 4 

11 1 1 1 1 4 16 

12 0 1 0 1 2 4 
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▪ Hitung jumlah skor 1 pada setiap kolom sebagai berikut.  

ID V1 V2 .. Vk L1 L1
2 

1 0 1 0 0 1 1 

2 0 0 1 1 2 4 

3 0 1 0 0 1 1 

4 0 1 0 0 1 1 

5 1 0 1 1 3 9 

6 1 1 0 0 2 4 

7 1 1 0 1 3 9 

8 0 0 0 1 1 1 

9 1 1 1 0 3 9 

10 0 1 0 1 2 4 

11 1 1 1 1 4 16 

12 0 1 0 1 2 4 

Total 5 9 4 7 25 63 

 G1 G2 .. Gk   

▪ Hitung dengan rumus Q–Cochran 

𝑄 = (𝑘 − 1)
[𝑘 ∑ 𝐺𝑗

2 −  (∑ 𝐺𝑗)
2

]

𝑘 ∑ 𝐿𝑖 −  ∑ 𝐿𝑖
2  

Untuk contoh masalah di atas adalah sebagai berikut. 

𝑄 = (4 − 1)
[4(52 + 92 + 42 + 72) − (5 + 9 + 4 + 7)2]

4 (25) − 63
 

𝑄 = 3
[4(171) − 625]

100 − 63
 

𝑄 = 3
59

37
 

𝑄 = 4,78 

▪ Cari χ2tabel untuk df dan α = 0,10, 0,05, dan 0,01 dari tabel chi-square. 

Untuk contoh masalah di atas, df = 3, maka nilai χ2tabel untuk α = 0,10, 

0,05, dan 0,01 adalah: 

χ2(3; 0,10) = 6,25139 

χ2
(3; 0,05) = 7,81473 

χ2(3; 0,01) = 11,34487 

3. Kriteria uji  

Kriteria uji, tolak H0 jika Q ≥ χ2tabel 

Untuk contoh masalah di atas, dengan nilai α = 10%, 5%, maupun 1% 

maka H0 = diterima. 
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4. Kesimpulan  

Karena nilai Q = 4,78 ≤ 7,81, maka H0 diterima. Artinya, tidak ada 

perbedaan sikap konsumen terhadap keempat rasa roti DUTA MAKMUR. 
 
Pengerjaan Dengan Menggunakan Unpad SAS 

▪ Buka tabel contoh np_krel_3 

▪ Pilih menu Analyze->Nonparametric Test->K-Related Samples 

▪ Pilih variabel Coklat, Nanas, Kacang, dan Durian untuk test variables seperti 

pada gambar di bawah ini. 

 

▪ Pilih/contreng Cohran Q untuk Test Type. 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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5 
Uji Korelasi 

 

 

A. UJI JASPEN’S M 

Jaspen’s M (atau Jaspen’s coefficient of multiserial association) digu-

nakan untuk mengukur hubungan variabel dengan skala ordinal dan va-

riabel dengan skala interval. Metode ini memungkinkan peneliti untuk 

memaksimalkan tingkat pengukuran bagi kedua jenis variabel.  

Untuk melakukan pengujian dengan tepat, maka kita harus memenuhi 

beberapa asumsi. Pertama, pastikan distribusi data bersifat acak. Lalu jenis 

skala yang digunakan bersifat ordinal dan interval. Variabel yang bersifat 

ordinal harus dibuat “normal” atau “terstandar” sehingga dapat diasumsikan 

bahwa jarak antara setiap unit dalam skala ordinal memiliki jarak yang 

sama. Hal ini yang menjadi dasar untuk menentukan ordinat untuk ranking 

pada tabel distribusi normal. Selain itu, variabel interval diasumsikan 

memiliki distribusi normal.  
 
Contoh Masalah 

Suatu penelitian dilakukan untuk melihat hubungan antara tingkat 

pendidikan dengan penghasilan karyawan di suatu perusahaan. Data yang 

dihasilkan dari pengukuran terhadap 50 karyawan di perusahaan tersebut 

dapat dilihat pada tabel berikut ini: 

Nomor 
Responden 

Pendidikan Penghasilan 
 Nomor 

Responden 
Pendidikan Penghasilan 

1 4 95  26 3 45 

2 3 50  27 1 25 

3 4 80  28 4 95 

4 2 34  29 3 52 

5 2 30  30 1 30 

6 1 20  31 3 55 

7 3 52  32 3 52 

8 2 40  33 3 60 

9 3 58  34 2 32 

10 1 18  35 3 65 
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Nomor 
Responden 

Pendidikan Penghasilan 
 Nomor 

Responden 
Pendidikan Penghasilan 

11 2 35  36 3 49 

12 3 55  37 4 75 

13 1 24  38 2 37 

14 3 50  39 4 80 

15 1 30  40 4 75 

16 2 40  41 3 52 

17 4 80  42 4 100 

18 1 20  43 3 60 

19 3 49  44 4 85 

20 3 58  45 1 28 

21 3 45  46 4 90 

22 3 55  47 4 85 

23 2 28  48 3 48 

24 4 85  49 2 30 

25 3 50  50 2 38 
 
Pengerjaan Secara Manual 

1. Tentukan hipotesis. Rumuskan H0 dan H1 seperti dibawah ini. 

H0: tidak terdapat hubungan yang signifikan antara tingkat pendidikan 

dengan penghasilan karyawan di suatu perusahaan 

H1: terdapat hubungan yang signifikan antara tingkat pendidikan de-

ngan penghasilan karyawan di suatu perusahaan  

2. Statistik Uji 

▪ Tetapkan variabel yang akan diuji. 

• X = Pendidikan 

• Y = Penghasilan 

ID X Y 

1 .. .. 

.. .. .. 

N .. .. 

▪ Hitung nilai standar error 

Untuk menghitung nilai Jaspen’s M, kita harus mengetahui nilai standar 

error dari variabel Y dengan rumus sebagai berikut. 

𝑆𝑦 = √
∑ 𝑌2 −

(∑ 𝑌)2

𝑁𝑟

𝑁𝑟
 

Dimana: 

𝑆𝑦 = Standard error of Y 
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∑ 𝑌 = Jumlah nilai Y 

∑ 𝑌2 = Jumlah nilai Y kuadrat 

𝑁𝑟  = Jumlah sampel 

Dalam kasus di atas, penghitungannya adalah seperti ini.  

𝑆𝑦 = √
161.886 −

(2.624)2

50

50
 

𝑆𝑦 = √
24.178,48

50
 

𝑆𝑦 = 21,990 

▪ Buatlah sebuah tabel bantu berdasarkan kategori variabel X, yang di-

urut dari nilai besar ke kecil, yang berisi kolom-kolom sebagai berikut.  

𝒊 𝒀̅ p 𝑪𝒑 𝑶𝒃 𝑶𝒂 𝑶𝒃 − 𝑶𝒂 
(𝑶𝒃 − 𝑶𝒂)𝟐

𝒑
 𝑌̅(𝑶𝒃 −  𝑶𝒂) 

k ... ... ... ... ... ... ... ... 

... ... ... ... ... ... ... ... ... 

1 ... ... ... ... ... ... ... ... 

 ∑ 𝑌̅      
∑

(𝑂𝑏 − 𝑂𝑎)2

𝑝
 ∑ 𝑌̅(𝑶𝒃 −  𝑶𝒂) 

Keterangan:  

𝑌̅ Rata-rata variabel Y 
p Proporsi jumlah sampel kelompok 𝑌̅𝑖. (P=n/N) 
Cp Kumulatif proporsi jumlah sampel kelompok 𝑌̅𝑖. 
𝑂𝑏 Ordinat dari tabel distribusi normal untuk proporsi kelompok i 
𝑂𝑎 Ordinat di atas pada kolom bO  

Untuk contoh masalah di atas, tabel bantu tersebut adalah: 

𝒊 𝒀̅ p 𝑪𝒑 𝑶𝒃 𝑶𝒂 𝑶𝒃 − 𝑶𝒂 
(𝑶𝒃 − 𝑶𝒂)𝟐

𝒑
 𝑌̅(𝑶𝒃 −  𝑶𝒂) 

4 85,4167 0,24 0,24 0,3109 0,0000 0,3109 0,4027 26,5560 

3 53,0000 0,40 0,64 0,3741 0,3109 0,0632 0,0099 3,3496 

2 34,4000 0,20 0,84 0,2433 0,3741 -0,1308 0,0855 -4,4995 

1 24,3750 0,16 1,00 0,0000 0,2433 -0,2433 0,3699 -5,9304 

 197,1917      0,8680 19,4757 

▪ Hitung koefisien Jaspen (M) dengan rumus berikut. 

𝑀 =
∑(𝑌̅𝑖)(𝑂𝑏 − 𝑂𝑎)

𝑆𝑦 ∑ [
(𝑂𝑏−𝑂𝑎)2

𝑝
]
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Setelah membuat tabel di atas, kemudian hitunglah menggunakan 

rumus Jaspen. 

𝑀 =
19,4757

(21,990)(0,868)
 

𝑀 = 1,0193 

▪ Hitung signifikansi statistik dari Jaspen’s M 

Untuk mengetahui signifikansi statistik dari Jaspen’s M, kita harus 

mengubah nilai M menjadi koefisien yang setara dengan Pearson’s r. 

Dengan rumus berikut : 

𝑟 = 𝑀√∑ [
(𝑂𝑏 − 𝑂𝑎)2

𝑝
] 

Untuk contoh masalah di atas adalah: 

𝑟 = 1,0193√0,868 

𝑟 = 0,9496 

▪ Cari rtabel untuk df = Nr – 2 dan α = 0,10, 0,05, dan 0,01 dari tabel r. 

Untuk contoh masalah di atas, df = 48, maka nilai rtabel untuk α = 0,10, 

0,05, dan 0,01 adalah: 

r(48; 0,10) = 0,2310 

r(48; 0,05) = 0,2730 

r(48; 0,01) = 0,3540 

3. Kriteria Uji (Daerah Kritis) 

Dengan menggunakan rumus degrees of freedom, df = NT – 2. Carilah nilai 

kritis pada tabel Distribusi R.  

Jika nilai r lebih besar dari nilai kritis yang didapat, maka koefisien 

korelasi yang didapat signifikan secara statistik dan H0 dapat ditolak.  

4. Kesimpulan  

Kesimpulannya adalah H0 ditolak, artinya terdapat hubungan yang 

signifikan antara tingkat pendidikan dengan penghasilan karyawan di 

suatu perusahaan 
 
Pengerjaan dengan UNPAD SAS  

▪ Buka tabel contoh cor_jaspen 

▪ Pilih menu Analyze->Correlate->Jaspen’s M Analysis 
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▪ Pilih variabel Pendidikan untuk Variable 1 dan Penghasilan untuk Vari-

able 2, yaitu seperti pada gambar di bawah ini. 

 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 

 

 

B. UJI ETA 

Uji Eta digunakan untuk menghitung hubungan variabel dengan skala 

nominal dan variabel dengan skala interval. 
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Untuk melakukan pengujian dengan tepat, maka kita harus memenuhi 

beberapa asumsi. Pertama, pastikan distribusi data bersifat acak. Lalu jenis 

skala yang digunakan bersifat nominal dan interval. Selain itu, variabel 

interval diasumsikan memiliki distribusi normal. 
 
Contoh Masalah 

Sebuah penelitian dilakukan untuk mengetahui faktor-faktor yang 

berpengaruh terhadap jumlah kosakata Bahasa Inggris yang dipelajari oleh 

anak usia 8 tahun di Bandung. Berikut hasil penelitian tersebut: 

No 
Subjek 

Jenis 
Kelamin 

Tingkat 
Pendidikan 

Ibu 

Status 
Sosial Ekonomi 

Orang Tua 

Lama Belajar 
Bahasa Inggris 

(bulan) 

Jumlah 
kosakata baru 
Bahasa Inggris 

1 1 1 1 1 20 

2 2 1 1 2 25 

3 1 1 2 3 30 

4 1 1 3 4 54 

5 1 1 3 5 21 

6 2 2 1 6 25 

7 2 2 1 4 23 

8 1 2 1 3 45 

9 2 2 2 5 32 

10 1 2 2 7 43 

11 1 2 2 6 12 

12 1 2 3 4 43 

13 2 2 3 3 21 

14 2 2 3 8 45 

15 2 2 3 9 32 

16 2 3 1 7 12 

17 2 3 1 6 10 

18 1 3 1 3 20 

19 2 3 1 4 31 

20 1 3 2 5 23 

21 2 3 2 6 43 

22 1 3 2 7 21 

23 2 3 2 8 43 

24 1 3 2 3 23 

25 2 3 3 1 87 

26 1 3 3 2 32 

27 2 3 3 5 12 

28 1 3 3 4 34 

29 2 3 3 3 32 

30 2 3 3 3 30 
Keterangan: 
Jenis Kelamin: 1 = Laki-laki; 2 = Perempuan 
Pendidikan Ibu: 1 = SLA; 2 = D3; 3 = S1 
Status Sosial Ekonomi: 1 = Rendah; 2 = Sedang ; 3= Tinggi 
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Dengan taraf kepercayaan 95%, jawablah persoalan berikut ini: 

1. Hitunglah besarnya hubungan antara jenis kelamin anak dengan jumlah 

kosakata baru! (jawaban akan dibahasa pada Bagian B Uji Eta) 

2. Hitunglah besarnya hubungan antara jenis kelamin anak dengan tingkat 

pendidikan ibu! (jawaban akan dibahasa pada Bagian C Uji Theta) 
 
Penghitungan uji Eta secara manual 

1. Tentukan hipotesis. Rumuskan H0 dan H1 seperti dibawah ini. 

H0: tidak terdapat hubungan yang signifikan antara jenis kelamin 

dengan jumlah kosakata baru 

H1: terdapat hubungan yang signifikan antara jenis kelamin dengan 

jumlah kosakata baru 

2. Hitung dengan rumus korelasi Eta. 

▪ Selanjutnya adalah penghitungan rumus korelasi Eta dengan meng-

gunakan rumus di bawah ini. 

𝜂 = √1 −
∑ 𝑌𝑇

2 − (𝑁1)(𝑌̅1)2 − (𝑁2)(𝑌̅2)2

∑ 𝑌𝑇
2 − (𝑁1 + 𝑁2)(𝑌̅𝑇)2

 

Keterangan: 

N1 dan N2 adalah Jumlah sampel  

TY  adalah total dari rata-rata kelompok 1 dan 2 yang digabungkan  

21,YY  adalah rata-rata dari kelompok 1 dan 2 

ΣYT2 adalah jumlah kuadrat dari setiap skor dari kedua sampel 

▪ Untuk mempermudah pengerjaan ini, buatlah tabel sebagai berikut 

Laki-laki 𝑌̅1 Perempuan 𝑌̅2 

20 400 25 625 

30 900 25 625 

54 2.916 23 529 

21 441 32 1024 

45 2.025 21 441 

43 1.849 45 2.025 

12 144 32 1.024 

43 1.849 12 144 

20 400 10 100 

23 529 31 961 

21 441 43 1.849 

23 529 43 1.849 

32 1.024 87 7.569 

34 1.156 12 144 
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Laki-laki 𝑌̅1 Perempuan 𝑌̅2 

  32 1.024 

  30 900 

421 1.043 503 1.302 

Setelah membuat tabel di atas, kemudian hitunglah menggunakan 

rumus korelasi Eta 

𝜂 = √1 −
∑ 𝑌𝑇

2 − (𝑁1)(𝑌̅1)2 − (𝑁2)(𝑌̅2)2

∑ 𝑌𝑇
2 − (𝑁1 + 𝑁2)(𝑌̅𝑇)2

 

𝜂 =  √1 − 
2345 − (14)(30)2 − (16)(31,4)2

2345 − (14 + 16)(30,8)2
 

𝜂 =  √1 − 
2345 − 12600 − 15775,36

2345 − 28459,2
 

𝜂 =  √1 − 
−26030,36

−26114,2
 

𝜂 =  √1 − 0,9956 

𝜂 =  0,0566 

3. Hitung uji signifikansi.  

Setelah mendapatkan nilai korelasi eta, hitung signifikansi dengan rumus 

F di berikut ini. 

𝐹 =  
𝜂2 (𝑁 − 𝑘)

(1 − 𝜂2) (𝑘 − 1)
 

𝐹 =  
(0,0566)2 (30 − 2)

(1 − (0,0566)2) (2 − 1)
 

𝐹 =  
0,0032(28)

0,9968(1)
 

𝐹 =  
0,0896

0,9968
 

𝐹 =  0,0898 
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4. Kriteria Uji (Daerah Kritis) 

Carilah nilai F table dengan df atas (K-1) dan df bawah (N-1). Jika Fhitung> 

Ftabel maka H0 ditolak. Nilai F hitung lebih kecil daripada Ftable maka H0 

diterima. 

5. Kesimpulan  

Kesimpulannya adalah H0 diterima, artinya tidak terdapat hubungan yang 

signifikan antara jenis kelamin dengan jumlah kosakata baru. 
 
Pengerjaan dengan Unpad SAS  

▪ Buka tabel contoh cor_eta 

▪ Pilih menu Analyze->Correlate->Eta 

▪ Pilih variabel JK untuk Variable 1 dan JKKB untuk Variable 2, yaitu seperti 

pada gambar di bawah ini. 

 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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C. UJI THETA 

Uji Theta digunakan untuk menghitung hubungan variabel dengan 

skala nominal dan variabel dengan skala ordinal.  
 
Penghitungan uji Eta secara manual 

Untuk melakukan pengujian dengan tepat, maka kita harus memenuhi 

beberapa asumsi. Pertama, pastikan distribusi data bersifat acak. Lalu jenis 

skala yang digunakan bersifat nominal dan ordinal. Selain itu, variabel 

interval diasumsikan memiliki distribusi normal. 

Berikut ini adalah langkah pengerjaan soal di atas.  

1. Tentukan hipotesis. Rumuskan H0 dan H1 seperti dibawah ini. 

H0: tidak terdapat hubungan yang signifikan antara jenis kelamin anak 

dengan tingkat pendidikan ibu 

H1: terdapat hubungan yang signifikan antara jenis kelamin anak 

dengan tingkat pendidikan ibu 

2. Hitung dengan rumus korelasi Tetha. 

▪ Selanjutnya adalah penghitungan rumus korelasi Tetha dengan 

menggunakan rumus di bawah ini.  

𝜃 =
∑ 𝐷𝑖

𝑇2
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dengan 

∑ 𝐷𝑖 = |𝑓𝑎 − 𝑓𝑏|   

Jenis Kelamin 1 2 3 Jumlah 

1 4 4 6 14 

2 1 6 9 16 

Jumlah 5 10 15 30 
 

Fa = 4(0) + 4(1) + 6(1+6) 

Fa = 4 + 42 

Fa= 46 

Fb = 4(6+9) + 4(9) + 6(0) 

Fb = 60 + 36 

Fb = 96 

∑ 𝐷𝑖 = |𝑓𝑎 − 𝑓𝑏| =  |46 − 96| = 50 

𝜃 =  
∑ 𝐷𝑖

𝑇2
 

𝜃 =  
50

14 𝑥 16
 

𝜃 =  
50

224
 

𝜃 =  0,2232 

3. Pada korelasi theta, tidak terdapat uji signifikansinya sehingga hasil 

perhitungan korelasi tetha langsung dibandingkan dengan kriteria 

Guilford. 

Bandingkan nilai Theta dengan kriteria Guilford di bawah ini: 

Nilai Kriteria Gullford 
< 0,20 tidak ada korelasi  
0,20-<0,40 korelasi rendah  
0,40-<0,70 korelasi sedang  
0,70-<0,90 korelasi tinggi  
0,90-<1,00 korelasi tinggi sekali  
1,00 korelasi sempurna  

Catatan: Kriteria Guilford dapat digunakan semua analisis korelasi. Jika 
suatu variabel dikatakan telah berhubungan secara signifikan, maka 
kekuatan dari hubungan tersebut dapat diinterpretasi menggunakan 
kriteria Guliford. 
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4. Kesimpulan 

Berdasarkan Analisis Statistik Korelasi Theta, didapatkan bahwa r = 

0,2232.  Hal ini menandakan bahwa terdapat hubungan yang rendah 

antara jenis kelamin anak dengan tingkat pendidikan ibu. 
 
Pengerjaan dengan Unpad SAS  

▪ Buka tabel contoh cor_eta 

▪ Pilih menu Analyze->Correlate->Eta 

▪ Pilih variabel JK untuk Variable 1 dan JPI untuk Variable 2, yaitu seperti 

pada gambar di bawah ini. 

 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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D. ANALISIS KORELASI CRAMER, TSUPROW, DAN  PEARSON 

Uji ini dapat digunakan untuk menguji dua kelompok yang inde-

penden dengan variabel yang memiliki skala pengukuran paling sedikit 

nominal dan berbentuk data kategori. 
 
Contoh Masalah  

Suatu penelitian dilakukan untuk mengetahui apakah ada perbedaan jenis 

pekerjaan yang dipilih laki-laki dengan perempuan. Pengambilan terhadap 

18 orang memberikan hasil sebagai berikut. 

ID JK JP  ID JK JP 

1 1 1  10 2 1 

2 1 1  11 2 1 

3 1 1  12 2 1 

4 1 2  13 2 2 

5 1 2  14 2 2 

6 1 2  15 2 2 

7 1 3  16 2 2 

8 1 3  17 2 3 

9 2 1  18 2 3 
KETERANGAN 
JK (Jenis Kelamin): 1=Laki-laki, 2=Perempuan 
JP (Pekerjaan): 1=PNS, 2=Swasta, 3=Lainnya 
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Dengan taraf nyata 10%, 5%, dan 1% ujilah apakah terdapat perbedaan jenis 

pekerjaan yang dipilih antara laki-laki dengan perempuan? 
 
Pengerjaan Secara Manual 

1. Rumuskan Hipotesis 

H0: Tidak terdapat perbedaan jenis pekerjaan yang dipilih antara laki-

laki dengan perempuan. 

H1: Terdapat perbedaan jenis pekerjaan yang dipilih laki-laki dengan 

perempuan. 

2. Statistik Uji 

▪ Tetapkan: 

• V1 = variabel yang akan diuji 

• V2 = variabel kelompok 

Untuk contoh masalah di atas, V1 = JP dan V2 = JK. 

▪ Hitunglah: 

• N = jumlah data 

• c = jumlah kategori JP 

• r = jumlah kategori JK 

• df =(r-1)(c-1) 

Untuk contoh masalah di atas, N = 18, c = 3, r = 2, dan df = 2. 

▪ Buat tabel kontingensi V2-V1 dengan nilai O (observasi) berupa 

frekuensi pasangan V2-V1. 

  V1 
Total 

 i     j 1 .. c 

V2 

1 O11 O12 O1j m1 

.. .. .. .. .. 

R Or1 .. Orc mr 

Total n1 .. nc N 

𝑚𝑟 = ∑ 𝑂𝑟𝑗

𝑐

𝑗=1

 

𝑛𝑐 = ∑ 𝑂𝑐𝑖

𝑟

𝑖=1
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Untuk contoh masalah di atas, tabel kontingensinya adalah: 

 
Pekerjaan 

Total 
1 2 3 

Jenis Kelamin 
1 3 3 2 8 

2 4 4 2 10 
Total 7 7 4 18 

▪ Buat tabel bantu untuk mendapatkan nilai E (ekspektasi) dari setiap 

nilai O (observasi). 

  V1 

 i     j 1 .. c 

V2 

1 E11 E12 E1j 

.. .. .. .. 

r Er1 .. Erc 

𝐸𝑖𝑗 =
𝑚𝑖 ∗ 𝑛𝑗

𝑁
 

Untuk contoh masalah di atas, tabel bantunya adalah: 

 
Pekerjaan 

1 2 3 

Jenis Kelamin 
1 3,1111 3,1111 1,7778 

2 3,8889 3,8889 2,2222 

▪ Hitung χ2 dengan rumus 

𝜒2 =  ∑ ∑
(𝑂𝑖𝑗 − 𝐸𝑖𝑗)

2

𝐸𝑖𝑗

𝑐

𝑗=1

𝑟

𝑖=1

 

Untuk contoh masalah di atas adalah sebagai berikut. 

𝜒2 = 0,0040 + 0,0040 + 0,0278 + 0,0032 + 0,0032 + 0,0222 

𝜒2 = 0,0643 

▪ Cari χ2tabel untuk df=2 dan α=0,10, 0,05, dan 0,01 dari tabel chi-square. 

χ2(2; 0,10) = 4,60517 

χ2(2; 0,05) = 5,99146 

χ2
(2; 0,01) = 9,21034 

3. KriteriaUji 

▪ Kriteria uji tolak H0 jika χ2hitung > χ2tabel. 

▪ Untuk contoh kasus di atas, dengan nilai α = 10%, 5%, dan 1% maka H0  

diterima. 

▪ Jika H0 ditolak, hitung koefisien korelasi dengan rumus berikut. 

𝐶 = √
𝜒2

𝑁 + 𝑋2
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𝑇 = √
𝜒2

𝑁√(𝑟 − 1)(𝑐 − 1)
 

𝑉 = √
𝜒2

𝑁(𝑎 − 1)
 

a = nilai baris atau kolom terkecil 

4. Kesimpulan 

Dapat disimpulkan bahwa “Tidak terdapat perbedaan jenis pekerjaan yang 

dipilih antara laki-laki dengan perempuan”. 
 
Pengerjaan dengan Unpad SAS 

▪ Buka tabel contoh cor_cramer 

▪ Pilih menu Analyze->Correlate->Crammer, Tsuprow, and  Pearson 

▪ Pilih variabel JK untuk grouping variables dan variabel JP untuk test 

variable seperti pada gambar di bawah ini. 

 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 



UJI KORELASI 

165 

 
 

 

E. ANALISIS KORELASI SPEARMAN 

Analisis ini digunakan untuk mengetahui hubungan diantara dua 

variabel yang memiliki skala pengukuran paling sedikit ordinal. 
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Contoh Masalah 

Suatu penelitian dilakukan untuk mengetahui hubungan antara mo-

tivasi kerja dengan hasil kerja dari 12 karyawan. Diperoleh data sebagai 

berikut: 

No Motivasi Hasil 

1 23 78 

2 25 78 

3 26 80 

4 30 85 

5 32 85 

6 25 78 

7 21 80 

8 20 70 

9 34 82 

10 32 80 

11 33 85 

12 19 75 
Keterangan: 
Motivasi = Motivasi Kerja, Hasil = Hasil Kerja 

 
Dengan taraf nyata 10%, 5%, 1% ujilah apakah terdapat hubungan 

antara motivasi kerja dengan hasil kerja? 
 
Pengerjaan Secara Manual 

1. Rumuskan Hipotesis 

H0: Tidak terdapat hubungan antara motivasi kerja dengan hasil kerja 

H1: Terdapat hubungan antara motivasi kerja dengan hasil kerja 

2. Statistik Uji 

▪ Tetapkan: 

• V1 = Motivasi 

• V2 = Hasil 

• α = 10%, 5%, 1% 

▪ Buatlah tabel bantu untuk menyalin variabel-variabel yang akan diuji. 

ID V1 V2 

1 ... ... 

... ... ... 

N ... ... 

Untuk contoh masalah di atas adalah: 

ID V1 V2 

1 23 76 

2 25 78 
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ID V1 V2 

3 26 87 

4 30 85 

5 32 87 

6 25 79 

7 21 73 

8 20 70 

9 34 82 

10 32 80 

11 33 85 

12 19 75 

▪ Perluas tabel bantu dengan menambahkan variabel R1 dan R2. Lakukan 

pe-ranking-an terhadap V1 dan nilainya tetapkan untuk variabel R1; 

dan lakukan pe-ranking-an terhadap V2 dan nilainya tetapkan untuk 

variabel R2. 

ID V1 V2 R1 R2 

1 ... ... ... ... 

... ... ... ... ... 

N ... ... ... ... 

▪ Perluas tabel bantu dengan menambahkan variabel d dan d2. Tetapkan 

d=R1-R2, dan d2=(R1-R2)2. 

ID V1 V2 R1 R2 d d2 

1 ... ... ... ... ... ... 

... ... ... ... ... ... ... 

N ... ... ... ... ... ... 

      ∑ 𝑑2 

Untuk contoh masalah di atas adalah: 

ID V1 V2 R1 R2 D D2 

1 23 78 4.00 4.00 0.00 0.00 

2 25 78 5.50 4.00 1.50 2.25 

3 26 80 7.00 7.00 0.00 0.00 

4 30 85 8.00 11.00 -3.00 9.00 

5 32 85 9.50 11.00 -1.50 2.25 

6 25 78 5.50 4.00 1.50 2.25 

7 21 80 3.00 7.00 -4.00 16.00 

8 20 70 2.00 1.00 1.00 1.00 

9 34 82 12.00 9.00 3.00 9.00 

10 32 80 9.50 7.00 2.50 6.25 

11 33 85 11.00 11.00 0.00 0.00 

12 19 75 1.00 2.00 -1.00 1.00 

      49.00 
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▪ Hitung 

𝑟𝑠 = 1 −
6 ∑ 𝑑𝑖

2𝑁
𝑖=1

𝑁3 − 𝑁
 

𝑧 = 𝑟𝑠√𝑁 − 1 

Untuk contoh masalah di atas adalah: 

𝑟𝑠 = 1 −
345

1716
= 1 − 0,2010 = 0,7990 

𝑧 = 𝑟𝑠√𝑁 − 1 = 0,7990√11 = 2,66498 

▪ Cari nilai Ztabel dari tabel distribusi normal untuk taraf nyata 10%, 5%, 

dan 1%. Dari tabel diperoleh: 

Z0,10 = 1,6448 

Z0,05 = 1,9600 

Z0,01 = 2,5760 

3. Kriteria uji 

Tolak H0 jika nilai Zhitung>Ztabel atau Z<-Ztabel 

 
Pengerjaan dengan Unpad SAS 

▪ Buka tabel contoh cor_spearman 

▪ Pilih menu Analyze->Correlate->Spearman 

▪ Pilih variabel Motivasi untuk Variabel 1 dan variabel Hasil untuk Variable 

2 seperti pada gambar di bawah ini. 

 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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F. UJI GAMMA 

Analisis ini digunakan untuk mengetahui hubungan diantara dua 

variabel yang memiliki skala pengukuran paling sedikit ordinal dan ber-

bentuk kategori. 
 
Contoh Masalah 

Suatu penelitian dilakukan untuk mengetahui hubungan antara 

tingkat pendidikan dengan jabatan karyawan di suatu perusahaan. 

Pengambilan data terhadap 40 karyawan memberikan hasil sebagai berikut. 
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No Pendidikan Jabatan  No Pendidikan Jabatan 

1 1 1  21 2 1 

2 1 1  22 2 1 

3 1 1  23 2 1 

4 1 1  24 2 2 

5 1 1  25 2 2 

6 1 1  26 2 2 

7 1 1  27 2 2 

8 1 1  28 2 2 

9 1 1  29 2 3 

10 1 1  30 2 3 

11 1 2  31 2 3 

12 1 2  32 2 3 

13 1 2  33 3 1 

14 1 3  34 3 1 

15 1 3  35 3 2 

16 2 1  36 3 2 

17 2 1  37 3 3 

18 2 1  38 3 3 

19 2 1  39 3 3 

20 2 1  40 3 3 

Keterangan: 
Pendidikan: 1 = SLA, 2 = D3, 3 = S1 
Jabatan: 1 = Karyawan Biasa, 2 = Supervisor, 3 = Manajer 

 
Dengan taraf nyata 10%, 5%, 1%, ujilah apakah terdapat hubungan antara 

tingkat pendidikan dengan jabatan karyawan di perusahaan tersebut? 
 
Pengerjaan Secara Manual 

1. Rumuskan Hipotesis 

H0: Tidak terdapat hubungan antara tingkat pendidikan dengan jabatan 

karyawan 

H1: Terdapat hubungan antara tingkat pendidikan dengan jabatan kar-

yawan 

2. Statistik Uji 

▪ Tetapkan: 

• V1 = Pendidikan 

• V2 = Jabatan 

• α = 10%, 5%, 1% 
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▪ Susun data dalam bentuk Tabel Kontingensi dengan kategori berurut 

dari kecil ke besar 

Pekerjaan 
Pendidikan 

SLA D3 S1 

Karyawan Biasa 10 8 2 

Supervisor 3 5 2 

Manajer 2 4 4 

 
▪ Hitung: 

𝐺 =
#(+) − #(−)

#(+) + #(−)
 

𝑧 = (𝐺 − 𝛾)√
#(+) + #(−)

𝑁(1 − 𝐺2)
 

dimana: 

#(+) adalah banyaknya pasangan yang agreement 

#(-) atau banyaknya pasangan yang disagreement 
 

Untuk contoh masalah di atas: 

#(+) = 10(5+2+4+4) + 8(2+4) + 3(4+4) + 5(4) = 150 + 48 + 24 + 20 = 242 

# (-) = 8(3+2) + 2(3+5+2+4) + 5(2) + 2(2+4) = 40 + 28 + 10 + 12 = 90 
 

𝐺 =
242 − 90

242 + 90
= 0,45783132  

𝑧 = (0,45783132 − 𝛾)√
242 + 90

40(1 − 0,457831322)
= 1,48362349 

▪ Cari Ztabel untuk α=0,10, 0,05, dan 0,01 dari tabel distribusi normal. 

Z(0,10) = 1,6448 uji dua pihak 

Z(0,05) = 1,9600 uji dua pihak 

Z(0,01) = 2,5760 uji dua pihak 

Z(0,10) = 1,2816 uji satu pihak 

Z(0,05) = 1,6448 uji satu pihak 

Z(0,01) = 2,3263 uji satu pihak 

3. Kriteria Uji 

Kriteria uji tolak H0 jika Z > Ztabel. 
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Dengan nilai α = 10% untuk uji satu pihak maka H0 = ditolak, sementara 

untuk selebihnya maka H0 = diterima. 

4. Kesimpulan 

Dapat disimpulkan secara umum bahwa “Tidak terdapat hubungan antara 

tingkat pendidikan dengan jabatan karyawan”. 
 
Pengerjaan dengan Unpad SAS 

▪ Buka tabel contoh cor_gamma 

▪ Pilih menu Analyze->Correlate->Gamma 

▪ Pilih variabel Pendidikan untuk Row(s) dan variabel Jabatan untuk 

Column (s) seperti pada gambar di bawah ini. 

 

▪ Klik <OK>. Setelah itu akan muncul luaran seperti gambar di bawah ini. 
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G. LATIHAN 

Suatu penelitian dilakukan untuk melihat minat dan motivasi belajar 

mahasiswa baru di Universitas X. Pengambilan data terhadap 30 mahasiswa 

baru tersebut memberikan hasil sebagai tercantum pada tabel di bawah ini: 

No JK Minat Motivasi IPK   No JK Minat Motivasi IPK 

1 1 0 40 3,12  16 2 1 18 2,43 

2 1 1 25 3,43  17 2 1 16 2,76 

3 1 0 26 3,00  18 2 0 15 3,87 

4 1 0 35 3,08  19 2 0 10 3,45 

5 1 0 27 2,87  20 2 1 40 3,12 

6 1 1 17 2,86  21 1 0 20 3,15 

7 1 1 18 2,56  22 2 0 25 3,47 

8 1 0 21 3,88  23 2 1 26 3,25 

9 1 0 25 2,74  24 1 1 16 2,61 

10 1 1 16 3,96  25 1 1 32 2,92 

11 2 1 32 2,90  26 1 1 15 2,78 

12 2 0 32 3,43  27 1 0 17 3,87 

13 2 0 40 3,21  28 2 1 40 2,90 

14 2 1 40 3,44  29 2 1 40 3,84 

15 2 1 30 3,33  30 1 1 36 2,95 
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Catatan: 
JK (Jenis Kelamin): 1=Laki-laki, 2=Perempuan 
Minat (Minat ketika masuk kuliah): 0=tidak berminat, 1=berminat 
Motivasi (Motivasi ketika masuk kuliah): 1=tidak termotivasi; 2=cukup termotivasi; 

3=sangat termotivasi 
 

Dengan taraf kepercayaan 95%, jawablah persoalan berikut ini: 

1. Hitunglah besarnya hubungan antara jenis kelamin dengan IPK!  

2. Hitunglah besarnya hubungan antara minat saat masuk kuliah dengan 

tingkat motivasi belajar!  

3. Hitunglah besarnya hubungan antara tingkat motivasi belajar dengan IPK 

mahasiswa!  
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6 

Petunjuk Instalasi 
 

 

A. KEBUTUHAN SISTEM DAN NOTASI PENULISAN 

Untuk dapat menggunakan Unpad SAS pastikan komputer yang Anda 

gunakan memiliki spesifikasi sebagai berikut. 
 

Prosesor: Intel/AMD x86 family 
RAM: 2 GB 
Sistem Operasi: Windows XP/Vista/7/8/8.1/10 32-bits/64-bits 
Database: MySQL Server versi 5 atau yang lebih baru 

MySQL Connector/ODBC versi 3.51 atau yang lebih 
baru 

 

 

B. MENGINSTAL PROGRAM 

1. Struktur Direktori 

Pastikan CD Unpad Statistical Analysis Series (Unpad SAS) yang Anda 

peroleh terdiri dari direktori dan file-file sebagai berikut. 
 

INSTALL 

 instalation-guide.pdf 

 sas-setup.exe 

UTILITIES 

 mysql-connector-odbc-3.51.30-win32.msi 

 mysql-5.5.45-win32.msi 

 reader10_en_ha_install.exe 

MODULES 

 cor-readme.pdf 

 cor-setup.exe 

 ds-readme.pdf 

 ds-setup.exe 

 np1-readme.pdf 

 np1-setup.exe 

 np2-readme.pdf 

 np2-setup.exe 

 np3-readme.pdf 

 np3-setup.exe 

 sam-readme.pdf 

 sam-setup.exe 
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autorun.inf 

modules.ini 

setup.exe 

 

Jika Anda memasukkan CD Unpad SAS ke dalam CD/DVD ROM Drive 

dan komputer yang Anda gunakan ditetapkan untuk menjalankan “autorun” 

secara otomatis maka Anda Akan melihat Jendela Pembuka untuk meng-

instal Unpad SAS. Jika tidak, Anda harus menjalankan program setup.exe 

yang terdapat di dalam CD Unpad SAS. 
 
2. Jendela Pembuka 

 

Gambar 6.1: 
Jendela Pembuka 

Jendela Pembuka, ditunjukkan di dalam Gambar 6.1, terdiri dari 

perintah-perintah untuk: 

▪ Install MySQL Server – untuk menginstal server database MySQL. 

▪ Install MySQL Connector – untuk menginstal driver ODBC untuk MySQL. 

▪ Install Unpad SAS – untuk menginstal aplikasi Unpad SAS. 

▪ Install Unpad SAS Modules – untuk menginstal modul-modul Unpad SAS. 

▪ Install Acrobat Reader – untuk menginstal aplikasi Acrobat Reader 

▪ Intallation Manual – untuk menampilkan dokumen Petunjuk Instalasi 

Unpad SAS. 

▪ Technical Support – untuk menampilkan nomor telpon yang dapat Anda 

hubungi untuk keperluan konsultasi. 
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3. Menginstal dan Mengkonfigurasi MySQL Server 

a. Menginstal MySQL Server 

Unpad SAS mengunakan MySQL Server sebagai server basisdata. My-

SQL Server boleh berada di komputer yang sama dengan komputer yang 

digunakan oleh Unpad SAS atau berada di komputer lain yang terhubung 

dengan Unpad SAS melalui jaringan komputer. 

 

Gambar 6.2: 
Jendela Pembuka MySQL Server 5.5 Setup 

Unpad SAS menyertakan MySQL Community Server versi 5.5, yang 

merupakan versi GNU GENERAL PUBLIC LICENSE, sehingga anda dapat 

menggunakannya secara cuma-cuma. Perlu anda catat bahwa MySQL Com-

munity Server memerlukan Microsoft Visual C++ 2008 Redistributable Pa-

ckage untuk dapat dijalankan pada sistem operasi Windows. 

Gunakan perintah ini di komputer dimana MySQL Server akan diinstal. 

Jika MySQL Server telah diinstal sebelumnya, Anda dapat mengabaikan perintah 

ini. 

Atas perintah ini, Anda akan melihat jendela MySQL Setup seperti 

ditunjukkan di dalam Gambar 6.2. 

▪ Klik tombol <Next>. 
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Berikutnya Anda akan melihat jendela Persetujuan Lisensi Pengguna 

akhir, yaitu seperti ditunjukkan di dalam Gambar 6.3. 

 

Gambar 6.3: 
Persetujuan Lisensi Pengguna Akhir 

▪ Beri tanda-contreng pada pernyataan “I accept the terms in the License 

Agreements"; 

▪ Klik tombol <Next>. 

Berikutnya Anda akan melihat jendela Memilih Tipe Setup, yaitu 

seperti ditunjukkan pada Gambar 6.4. Pilih salah satu tipe Setup sesuai 

kebutuhan Anda. Pilih:  

▪ Typical - untuk menginstal hampir semua fitur umum program. Disa-

rankan untuk hampir semua pengguna. 

▪ Custom - membolehkan pengguna untuk memilih fitur program mana 

yang akan diinstal dan dimana itu akan diinstal. Disarankan untuk peng-

guna mahir. 

▪ Complete - semua fitur program akan diinstal. Memerlukan ruang disk 

yang lebih banyak. 

Jika Anda kurang memiliki pengetahuan tentang MySQL maka seba-

iknya Anda: 

▪ Pilih tipe “Typical”; 

▪ Tekan tombol <Next>. 
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Gambar 6.4: 
Memilih Tipe Setup 

Jika Anda memilih tipe Typical maka jendela berikutnya menyatakan 

bahwa MySQL Server siap untuk diinstal, yaitu seperti ditunjukkan pada 

Gambar 6.5. 

 

Gambar 6.5: 
Siap untuk Menginstal MySQL Server 

▪ Tekan tombol <Install>. 
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▪ Jendela proses instalasi MySQL akan ditampilkan. 

Tunggu beberapa menit sampai proses instalasi MySQL selesai. Itu di-

tandai oleh aktifnya tombol <Next>. Tekan tombol <Next> untuk me-

nampilkan dua jendela berikutnya yang berisi deskripsi singkat tentang 

produk MySQL Server, yaitu seperti ditunjukkan pada Gambar 6.6. 

 

Gambar 6.6: 
Proses Instalasi MySQL 

▪ Tekan tombol <Next> 

Berikutnya Anda akan melihat jendela yang berisi deskripsi singkat 

tentang produk MySQL Server, yaitu seperti ditunjukkan pada Gambar 6.7 

dan Gambar 6.8. 
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Gambar 6.7: 
MySQL Enterprise 

 

 

Gambar 6.8: 
MySQL Enterprise 

Tekan tombol <Next> di kedua jendela tersebut untuk menampilkan 

jendela berikutnya. 



BELAJAR STATISTIKA DENGAN UNPAD SAS 

182 

 

Gambar 6.9: 
Instalasi MySQL Server Komplit 

Jendela yang ditunjukkan di dalam Gambar 6.9 menyatakan bahwa 

instalasi MySQL Server telah lengkap. 

Di dalam jendela ini Anda dapat menetapkan bahwa setelah proses 

instalasi akan dilanjutkan dengan proses konfigurasi MySQL atau tidak. Beri 

tanda contreng pada pernyataan “Launch the MySQL Instance Configuration 

Wizard” jika itu akan Anda lakukan. Selanjutnya tekan tombol <Finish> 

untuk mengakhiri proses instalasi MySQL Server. 
 
b. Mengkonfigurasi MySQL Server 

Setelah MySQL Server diistal, itu perlu dikonfigurasi. Ini diperlukan 

terutama untuk menetapkan bagaimana cara menjalankan MySQL Server, 

apakah itu akan dijalankan secara otomatis atau secara manual, serta 

menetapkan kata kunci (password) untuk mengakses MySQL Server. 
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Gambar 6.10: 
Jendela Pembuka Konfigurasi MySQL Server Instance 

▪ Klik <Next> 

 

Gambar 6.11: 
Jendela 2 Konfigurasi MySQL Server Instance 

▪ Pilih “Standard Configuration"; 

▪ Klik <Next> 
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Gambar 6.12: 
Jendela 3 Konfigurasi MySQL Server Instance 

▪ Pilih “Install As Windows Service"; 

▪ Pilih “MySQL” untuk “Service Name"; 

▪ Pilih “Launch the MySQL Server automatically"; 

▪ Pilih “Include Bin Directory in Windows PATH"; 

▪ Klik <Next>. 

 

Gambar 6.13: 
Jendela 4 Konfigurasi MySQL Server Instance 
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▪ Pilih “Modify Security Settings"; 

▪ Tetapkan “unpad_sas” untuk “New root password"; 

▪ Tetapkan “unpad_sas” untuk “Confirm"; 

▪ Pilih “Enable root access from remote machines"; 

▪ Klik <Next>. 

 

Gambar 6.14: 
Jendela 5 Konfigurasi MySQL Server Instance 

▪  Klik <Execute> 

 

Gambar 6.15: 
Jendela 6 Konfigurasi MySQL Server Instance 
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▪ Klik <Finish> 
 
c. Menguji Kesiapan MySQL Server 

Pada bagian ini penulis ingin memastikan bahwa MySQL Server telah 

Anda instal secara benar. Hal ini penting mengingat dalam beberapa uji-coba 

yang penulis lakukan terhadap sejumlah mahasiswa ditemukan fakta bahwa 

sekira 10%-15% mahasiswa mengalami kesalahan/kegagalan dalam 

menginstal MySQL Server. Jika MySQL Server salah/gagal diinstal maka dapat 

dipastikan bahwa Unpad SAS tidak akan dapat dijalankan. 

Mari kita lihat apakah MySQL Server telah diinstal secara benar, sesuai 

dengan langkah-langkah di atas atau tidak adalah dengan melihat statusnya 

di dalam Task Manager. Untuk menampilkan Task Manager dapat dilakukan 

melalui dua cara, yaitu: 

▪ Cara pertama: 

• Tekan tombol Ctrl+Alt+Del 

• Pilih perintah “Start Task Manager” 

▪ Cara kedua: 

• Bawa kursor ke “Task bar” 

• Klik tombol-kanan mouse untuk menampilkan pop-up menu di bawah ini. 

 

• Pilih perintah  “Start Task Manager” 

Atas perintah tersebut maka jendela Task Manager akan ditampilkan, 

yaitu seperti terlihat di dalam Gambar 6.16. 
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Gambar 6.16: 
Jendela Task Manager 

Pilih “Services” seperti terlihat di dalam gambar di atas dan pastikan 

MySQL terdaftar di kolom Name. Jika itu tidak terdaftar maka Anda harus 

mengulang bagian “1.B.3.b. Mengkonfigurasi MySQL Server”. 

Berikutnya cobalah Anda buka jendela Command Prompt. Ada 

beberapa untuk melakukan itu, yaitu: 

▪ Cara I: 

Pilih Start->All Program->Accessories->Command Prompt seperti ditun-

jukkan di dalam gambar berikut. 
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▪ Cara II: 

• Klik  tombol +R untuk menampilkan jendela “Run” seperti ditunjuk-

kan dalam gambar berikut. 

 

• Tulis “cmd” pada ruas Open dan klik tombol <OK>. 

Atas perintah tersebut akan dibuka jendela Command Prompt se-

perti ditunjukkan dalam gambar berikut. 
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Gambar 6.17: 
Jendela Command Prompt 

Di dalam jendela Command Prompt tuliskan perintah berikut untuk 

menjalankan program MySQL Client standar. 
 

C:>mysql --user=root --password=unpad_sas 

'mysql' is not recognized as internal or external command, 

operable program or batch file 

 

C:>_ 

 

Jika muncul pesan kesalahan seperti itu, kemungkinan masalahnya adalah: 

▪ Anda lupa mencontreng “Include Bin Directory in Windows PATH” pada 

saat Anda mengkonfigurasi MySQL Server, seperti ditunjukkan pada 

Gambar 6.12. 

▪ Jika Anda yakin telah melakukan hal di atas, kemungkinan kesalahannya 

terletak pada Windows Anda. Pada saat uji-coba, penulis menemukan hal 

tersebut yang disebabkan oleh Windows yang tidak secara langsung 

mengeksekusi perintah SET PATH yang diberikan oleh MySQLInstance-

Config. Solusi untuk masalah itu adalah me-restart Windows Anda dan 

mengulang perintah di atas. 

Pesan kesalahan lain yang boleh jadi muncul atas perintah tersebut adalah 

seperti ditunjukkan di bawah ini. 

C:>mysql --user=root --password=unpad_sas 

ERROR 2005 (HY000): Unknown MySQL server host 'localhost' (0) 

 

C:>_ 



BELAJAR STATISTIKA DENGAN UNPAD SAS 

190 

Pada saat uji-coba, penulis menemukan hal tersebut yang disebabkan oleh 

konfigurasi yang salah (disengaja) di dalam file C:\Windows\System32\ 

drivers\etc\hosts. Cobalah buka file tersebut dan perhatikan baris berikut 

ini. 

... 

0.0.0.0 localhost 

... 

Kesalahan tersebut kemungkinan besarnya disengaja karena Anda diminta 

menuliskan itu oleh pihak tertentu berkaitan dengan meng-hack program 

ilegal yang Anda gunakan. Solusi untuk masalah itu adalah mengembalikan 

konfigurasi tersebut pada nilai sebenarnya, yaitu mengganti nilai “0.0.0.0 

localhost” menjadi “127.0.0.1 localhost”. 

Untuk melakukan perubahan itu pastikan anda melakukan langkah-langkah 

berikut. 

▪ Jika Anda memasang program Anti Virus, pastikan itu itu dinonaktifkan 

atau setidak-tidaknya fitur “Enable Real-time Protection” nya dimatikan 

sementara. 

▪ Jika Anda menggunakan Windows XP/Vista, Anda dapat secara langsung 

mengedit file tersebut dengan menggunakan Notepad atau editor teks 

lainnya. 

▪ Jika Anda menggunakan Windows 7/8.0/8.1/10, Anda harus menyalin file 

tersebut terlebih dahulu ke folder kerja Anda, lakukan pengeditan ter-

hadap file tersebut dengan menggunakan Notepad atau editor teks lain-

nya, setelah itu salin kembali file tersebut ke folder C:\Windows\Sys-

tem32\drivers\etc. 

Jika MySQL Server diinstal dan dikonfigurasi secara benar maka 

respon atas perintah tersebut adalah sebagai berikut. 

C:>mysql --user=root --password=unpad_sas 

Welcome to the MySQL monitor.  Commands end with ; or \g. 

Your MySQL connection id is 9 

Server version: 5.5.45 MySQL Community Server (GPL) 

 

Copyright (c) 2000, 2015, Oracle and/or its affiliates. All 

rights reserved. 

 

Oracle is a registered trademark of Oracle Corporation and/or its 

affiliates. Other names may be trademarks of their respective 

owners. 
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Type 'help;' or '\h' for help. Type '\c' to clear the current 

input statement. 

 

mysql> _ 

Cobalah Anda tuliskan perintah “SHOW DATABASES;” dan tekan tombol 

<Enter>, maka Anda akan melihat respon sebagai berikut. 

mysql> SHOW DATABASES; 

+--------------------+ 

| Database           | 

+--------------------+ 

| information_schema | 

| mysql              | 

| performance_schema | 

| test               | 

+--------------------+ 

4 rows in set (0.00 sec) 

 

mysql> _ 

Jika semuanya telah berjalan dengan benar maka Anda dapat keluar 

dari MySQL Client dengan memberikan perintah QUIT.  
 
4. Menginstal MySQL Connector 

Unpad SAS melakukan koneksi terhadap MySQL Server melalui peng-

arah ODBC. Untuk keperluan tersebut Anda harus menginstal MySQL Con-

nector di komputer yang sama dengan komputer yang digunakan oleh 

Unpad SAS. 

Jika MySQL Connector telah diinstal sebelumnya, Anda dapat mengabaikan 

perintah ini. 
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Gambar 6.18: 
Perintah Menginstal MySQL Connector 

 

Gambar 6.19: 
Jendela Pembuka MySQL Connector/ODBC Setup 

▪ Klik <Next> 
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Gambar 6.20: 
Persetujuan Lisensi 

▪ Pilih “I accept the terms in the license agreement". Klik <Next> 

 

Gambar 6.21: 
Jendela 3 MySQL Connector/ODBC Setup 

▪ Pilih “Typical"; 

▪ Klik <Next> 
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Gambar 6.22: 
Jendela 4 MySQL Connector/ODBC Setup 

▪ Klik <Install> 

 

Gambar 6.23: 
Proses instalasi MySQL Connector/ODBC Setup 
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Gambar 6.24: 
Jendela 6 MySQL Connector/ODBC Setup 

▪ Klik <Finish> 
 
5. Menginstal Unpad SAS 

 

Gambar 6.25: 
Perintah Menginstal UNPAD SAS 

▪ Pilih “Install Unpad SAS: Database Management" 
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Gambar 6.26: 
Jendela Pembuka Instalasi Unpad SAS 

▪ Klik <Next> 

 

Gambar 6.27: 
Persetujuan Lisensi 

▪ Pilih “I accept the terms in the license agreement"; 

▪ Klik <Next> 
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Gambar 6.28: 
Informasi Pengguna 

▪ Tuliskan nama Anda di ruas “User Name", nama organisasi di ruas 

“Organization"; 

▪ Pilih “Anyone" dan klik <Next> 

 

Gambar 6.29: 
Memilih Tipe Setup 

▪ Pilih “Typical"; 

▪ Klik <Next> 
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Gambar 6.30: 
Instalasi Unpad SAS Siap Dilakukan 

▪ Klik <Install> 

 

Gambar 6.31: 
Instalasi Unpad SAS Sedang Dilakukan. 
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Gambar 6.32: 
Instalasi Unpad SAS Selesai 

▪ Klik <Finish> 

Ulangi langkah-langkah di atas untuk menginstal modul Descriptive 

Statistic, Sampling, dan modul-modul lainnya yang telah terdaftar. 
 
6. Menginstal Acrobat Reader 

 

Gambar 6.33: 
Perintah Menginstal Acrobat Reader 
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Jika Acrobat Reader telah diinstal sebelumnya, Anda dapat mengabaikan 

perintah ini. 

▪ Pilih “Install Acrobat Reader" 

▪ Ikuti petunjuk yang ditampilkan di layar. 
 
7. Menampilkan Petunjuk Instalasi 

 

Gambar 6.34: 
Perintah Menampilkan Petunjuk Instalasi 

 
8. Dukungan Teknis 

 

Gambar 6.35: 
Perintah Menampilkan Nomor Telpon Dukungan Teknis 
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C. MENGGUNAKAN APLIKASI 

1. Menyiapkan Database 

▪ Klik tombol +R 

 

Gambar 6.36: 
Jendela Run 

▪ Tulis “%APPDATA%\UNPAD SAS\dbinit\sas-dbinit.cmd” pada ruas 

“Open"; 

▪ Klik tombol <OK> 
 
2. Mengkonfigurasi ODBC 

MySQL Connector/ODBC yang didistribusikan dengan Unpad SAS ada-

lah versi 3.51 32 bits. Jika Anda menggunakan MySQL Connector/ODBC versi 

yang lebih baru, perhatikan apakah itu untuk Windows 32 bits atau 64 bits? 

MySQL Connector/ODBC versi 32 bits dapat diinstal pada Windows 32/64 bits, 

sementara MySQL Connector/ODBC versi 64 bits hanya dapat diinstal pada 

Windows 64 bits. 

Jika Anda menggunakan MySQL Connector/ODBC versi 32 bits pada 

Windows 64 bits maka konfigurasi ODBC dilakukan melalui perintah sebagai 

berikut. 

▪ Klik  tombol +R 
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Gambar 6.37: 
Jendela Run 

▪ Tulis “%WINDIR%\SysWOW64\odbcad32.exe” pada ruas “Open"; 

▪ Klik tombol <OK> 

Sementara jka Anda menggunakan MySQL Connector/ODBC versi 32 

bits pada Windows 32 bits atau menggunakan MySQL Connector/ODBC versi 

64 bits pada Windows 64 bits maka konfigurasi ODBC dilakukan melalui 

perintah sebagai berikut. 

▪ Klik tombol +R 

 

Gambar 6.38: 
Jendela Run 

▪ Tulis “%WINDIR%\System32\odbcad32.exe” pada ruas “Open"; 

▪ Klik tombol <OK> 

Atas perintah tersebut maka akan ditampilkan jendela ODBC Data 

Source Administrator seperti ditunjukkan di dalam gambar berikut. 
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Gambar 6.39: 
ODBC Data Source Administrator 

▪ Pilih “System DSN"; 

▪ Klik tombol <Add> 

 

Gambar 6.40: 
Create New Data Source 

▪ Pilih “MySQL ODBC 3.51 Driver"; 

▪ Klik tombol <Finish> 
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Gambar 6.41: 
MySQL Connector/ODBC Data Source Configuration 

▪ Masukkan “sas” ke dalam ruas “Data Source Name”; 

▪ Masukkan deskripsi ke dalam ruas “Description”; 

▪ Masukkan “localhost” ke dalam ruas “TCP/IP Server"; 

▪ Masukkan “3306” ke dalam ruas “Port"; 

▪ Masukkan “root” ke dalam ruas “User"; 

▪ Masukkan “unpad_sas” ke dalam ruas “Password"; 

▪ Pilih “sas” pada kotak-kombo “Database"; 

▪ Klik tombol <OK> 

 

3. Menjalankan Unpad SAS 

Pada Windows Desktop, klik ikon Unpad SAS dan tekan tombol 

<Enter> atau klik-ganda ikon tersebut. Cara lainnya adalah, pada 

Windows Taskbar, klik tombol <Start>, pilih “All Programs”, pilih 

“Unpad SAS”, dan klik “Unpad SAS". 
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Gambar 6.42: 
Jendela Pembuka Unpad SAS 

Sesudah Jendela Pembuka, Anda akan dibawa masuk ke dalam Jendela 

Utama Unpad SAS sebagai berikut. 

 

Gambar 6.43: 
Jendela Utama Unpad SAS 



BELAJAR STATISTIKA DENGAN UNPAD SAS 

206 

4. Meng-import tabel-tabel contoh 

Unpad SAS menyediakan contoh-contoh tabel untuk setiap metode 

analisis. Tabel-tabel contoh tersebut ditempatkan di dalam folder 

%APPDATA%\UNPAD SAS\samples berupa file-file SQL-Script (SQL). Untuk 

mengimpor file-file tersebut lakukan langkah-langkah sebagai berikut. 

▪ Pertama. Buka menu File dan pilih perintah Import Table. 

 

Gambar 6.44: 
Menu File UNPAD SAS 

Atas perintah tersebut akan ditampilkan kotak dialog sebagai berikut. 

 

Gambar 6.45: 
Kotak Dialog Import Table 

▪ Kedua. Pilih tipe file SQL Script files (*.sql), pilih nama file yang akan di-

import, misalnya “sas-samples.sql”, dan klik tombol <Open>. 
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Atas perintah tersebut akan ditampilkan jendela “Import Table” sebagai 

berikut. 

 

Gambar 6.46: 
Jendela Import Table 

• Klik tombol    (Run SQL script) untuk menjalankan skrip tersebut. 

• Atas perintah tersebut maka tabel contoh yang dimaksud akan ditam-

bahkan ke dalam Unpad SAS. 

• Jangan melakukan perubahan apa pun terhadap skrip SQL tabel-tabel 

contoh terkecuali Anda telah memahami arti perintah di dalam skrip SQL 

tersebut. Uraian lebih lanjut tentang struktur perintah untuk mengimpor 
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tabel dalam bentuk skrip SQL dapat Anda baca di Bab 1 tentang 

Mengimpor Tabel. 

▪ Ketiga. Lakukan langkah pertama dan kedua untuk mengimpor tabel-

tabel lainnya. 

Cara lainnya adalah klik tombol    untuk menampilkan kotak dialog 

“Import Table” kemudian lakukan langkah kedua untuk mengimpor tabel-

tabel lainnya. 
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LAMPIRAN I: 
TABEL DISTRIBUSI NORMAL 

Z 
,000 ,001 ,002 ,003 ,004 

Luas Ordinat Luas Ordinat Luas Ordinat Luas Ordinat Luas Ordinat 

0,00 0,50000 0,39886 0,50040 0,39886 0,50080 0,39886 0,50120 0,39886 0,50160 0,39886 

0,01 0,50399 0,39884 0,50439 0,39884 0,50479 0,39883 0,50519 0,39883 0,50559 0,39882 

0,02 0,50798 0,39878 0,50838 0,39877 0,50878 0,39877 0,50917 0,39876 0,50957 0,39875 

0,03 0,51197 0,39868 0,51237 0,39867 0,51276 0,39866 0,51316 0,39864 0,51356 0,39863 

0,04 0,51595 0,39854 0,51635 0,39853 0,51675 0,39851 0,51715 0,39849 0,51755 0,39848 

0,05 0,51994 0,39836 0,52034 0,39834 0,52074 0,39832 0,52113 0,39830 0,52153 0,39828 

0,06 0,52392 0,39814 0,52432 0,39812 0,52472 0,39810 0,52512 0,39807 0,52551 0,39805 

0,07 0,52790 0,39789 0,52830 0,39786 0,52870 0,39783 0,52910 0,39780 0,52949 0,39777 

0,08 0,53188 0,39759 0,53228 0,39756 0,53268 0,39752 0,53307 0,39749 0,53347 0,39746 

0,09 0,53586 0,39725 0,53625 0,39721 0,53665 0,39718 0,53705 0,39714 0,53745 0,39710 

0,10 0,53983 0,39687 0,54022 0,39683 0,54062 0,39679 0,54102 0,39675 0,54142 0,39671 

0,11 0,54380 0,39646 0,54419 0,39641 0,54459 0,39637 0,54498 0,39632 0,54538 0,39628 

0,12 0,54776 0,39600 0,54815 0,39595 0,54855 0,39590 0,54895 0,39586 0,54934 0,39581 

0,13 0,55172 0,39551 0,55211 0,39545 0,55251 0,39540 0,55290 0,39535 0,55330 0,39530 

0,14 0,55567 0,39497 0,55607 0,39492 0,55646 0,39486 0,55685 0,39480 0,55725 0,39475 

0,15 0,55962 0,39440 0,56001 0,39434 0,56041 0,39428 0,56080 0,39422 0,56120 0,39416 

0,16 0,56356 0,39379 0,56395 0,39373 0,56435 0,39366 0,56474 0,39360 0,56513 0,39353 

0,17 0,56749 0,39314 0,56789 0,39307 0,56828 0,39301 0,56867 0,39294 0,56907 0,39287 

0,18 0,57142 0,39245 0,57182 0,39238 0,57221 0,39231 0,57260 0,39224 0,57299 0,39217 

0,19 0,57535 0,39173 0,57574 0,39165 0,57613 0,39158 0,57652 0,39150 0,57691 0,39143 

0,20 0,57926 0,39096 0,57965 0,39089 0,58004 0,39081 0,58043 0,39073 0,58082 0,39065 

0,21 0,58317 0,39016 0,58356 0,39008 0,58395 0,39000 0,58434 0,38992 0,58473 0,38983 

0,22 0,58706 0,38933 0,58745 0,38924 0,58784 0,38915 0,58823 0,38907 0,58862 0,38898 

0,23 0,59095 0,38845 0,59134 0,38836 0,59173 0,38827 0,59212 0,38818 0,59251 0,38809 

0,24 0,59483 0,38754 0,59522 0,38745 0,59561 0,38735 0,59600 0,38726 0,59638 0,38716 

0,25 0,59871 0,38659 0,59909 0,38649 0,59948 0,38640 0,59987 0,38630 0,60025 0,38620 

0,26 0,60257 0,38561 0,60295 0,38551 0,60334 0,38540 0,60372 0,38530 0,60411 0,38520 

0,27 0,60642 0,38459 0,60680 0,38448 0,60719 0,38438 0,60757 0,38427 0,60796 0,38417 

0,28 0,61026 0,38353 0,61064 0,38342 0,61103 0,38331 0,61141 0,38321 0,61179 0,38310 

0,29 0,61409 0,38244 0,61447 0,38233 0,61486 0,38222 0,61524 0,38210 0,61562 0,38199 

0,30 0,61791 0,38131 0,61829 0,38120 0,61867 0,38108 0,61906 0,38097 0,61944 0,38085 

0,31 0,62172 0,38015 0,62210 0,38003 0,62248 0,37991 0,62286 0,37979 0,62324 0,37968 

0,32 0,62552 0,37895 0,62589 0,37883 0,62627 0,37871 0,62665 0,37859 0,62703 0,37847 

0,33 0,62930 0,37772 0,62968 0,37760 0,63006 0,37747 0,63043 0,37735 0,63081 0,37722 

0,34 0,63307 0,37646 0,63345 0,37633 0,63382 0,37620 0,63420 0,37608 0,63458 0,37595 

0,35 0,63683 0,37516 0,63721 0,37503 0,63758 0,37490 0,63796 0,37477 0,63833 0,37464 

0,36 0,64058 0,37384 0,64095 0,37370 0,64132 0,37357 0,64170 0,37343 0,64207 0,37329 

0,37 0,64431 0,37247 0,64468 0,37234 0,64505 0,37220 0,64543 0,37206 0,64580 0,37192 

0,38 0,64803 0,37108 0,64840 0,37094 0,64877 0,37080 0,64914 0,37065 0,64951 0,37051 

0,39 0,65173 0,36965 0,65210 0,36951 0,65247 0,36936 0,65284 0,36922 0,65321 0,36907 

0,40 0,65542 0,36820 0,65579 0,36805 0,65616 0,36790 0,65653 0,36775 0,65689 0,36760 

0,41 0,65910 0,36671 0,65946 0,36656 0,65983 0,36641 0,66020 0,36626 0,66056 0,36610 

0,42 0,66276 0,36519 0,66312 0,36504 0,66349 0,36488 0,66385 0,36473 0,66422 0,36457 

0,43 0,66640 0,36364 0,66677 0,36348 0,66713 0,36333 0,66749 0,36317 0,66786 0,36301 

0,44 0,67003 0,36206 0,67039 0,36190 0,67076 0,36174 0,67112 0,36158 0,67148 0,36142 

0,45 0,67364 0,36045 0,67401 0,36029 0,67437 0,36013 0,67473 0,35997 0,67509 0,35980 

0,46 0,67724 0,35882 0,67760 0,35865 0,67796 0,35849 0,67832 0,35832 0,67868 0,35816 
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0,47 0,68082 0,35715 0,68118 0,35699 0,68154 0,35682 0,68189 0,35665 0,68225 0,35648 

0,48 0,68439 0,35546 0,68474 0,35529 0,68510 0,35512 0,68545 0,35495 0,68581 0,35478 

0,49 0,68793 0,35374 0,68829 0,35357 0,68864 0,35339 0,68899 0,35322 0,68935 0,35305 

0,50 0,69146 0,35199 0,69181 0,35182 0,69217 0,35164 0,69252 0,35147 0,69287 0,35129 

0,51 0,69497 0,35022 0,69532 0,35004 0,69567 0,34986 0,69602 0,34968 0,69637 0,34950 

0,52 0,69847 0,34842 0,69882 0,34824 0,69916 0,34806 0,69951 0,34788 0,69986 0,34770 

0,53 0,70194 0,34660 0,70229 0,34641 0,70264 0,34623 0,70298 0,34605 0,70333 0,34586 

0,54 0,70540 0,34475 0,70575 0,34456 0,70609 0,34438 0,70644 0,34419 0,70678 0,34400 

0,55 0,70884 0,34287 0,70918 0,34269 0,70953 0,34250 0,70987 0,34231 0,71021 0,34212 

0,56 0,71226 0,34098 0,71260 0,34079 0,71294 0,34059 0,71328 0,34040 0,71362 0,34021 

0,57 0,71566 0,33906 0,71600 0,33886 0,71634 0,33867 0,71668 0,33848 0,71702 0,33828 

0,58 0,71904 0,33711 0,71938 0,33692 0,71972 0,33672 0,72005 0,33652 0,72039 0,33633 

0,59 0,72240 0,33515 0,72274 0,33495 0,72307 0,33475 0,72341 0,33455 0,72374 0,33435 

0,60 0,72575 0,33316 0,72608 0,33296 0,72641 0,33276 0,72675 0,33256 0,72708 0,33236 

0,61 0,72907 0,33115 0,72940 0,33095 0,72973 0,33074 0,73006 0,33054 0,73039 0,33034 

0,62 0,73237 0,32912 0,73270 0,32891 0,73303 0,32871 0,73336 0,32850 0,73369 0,32830 

0,63 0,73565 0,32707 0,73598 0,32686 0,73631 0,32665 0,73663 0,32645 0,73696 0,32624 

0,64 0,73891 0,32500 0,73924 0,32479 0,73956 0,32458 0,73989 0,32437 0,74021 0,32416 

0,65 0,74215 0,32291 0,74248 0,32270 0,74280 0,32249 0,74312 0,32228 0,74344 0,32207 

0,66 0,74537 0,32080 0,74569 0,32059 0,74601 0,32038 0,74633 0,32016 0,74665 0,31995 

0,67 0,74857 0,31867 0,74889 0,31846 0,74921 0,31825 0,74953 0,31803 0,74984 0,31782 

0,68 0,75175 0,31653 0,75206 0,31631 0,75238 0,31610 0,75270 0,31588 0,75301 0,31567 

0,69 0,75490 0,31437 0,75522 0,31415 0,75553 0,31393 0,75585 0,31372 0,75616 0,31350 

0,70 0,75804 0,31219 0,75835 0,31197 0,75866 0,31175 0,75897 0,31153 0,75928 0,31132 

0,71 0,76115 0,31000 0,76146 0,30978 0,76177 0,30956 0,76208 0,30934 0,76239 0,30912 

0,72 0,76424 0,30779 0,76455 0,30757 0,76485 0,30735 0,76516 0,30712 0,76547 0,30690 

0,73 0,76730 0,30557 0,76761 0,30534 0,76792 0,30512 0,76822 0,30490 0,76853 0,30467 

0,74 0,77035 0,30333 0,77065 0,30310 0,77096 0,30288 0,77126 0,30265 0,77156 0,30243 

0,75 0,77337 0,30108 0,77367 0,30085 0,77397 0,30062 0,77428 0,30040 0,77458 0,30017 

0,76 0,77637 0,29881 0,77667 0,29859 0,77697 0,29836 0,77727 0,29813 0,77757 0,29790 

0,77 0,77935 0,29654 0,77965 0,29631 0,77994 0,29608 0,78024 0,29585 0,78053 0,29562 

0,78 0,78230 0,29425 0,78260 0,29402 0,78289 0,29379 0,78319 0,29356 0,78348 0,29333 

0,79 0,78524 0,29195 0,78553 0,29171 0,78582 0,29148 0,78611 0,29125 0,78640 0,29102 

0,80 0,78814 0,28963 0,78843 0,28940 0,78872 0,28917 0,78901 0,28894 0,78930 0,28871 

0,81 0,79103 0,28731 0,79132 0,28708 0,79160 0,28685 0,79189 0,28661 0,79218 0,28638 

0,82 0,79389 0,28498 0,79418 0,28475 0,79446 0,28451 0,79475 0,28428 0,79503 0,28404 

0,83 0,79673 0,28264 0,79701 0,28240 0,79730 0,28217 0,79758 0,28193 0,79786 0,28170 

0,84 0,79955 0,28029 0,79983 0,28005 0,80011 0,27982 0,80039 0,27958 0,80067 0,27934 

0,85 0,80234 0,27793 0,80262 0,27769 0,80289 0,27746 0,80317 0,27722 0,80345 0,27698 

0,86 0,80511 0,27556 0,80538 0,27533 0,80566 0,27509 0,80593 0,27485 0,80621 0,27461 

0,87 0,80785 0,27319 0,80812 0,27295 0,80840 0,27271 0,80867 0,27248 0,80894 0,27224 

0,88 0,81057 0,27081 0,81084 0,27057 0,81111 0,27033 0,81138 0,27009 0,81165 0,26986 

0,89 0,81327 0,26842 0,81354 0,26818 0,81380 0,26795 0,81407 0,26771 0,81434 0,26747 

0,90 0,81594 0,26603 0,81621 0,26579 0,81647 0,26555 0,81674 0,26531 0,81700 0,26507 

0,91 0,81859 0,26363 0,81885 0,26340 0,81912 0,26316 0,81938 0,26292 0,81964 0,26268 

0,92 0,82121 0,26123 0,82147 0,26099 0,82174 0,26075 0,82200 0,26051 0,82226 0,26027 

0,93 0,82381 0,25883 0,82407 0,25859 0,82433 0,25835 0,82459 0,25811 0,82485 0,25787 

0,94 0,82639 0,25642 0,82665 0,25618 0,82690 0,25594 0,82716 0,25570 0,82742 0,25546 

0,95 0,82894 0,25401 0,82920 0,25377 0,82945 0,25353 0,82970 0,25328 0,82996 0,25304 

0,96 0,83147 0,25159 0,83172 0,25135 0,83198 0,25111 0,83223 0,25087 0,83248 0,25063 
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0,97 0,83398 0,24918 0,83423 0,24894 0,83447 0,24869 0,83472 0,24845 0,83497 0,24821 

0,98 0,83646 0,24676 0,83670 0,24652 0,83695 0,24628 0,83720 0,24603 0,83744 0,24579 

0,99 0,83891 0,24434 0,83916 0,24410 0,83940 0,24386 0,83965 0,24362 0,83989 0,24337 

1,00 0,84134 0,24192 0,84159 0,24168 0,84183 0,24144 0,84207 0,24120 0,84231 0,24095 

1,01 0,84375 0,23950 0,84399 0,23926 0,84423 0,23902 0,84447 0,23878 0,84471 0,23854 

1,02 0,84614 0,23708 0,84637 0,23684 0,84661 0,23660 0,84685 0,23636 0,84708 0,23612 

1,03 0,84849 0,23467 0,84873 0,23442 0,84896 0,23418 0,84920 0,23394 0,84943 0,23370 

1,04 0,85083 0,23225 0,85106 0,23201 0,85129 0,23177 0,85153 0,23153 0,85176 0,23128 

1,05 0,85314 0,22984 0,85337 0,22959 0,85360 0,22935 0,85383 0,22911 0,85406 0,22887 

1,06 0,85543 0,22742 0,85566 0,22718 0,85588 0,22694 0,85611 0,22670 0,85634 0,22646 

1,07 0,85769 0,22501 0,85792 0,22477 0,85814 0,22453 0,85836 0,22429 0,85859 0,22405 

1,08 0,85993 0,22261 0,86015 0,22237 0,86037 0,22213 0,86060 0,22189 0,86082 0,22165 

1,09 0,86214 0,22021 0,86236 0,21997 0,86258 0,21973 0,86280 0,21949 0,86302 0,21925 

1,10 0,86433 0,21781 0,86455 0,21757 0,86477 0,21733 0,86499 0,21709 0,86520 0,21685 

1,11 0,86650 0,21541 0,86672 0,21518 0,86693 0,21494 0,86715 0,21470 0,86736 0,21446 

1,12 0,86864 0,21303 0,86886 0,21279 0,86907 0,21255 0,86928 0,21231 0,86949 0,21207 

1,13 0,87076 0,21064 0,87097 0,21041 0,87118 0,21017 0,87139 0,20993 0,87160 0,20969 

1,14 0,87286 0,20827 0,87307 0,20803 0,87327 0,20779 0,87348 0,20755 0,87369 0,20732 

1,15 0,87493 0,20589 0,87513 0,20566 0,87534 0,20542 0,87554 0,20518 0,87575 0,20495 

1,16 0,87698 0,20353 0,87718 0,20329 0,87738 0,20306 0,87759 0,20282 0,87779 0,20259 

1,17 0,87900 0,20117 0,87920 0,20094 0,87940 0,20070 0,87960 0,20047 0,87980 0,20023 

1,18 0,88100 0,19882 0,88120 0,19859 0,88140 0,19835 0,88160 0,19812 0,88179 0,19789 

1,19 0,88298 0,19648 0,88317 0,19625 0,88337 0,19601 0,88357 0,19578 0,88376 0,19555 

1,20 0,88493 0,19415 0,88512 0,19391 0,88532 0,19368 0,88551 0,19345 0,88571 0,19322 

1,21 0,88686 0,19182 0,88705 0,19159 0,88724 0,19136 0,88744 0,19113 0,88763 0,19089 

1,22 0,88877 0,18951 0,88896 0,18927 0,88915 0,18904 0,88934 0,18881 0,88952 0,18858 

1,23 0,89065 0,18720 0,89084 0,18697 0,89103 0,18674 0,89121 0,18651 0,89140 0,18628 

1,24 0,89251 0,18490 0,89270 0,18467 0,89288 0,18444 0,89307 0,18421 0,89325 0,18398 

1,25 0,89435 0,18261 0,89453 0,18238 0,89472 0,18216 0,89490 0,18193 0,89508 0,18170 

1,26 0,89617 0,18033 0,89635 0,18011 0,89653 0,17988 0,89671 0,17965 0,89688 0,17943 

1,27 0,89796 0,17807 0,89814 0,17784 0,89831 0,17762 0,89849 0,17739 0,89867 0,17716 

1,28 0,89973 0,17581 0,89990 0,17559 0,90008 0,17536 0,90025 0,17514 0,90043 0,17491 

1,29 0,90147 0,17357 0,90165 0,17334 0,90182 0,17312 0,90199 0,17290 0,90217 0,17267 

1,30 0,90320 0,17133 0,90337 0,17111 0,90354 0,17089 0,90371 0,17067 0,90388 0,17044 

1,31 0,90490 0,16911 0,90507 0,16889 0,90524 0,16867 0,90541 0,16845 0,90558 0,16823 

1,32 0,90658 0,16690 0,90675 0,16668 0,90692 0,16646 0,90708 0,16624 0,90725 0,16602 

1,33 0,90824 0,16471 0,90841 0,16449 0,90857 0,16427 0,90873 0,16405 0,90890 0,16383 

1,34 0,90988 0,16252 0,91004 0,16230 0,91020 0,16209 0,91036 0,16187 0,91053 0,16165 

1,35 0,91149 0,16035 0,91165 0,16013 0,91181 0,15992 0,91197 0,15970 0,91213 0,15949 

1,36 0,91309 0,15819 0,91324 0,15798 0,91340 0,15776 0,91356 0,15755 0,91372 0,15733 

1,37 0,91466 0,15605 0,91481 0,15583 0,91497 0,15562 0,91512 0,15541 0,91528 0,15519 

1,38 0,91621 0,15392 0,91636 0,15370 0,91651 0,15349 0,91667 0,15328 0,91682 0,15307 

1,39 0,91774 0,15180 0,91789 0,15159 0,91804 0,15138 0,91819 0,15117 0,91834 0,15096 

1,40 0,91924 0,14970 0,91939 0,14949 0,91954 0,14928 0,91969 0,14907 0,91984 0,14886 

1,41 0,92073 0,14761 0,92088 0,14740 0,92103 0,14719 0,92117 0,14699 0,92132 0,14678 

1,42 0,92220 0,14553 0,92234 0,14533 0,92249 0,14512 0,92263 0,14492 0,92278 0,14471 

1,43 0,92364 0,14348 0,92378 0,14327 0,92393 0,14307 0,92407 0,14286 0,92421 0,14266 

1,44 0,92507 0,14143 0,92521 0,14123 0,92535 0,14102 0,92549 0,14082 0,92563 0,14062 

1,45 0,92647 0,13940 0,92661 0,13920 0,92675 0,13900 0,92689 0,13880 0,92703 0,13860 

1,46 0,92785 0,13739 0,92799 0,13719 0,92813 0,13699 0,92827 0,13679 0,92840 0,13659 
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1,47 0,92922 0,13539 0,92935 0,13519 0,92949 0,13499 0,92962 0,13479 0,92976 0,13460 

1,48 0,93056 0,13341 0,93070 0,13321 0,93083 0,13301 0,93096 0,13282 0,93110 0,13262 

1,49 0,93189 0,13144 0,93202 0,13125 0,93215 0,13105 0,93228 0,13086 0,93241 0,13066 

1,50 0,93319 0,12949 0,93332 0,12930 0,93345 0,12910 0,93358 0,12891 0,93371 0,12872 

1,51 0,93448 0,12756 0,93461 0,12736 0,93473 0,12717 0,93486 0,12698 0,93499 0,12679 

1,52 0,93574 0,12564 0,93587 0,12545 0,93600 0,12526 0,93612 0,12507 0,93625 0,12488 

1,53 0,93699 0,12374 0,93712 0,12355 0,93724 0,12336 0,93736 0,12317 0,93749 0,12298 

1,54 0,93822 0,12185 0,93834 0,12167 0,93846 0,12148 0,93858 0,12129 0,93871 0,12110 

1,55 0,93943 0,11998 0,93955 0,11980 0,93967 0,11961 0,93979 0,11943 0,93991 0,11924 

1,56 0,94062 0,11813 0,94074 0,11795 0,94086 0,11777 0,94097 0,11758 0,94109 0,11740 

1,57 0,94179 0,11630 0,94191 0,11612 0,94202 0,11593 0,94214 0,11575 0,94226 0,11557 

1,58 0,94295 0,11448 0,94306 0,11430 0,94318 0,11412 0,94329 0,11394 0,94340 0,11376 

1,59 0,94408 0,11268 0,94420 0,11250 0,94431 0,11232 0,94442 0,11214 0,94453 0,11197 

1,60 0,94520 0,11090 0,94531 0,11072 0,94542 0,11054 0,94553 0,11037 0,94564 0,11019 

1,61 0,94630 0,10913 0,94641 0,10896 0,94652 0,10878 0,94663 0,10861 0,94674 0,10843 

1,62 0,94738 0,10738 0,94749 0,10721 0,94760 0,10704 0,94771 0,10686 0,94781 0,10669 

1,63 0,94845 0,10565 0,94855 0,10548 0,94866 0,10531 0,94877 0,10514 0,94887 0,10497 

1,64 0,94950 0,10394 0,94960 0,10377 0,94970 0,10360 0,94981 0,10343 0,94991 0,10326 

1,65 0,95053 0,10224 0,95063 0,10208 0,95073 0,10191 0,95083 0,10174 0,95094 0,10157 

1,66 0,95154 0,10057 0,95164 0,10040 0,95174 0,10023 0,95184 0,10007 0,95194 0,09990 

1,67 0,95254 0,09891 0,95264 0,09874 0,95274 0,09858 0,95284 0,09841 0,95293 0,09825 

1,68 0,95352 0,09726 0,95362 0,09710 0,95372 0,09694 0,95381 0,09677 0,95391 0,09661 

1,69 0,95449 0,09564 0,95458 0,09548 0,95468 0,09531 0,95477 0,09515 0,95487 0,09499 

1,70 0,95543 0,09403 0,95553 0,09387 0,95562 0,09371 0,95572 0,09355 0,95581 0,09339 

1,71 0,95637 0,09244 0,95646 0,09228 0,95655 0,09212 0,95664 0,09197 0,95674 0,09181 

1,72 0,95728 0,09087 0,95737 0,09071 0,95747 0,09056 0,95756 0,09040 0,95765 0,09024 

1,73 0,95818 0,08931 0,95827 0,08916 0,95836 0,08901 0,95845 0,08885 0,95854 0,08870 

1,74 0,95907 0,08778 0,95916 0,08763 0,95925 0,08747 0,95933 0,08732 0,95942 0,08717 

1,75 0,95994 0,08626 0,96003 0,08611 0,96011 0,08596 0,96020 0,08581 0,96028 0,08566 

1,76 0,96080 0,08476 0,96088 0,08461 0,96097 0,08446 0,96105 0,08431 0,96113 0,08416 

1,77 0,96164 0,08328 0,96172 0,08313 0,96180 0,08298 0,96189 0,08284 0,96197 0,08269 

1,78 0,96246 0,08181 0,96254 0,08167 0,96263 0,08152 0,96271 0,08138 0,96279 0,08123 

1,79 0,96327 0,08036 0,96335 0,08022 0,96343 0,08008 0,96351 0,07993 0,96359 0,07979 

1,80 0,96407 0,07893 0,96415 0,07879 0,96423 0,07865 0,96431 0,07851 0,96438 0,07837 

1,81 0,96485 0,07752 0,96493 0,07738 0,96501 0,07724 0,96508 0,07710 0,96516 0,07696 

1,82 0,96562 0,07613 0,96570 0,07599 0,96577 0,07585 0,96585 0,07571 0,96592 0,07558 

1,83 0,96638 0,07475 0,96645 0,07461 0,96652 0,07448 0,96660 0,07434 0,96667 0,07421 

1,84 0,96712 0,07339 0,96719 0,07326 0,96726 0,07312 0,96734 0,07299 0,96741 0,07285 

1,85 0,96784 0,07205 0,96792 0,07192 0,96799 0,07178 0,96806 0,07165 0,96813 0,07152 

1,86 0,96856 0,07073 0,96863 0,07059 0,96870 0,07046 0,96877 0,07033 0,96884 0,07020 

1,87 0,96926 0,06942 0,96933 0,06929 0,96940 0,06916 0,96947 0,06903 0,96953 0,06890 

1,88 0,96995 0,06813 0,97001 0,06800 0,97008 0,06787 0,97015 0,06775 0,97022 0,06762 

1,89 0,97062 0,06686 0,97069 0,06673 0,97075 0,06661 0,97082 0,06648 0,97089 0,06635 

1,90 0,97128 0,06560 0,97135 0,06548 0,97141 0,06535 0,97148 0,06523 0,97154 0,06511 

1,91 0,97193 0,06436 0,97200 0,06424 0,97206 0,06412 0,97213 0,06400 0,97219 0,06387 

1,92 0,97257 0,06314 0,97263 0,06302 0,97270 0,06290 0,97276 0,06278 0,97282 0,06266 

1,93 0,97320 0,06194 0,97326 0,06182 0,97332 0,06170 0,97338 0,06158 0,97344 0,06146 

1,94 0,97381 0,06075 0,97387 0,06064 0,97393 0,06052 0,97399 0,06040 0,97405 0,06028 

1,95 0,97441 0,05958 0,97447 0,05947 0,97453 0,05935 0,97459 0,05923 0,97465 0,05912 

1,96 0,97500 0,05843 0,97506 0,05831 0,97512 0,05820 0,97518 0,05809 0,97523 0,05797 
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1,97 0,97558 0,05729 0,97564 0,05718 0,97570 0,05707 0,97575 0,05695 0,97581 0,05684 

1,98 0,97615 0,05617 0,97620 0,05606 0,97626 0,05595 0,97632 0,05584 0,97637 0,05573 

1,99 0,97670 0,05507 0,97676 0,05496 0,97681 0,05485 0,97687 0,05474 0,97692 0,05463 

2,00 0,97725 0,05398 0,97730 0,05387 0,97736 0,05376 0,97741 0,05366 0,97746 0,05355 

2,01 0,97778 0,05291 0,97784 0,05280 0,97789 0,05270 0,97794 0,05259 0,97800 0,05248 

2,02 0,97831 0,05185 0,97836 0,05175 0,97841 0,05164 0,97846 0,05154 0,97851 0,05144 

2,03 0,97882 0,05081 0,97887 0,05071 0,97892 0,05061 0,97897 0,05050 0,97902 0,05040 

2,04 0,97932 0,04979 0,97937 0,04969 0,97942 0,04959 0,97947 0,04949 0,97952 0,04939 

2,05 0,97982 0,04878 0,97987 0,04868 0,97992 0,04858 0,97996 0,04848 0,98001 0,04838 

2,06 0,98030 0,04779 0,98035 0,04769 0,98040 0,04759 0,98044 0,04750 0,98049 0,04740 

2,07 0,98077 0,04681 0,98082 0,04672 0,98087 0,04662 0,98091 0,04652 0,98096 0,04643 

2,08 0,98124 0,04585 0,98128 0,04576 0,98133 0,04566 0,98137 0,04557 0,98142 0,04547 

2,09 0,98169 0,04491 0,98174 0,04481 0,98178 0,04472 0,98183 0,04462 0,98187 0,04453 

2,10 0,98214 0,04397 0,98218 0,04388 0,98222 0,04379 0,98227 0,04370 0,98231 0,04361 

2,11 0,98257 0,04306 0,98261 0,04297 0,98266 0,04288 0,98270 0,04279 0,98274 0,04270 

2,12 0,98300 0,04216 0,98304 0,04207 0,98308 0,04198 0,98312 0,04189 0,98316 0,04180 

2,13 0,98341 0,04127 0,98346 0,04118 0,98350 0,04110 0,98354 0,04101 0,98358 0,04092 

2,14 0,98382 0,04040 0,98386 0,04031 0,98390 0,04023 0,98394 0,04014 0,98398 0,04005 

2,15 0,98422 0,03954 0,98426 0,03946 0,98430 0,03937 0,98434 0,03929 0,98438 0,03920 

2,16 0,98461 0,03870 0,98465 0,03862 0,98469 0,03853 0,98473 0,03845 0,98477 0,03837 

2,17 0,98500 0,03787 0,98503 0,03779 0,98507 0,03771 0,98511 0,03762 0,98515 0,03754 

2,18 0,98537 0,03706 0,98541 0,03697 0,98545 0,03689 0,98548 0,03681 0,98552 0,03673 

2,19 0,98574 0,03625 0,98577 0,03618 0,98581 0,03610 0,98585 0,03602 0,98588 0,03594 

2,20 0,98610 0,03547 0,98613 0,03539 0,98617 0,03531 0,98620 0,03523 0,98624 0,03516 

2,21 0,98645 0,03469 0,98648 0,03462 0,98652 0,03454 0,98655 0,03446 0,98659 0,03439 

2,22 0,98679 0,03393 0,98682 0,03386 0,98686 0,03378 0,98689 0,03371 0,98693 0,03363 

2,23 0,98713 0,03319 0,98716 0,03311 0,98719 0,03304 0,98723 0,03297 0,98726 0,03289 

2,24 0,98745 0,03245 0,98749 0,03238 0,98752 0,03231 0,98755 0,03224 0,98758 0,03216 

2,25 0,98778 0,03173 0,98781 0,03166 0,98784 0,03159 0,98787 0,03152 0,98790 0,03145 

2,26 0,98809 0,03103 0,98812 0,03096 0,98815 0,03089 0,98818 0,03082 0,98821 0,03075 

2,27 0,98840 0,03033 0,98843 0,03026 0,98846 0,03019 0,98849 0,03012 0,98852 0,03006 

2,28 0,98870 0,02965 0,98873 0,02958 0,98876 0,02951 0,98878 0,02945 0,98881 0,02938 

2,29 0,98899 0,02898 0,98902 0,02891 0,98905 0,02885 0,98908 0,02878 0,98910 0,02871 

2,30 0,98928 0,02832 0,98930 0,02826 0,98933 0,02819 0,98936 0,02813 0,98939 0,02806 

2,31 0,98956 0,02768 0,98958 0,02761 0,98961 0,02755 0,98964 0,02748 0,98967 0,02742 

2,32 0,98983 0,02704 0,98986 0,02698 0,98988 0,02692 0,98991 0,02685 0,98994 0,02679 

2,33 0,99010 0,02642 0,99012 0,02636 0,99015 0,02630 0,99018 0,02624 0,99020 0,02618 

2,34 0,99036 0,02581 0,99038 0,02575 0,99041 0,02569 0,99044 0,02563 0,99046 0,02557 

2,35 0,99061 0,02521 0,99064 0,02515 0,99066 0,02509 0,99069 0,02504 0,99071 0,02498 

2,36 0,99086 0,02463 0,99089 0,02457 0,99091 0,02451 0,99094 0,02445 0,99096 0,02439 

2,37 0,99111 0,02405 0,99113 0,02399 0,99115 0,02394 0,99118 0,02388 0,99120 0,02382 

2,38 0,99134 0,02349 0,99137 0,02343 0,99139 0,02337 0,99141 0,02332 0,99144 0,02326 

2,39 0,99158 0,02293 0,99160 0,02288 0,99162 0,02282 0,99164 0,02277 0,99167 0,02271 

2,40 0,99180 0,02239 0,99182 0,02234 0,99185 0,02228 0,99187 0,02223 0,99189 0,02218 

2,41 0,99202 0,02186 0,99205 0,02181 0,99207 0,02175 0,99209 0,02170 0,99211 0,02165 

2,42 0,99224 0,02134 0,99226 0,02128 0,99228 0,02123 0,99230 0,02118 0,99232 0,02113 

2,43 0,99245 0,02083 0,99247 0,02077 0,99249 0,02072 0,99251 0,02067 0,99253 0,02062 

2,44 0,99266 0,02032 0,99268 0,02027 0,99270 0,02023 0,99272 0,02018 0,99274 0,02013 

2,45 0,99286 0,01983 0,99288 0,01978 0,99290 0,01974 0,99292 0,01969 0,99294 0,01964 

2,46 0,99305 0,01935 0,99307 0,01930 0,99309 0,01926 0,99311 0,01921 0,99313 0,01916 
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2,47 0,99324 0,01888 0,99326 0,01883 0,99328 0,01879 0,99330 0,01874 0,99332 0,01870 

2,48 0,99343 0,01842 0,99345 0,01837 0,99347 0,01833 0,99349 0,01828 0,99350 0,01824 

2,49 0,99361 0,01797 0,99363 0,01792 0,99365 0,01788 0,99367 0,01783 0,99368 0,01779 

2,50 0,99379 0,01752 0,99381 0,01748 0,99383 0,01744 0,99384 0,01739 0,99386 0,01735 

2,51 0,99396 0,01709 0,99398 0,01705 0,99400 0,01701 0,99401 0,01696 0,99403 0,01692 

2,52 0,99413 0,01667 0,99415 0,01662 0,99417 0,01658 0,99418 0,01654 0,99420 0,01650 

2,53 0,99430 0,01625 0,99431 0,01621 0,99433 0,01617 0,99435 0,01613 0,99436 0,01609 

2,54 0,99446 0,01584 0,99447 0,01580 0,99449 0,01576 0,99450 0,01572 0,99452 0,01568 

2,55 0,99461 0,01545 0,99463 0,01541 0,99464 0,01537 0,99466 0,01533 0,99468 0,01529 

2,56 0,99477 0,01506 0,99478 0,01502 0,99480 0,01498 0,99481 0,01494 0,99483 0,01490 

2,57 0,99492 0,01468 0,99493 0,01464 0,99494 0,01460 0,99496 0,01456 0,99497 0,01453 

2,58 0,99506 0,01430 0,99507 0,01427 0,99509 0,01423 0,99510 0,01419 0,99512 0,01416 

2,59 0,99520 0,01394 0,99522 0,01390 0,99523 0,01387 0,99524 0,01383 0,99526 0,01379 

2,60 0,99534 0,01358 0,99535 0,01354 0,99537 0,01351 0,99538 0,01347 0,99539 0,01344 

2,61 0,99547 0,01323 0,99549 0,01320 0,99550 0,01316 0,99551 0,01313 0,99553 0,01309 

2,62 0,99560 0,01289 0,99562 0,01286 0,99563 0,01282 0,99564 0,01279 0,99565 0,01276 

2,63 0,99573 0,01256 0,99574 0,01252 0,99576 0,01249 0,99577 0,01246 0,99578 0,01242 

2,64 0,99585 0,01223 0,99587 0,01220 0,99588 0,01216 0,99589 0,01213 0,99590 0,01210 

2,65 0,99598 0,01191 0,99599 0,01188 0,99600 0,01185 0,99601 0,01182 0,99602 0,01178 

2,66 0,99609 0,01160 0,99610 0,01157 0,99612 0,01154 0,99613 0,01151 0,99614 0,01147 

2,67 0,99621 0,01129 0,99622 0,01126 0,99623 0,01123 0,99624 0,01120 0,99625 0,01117 

2,68 0,99632 0,01099 0,99633 0,01097 0,99634 0,01094 0,99635 0,01091 0,99636 0,01088 

2,69 0,99643 0,01070 0,99644 0,01067 0,99645 0,01065 0,99646 0,01062 0,99647 0,01059 

2,70 0,99653 0,01042 0,99654 0,01039 0,99655 0,01036 0,99656 0,01033 0,99657 0,01031 

2,71 0,99664 0,01014 0,99665 0,01011 0,99666 0,01009 0,99667 0,01006 0,99668 0,01003 

2,72 0,99674 0,00987 0,99675 0,00984 0,99676 0,00982 0,99677 0,00979 0,99678 0,00976 

2,73 0,99683 0,00960 0,99684 0,00958 0,99685 0,00955 0,99686 0,00953 0,99687 0,00950 

2,74 0,99693 0,00934 0,99694 0,00932 0,99695 0,00929 0,99696 0,00927 0,99697 0,00924 

2,75 0,99702 0,00909 0,99703 0,00907 0,99704 0,00904 0,99705 0,00902 0,99706 0,00899 

2,76 0,99711 0,00884 0,99712 0,00882 0,99713 0,00880 0,99714 0,00877 0,99715 0,00875 

2,77 0,99720 0,00860 0,99721 0,00858 0,99721 0,00856 0,99722 0,00853 0,99723 0,00851 

2,78 0,99728 0,00837 0,99729 0,00834 0,99730 0,00832 0,99731 0,00830 0,99732 0,00828 

2,79 0,99736 0,00814 0,99737 0,00812 0,99738 0,00809 0,99739 0,00807 0,99740 0,00805 

2,80 0,99744 0,00791 0,99745 0,00789 0,99746 0,00787 0,99747 0,00785 0,99748 0,00783 

2,81 0,99752 0,00769 0,99753 0,00767 0,99754 0,00765 0,99755 0,00763 0,99755 0,00761 

2,82 0,99760 0,00748 0,99761 0,00746 0,99761 0,00744 0,99762 0,00742 0,99763 0,00740 

2,83 0,99767 0,00727 0,99768 0,00725 0,99769 0,00723 0,99769 0,00721 0,99770 0,00719 

2,84 0,99774 0,00707 0,99775 0,00705 0,99776 0,00703 0,99777 0,00701 0,99777 0,00699 

2,85 0,99781 0,00687 0,99782 0,00685 0,99783 0,00683 0,99783 0,00681 0,99784 0,00679 

2,86 0,99788 0,00668 0,99789 0,00666 0,99790 0,00664 0,99790 0,00662 0,99791 0,00660 

2,87 0,99795 0,00649 0,99795 0,00647 0,99796 0,00645 0,99797 0,00643 0,99797 0,00642 

2,88 0,99801 0,00631 0,99802 0,00629 0,99802 0,00627 0,99803 0,00625 0,99804 0,00623 

2,89 0,99807 0,00613 0,99808 0,00611 0,99809 0,00609 0,99809 0,00607 0,99810 0,00606 

2,90 0,99813 0,00595 0,99814 0,00593 0,99815 0,00592 0,99815 0,00590 0,99816 0,00588 

2,91 0,99819 0,00578 0,99820 0,00576 0,99820 0,00575 0,99821 0,00573 0,99822 0,00571 

2,92 0,99825 0,00561 0,99826 0,00560 0,99826 0,00558 0,99827 0,00557 0,99827 0,00555 

2,93 0,99831 0,00545 0,99831 0,00544 0,99832 0,00542 0,99832 0,00541 0,99833 0,00539 

2,94 0,99836 0,00530 0,99836 0,00528 0,99837 0,00526 0,99837 0,00525 0,99838 0,00523 

2,95 0,99841 0,00514 0,99842 0,00513 0,99842 0,00511 0,99843 0,00510 0,99843 0,00508 

2,96 0,99846 0,00499 0,99847 0,00498 0,99847 0,00496 0,99848 0,00495 0,99848 0,00493 
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2,97 0,99851 0,00485 0,99852 0,00483 0,99852 0,00482 0,99853 0,00480 0,99853 0,00479 

2,98 0,99856 0,00470 0,99856 0,00469 0,99857 0,00468 0,99857 0,00466 0,99858 0,00465 

2,99 0,99861 0,00457 0,99861 0,00455 0,99861 0,00454 0,99862 0,00452 0,99862 0,00451 

3,00 0,99865 0,00443 0,99865 0,00442 0,99866 0,00440 0,99866 0,00439 0,99867 0,00438 

3,01 0,99869 0,00430 0,99870 0,00429 0,99870 0,00427 0,99871 0,00426 0,99871 0,00425 

3,02 0,99874 0,00417 0,99874 0,00416 0,99874 0,00415 0,99875 0,00413 0,99875 0,00412 

3,03 0,99878 0,00405 0,99878 0,00404 0,99879 0,00402 0,99879 0,00401 0,99879 0,00400 

3,04 0,99882 0,00393 0,99882 0,00391 0,99882 0,00390 0,99883 0,00389 0,99883 0,00388 

3,05 0,99886 0,00381 0,99886 0,00380 0,99886 0,00379 0,99887 0,00377 0,99887 0,00376 

3,06 0,99889 0,00369 0,99890 0,00368 0,99890 0,00367 0,99890 0,00366 0,99891 0,00365 

3,07 0,99893 0,00358 0,99893 0,00357 0,99894 0,00356 0,99894 0,00355 0,99894 0,00354 

3,08 0,99896 0,00347 0,99897 0,00346 0,99897 0,00345 0,99898 0,00344 0,99898 0,00343 

3,09 0,99900 0,00337 0,99900 0,00336 0,99901 0,00335 0,99901 0,00334 0,99901 0,00333 

3,10 0,99903 0,00327 0,99904 0,00326 0,99904 0,00325 0,99904 0,00324 0,99905 0,00323 

3,11 0,99906 0,00317 0,99907 0,00316 0,99907 0,00315 0,99907 0,00314 0,99908 0,00313 

3,12 0,99910 0,00307 0,99910 0,00306 0,99910 0,00305 0,99910 0,00304 0,99911 0,00303 

3,13 0,99913 0,00297 0,99913 0,00297 0,99913 0,00296 0,99913 0,00295 0,99914 0,00294 

3,14 0,99916 0,00288 0,99916 0,00287 0,99916 0,00286 0,99916 0,00286 0,99917 0,00285 

3,15 0,99918 0,00279 0,99919 0,00278 0,99919 0,00278 0,99919 0,00277 0,99919 0,00276 

3,16 0,99921 0,00271 0,99921 0,00270 0,99922 0,00269 0,99922 0,00268 0,99922 0,00267 

3,17 0,99924 0,00262 0,99924 0,00261 0,99924 0,00261 0,99925 0,00260 0,99925 0,00259 

3,18 0,99926 0,00254 0,99927 0,00253 0,99927 0,00252 0,99927 0,00252 0,99927 0,00251 

3,19 0,99929 0,00246 0,99929 0,00245 0,99929 0,00245 0,99930 0,00244 0,99930 0,00243 

3,20 0,99931 0,00238 0,99932 0,00238 0,99932 0,00237 0,99932 0,00236 0,99932 0,00235 

3,21 0,99934 0,00231 0,99934 0,00230 0,99934 0,00229 0,99934 0,00229 0,99935 0,00228 

3,22 0,99936 0,00224 0,99936 0,00223 0,99936 0,00222 0,99937 0,00221 0,99937 0,00221 

3,23 0,99938 0,00216 0,99938 0,00216 0,99939 0,00215 0,99939 0,00214 0,99939 0,00214 

3,24 0,99940 0,00210 0,99940 0,00209 0,99941 0,00208 0,99941 0,00208 0,99941 0,00207 

3,25 0,99942 0,00203 0,99943 0,00202 0,99943 0,00202 0,99943 0,00201 0,99943 0,00200 

3,26 0,99944 0,00196 0,99944 0,00196 0,99945 0,00195 0,99945 0,00194 0,99945 0,00194 

3,27 0,99946 0,00190 0,99946 0,00189 0,99947 0,00189 0,99947 0,00188 0,99947 0,00188 

3,28 0,99948 0,00184 0,99948 0,00183 0,99948 0,00183 0,99949 0,00182 0,99949 0,00182 

3,29 0,99950 0,00178 0,99950 0,00177 0,99950 0,00177 0,99950 0,00176 0,99951 0,00176 

3,30 0,99952 0,00172 0,99952 0,00172 0,99952 0,00171 0,99952 0,00171 0,99952 0,00170 

3,31 0,99953 0,00167 0,99954 0,00166 0,99954 0,00166 0,99954 0,00165 0,99954 0,00164 

3,32 0,99955 0,00161 0,99955 0,00161 0,99955 0,00160 0,99955 0,00160 0,99956 0,00159 

3,33 0,99957 0,00156 0,99957 0,00155 0,99957 0,00155 0,99957 0,00154 0,99957 0,00154 

3,34 0,99958 0,00151 0,99958 0,00150 0,99958 0,00150 0,99959 0,00149 0,99959 0,00149 

3,35 0,99960 0,00146 0,99960 0,00145 0,99960 0,00145 0,99960 0,00144 0,99960 0,00144 

3,36 0,99961 0,00141 0,99961 0,00141 0,99961 0,00140 0,99961 0,00140 0,99962 0,00139 

3,37 0,99962 0,00136 0,99963 0,00136 0,99963 0,00135 0,99963 0,00135 0,99963 0,00135 

3,38 0,99964 0,00132 0,99964 0,00131 0,99964 0,00131 0,99964 0,00131 0,99964 0,00130 

3,39 0,99965 0,00127 0,99965 0,00127 0,99965 0,00127 0,99965 0,00126 0,99966 0,00126 

3,40 0,99966 0,00123 0,99966 0,00123 0,99967 0,00122 0,99967 0,00122 0,99967 0,00122 

3,41 0,99968 0,00119 0,99968 0,00119 0,99968 0,00118 0,99968 0,00118 0,99968 0,00117 

3,42 0,99969 0,00115 0,99969 0,00115 0,99969 0,00114 0,99969 0,00114 0,99969 0,00114 

3,43 0,99970 0,00111 0,99970 0,00111 0,99970 0,00110 0,99970 0,00110 0,99970 0,00110 

3,44 0,99971 0,00107 0,99971 0,00107 0,99971 0,00107 0,99971 0,00106 0,99971 0,00106 

3,45 0,99972 0,00104 0,99972 0,00103 0,99972 0,00103 0,99972 0,00103 0,99972 0,00102 

3,46 0,99973 0,00100 0,99973 0,00100 0,99973 0,00100 0,99973 0,00099 0,99973 0,00099 
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3,47 0,99974 0,00097 0,99974 0,00097 0,99974 0,00096 0,99974 0,00096 0,99974 0,00096 

3,48 0,99975 0,00094 0,99975 0,00093 0,99975 0,00093 0,99975 0,00093 0,99975 0,00092 

3,49 0,99976 0,00090 0,99976 0,00090 0,99976 0,00090 0,99976 0,00089 0,99976 0,00089 

3,50 0,99977 0,00087 0,99977 0,00087 0,99977 0,00087 0,99977 0,00086 0,99977 0,00086 

3,51 0,99978 0,00084 0,99978 0,00084 0,99978 0,00084 0,99978 0,00083 0,99978 0,00083 

3,52 0,99978 0,00081 0,99979 0,00081 0,99979 0,00081 0,99979 0,00080 0,99979 0,00080 

3,53 0,99979 0,00079 0,99979 0,00078 0,99979 0,00078 0,99979 0,00078 0,99980 0,00077 

3,54 0,99980 0,00076 0,99980 0,00076 0,99980 0,00075 0,99980 0,00075 0,99980 0,00075 

3,55 0,99981 0,00073 0,99981 0,00073 0,99981 0,00073 0,99981 0,00072 0,99981 0,00072 

3,56 0,99981 0,00071 0,99982 0,00070 0,99982 0,00070 0,99982 0,00070 0,99982 0,00070 

3,57 0,99982 0,00068 0,99982 0,00068 0,99982 0,00068 0,99982 0,00067 0,99982 0,00067 

3,58 0,99983 0,00066 0,99983 0,00065 0,99983 0,00065 0,99983 0,00065 0,99983 0,00065 

3,59 0,99983 0,00063 0,99984 0,00063 0,99984 0,00063 0,99984 0,00063 0,99984 0,00063 

3,60 0,99984 0,00061 0,99984 0,00061 0,99984 0,00061 0,99984 0,00061 0,99984 0,00060 

3,61 0,99985 0,00059 0,99985 0,00059 0,99985 0,00059 0,99985 0,00058 0,99985 0,00058 

3,62 0,99985 0,00057 0,99985 0,00057 0,99985 0,00057 0,99985 0,00056 0,99985 0,00056 

3,63 0,99986 0,00055 0,99986 0,00055 0,99986 0,00054 0,99986 0,00054 0,99986 0,00054 

3,64 0,99986 0,00053 0,99986 0,00053 0,99986 0,00053 0,99987 0,00052 0,99987 0,00052 

3,65 0,99987 0,00051 0,99987 0,00051 0,99987 0,00051 0,99987 0,00050 0,99987 0,00050 

3,66 0,99987 0,00049 0,99987 0,00049 0,99987 0,00049 0,99988 0,00049 0,99988 0,00048 

3,67 0,99988 0,00047 0,99988 0,00047 0,99988 0,00047 0,99988 0,00047 0,99988 0,00047 

3,68 0,99988 0,00046 0,99988 0,00046 0,99988 0,00045 0,99988 0,00045 0,99989 0,00045 

3,69 0,99989 0,00044 0,99989 0,00044 0,99989 0,00044 0,99989 0,00044 0,99989 0,00043 

3,70 0,99989 0,00042 0,99989 0,00042 0,99989 0,00042 0,99989 0,00042 0,99989 0,00042 

3,71 0,99990 0,00041 0,99990 0,00041 0,99990 0,00041 0,99990 0,00040 0,99990 0,00040 

3,72 0,99990 0,00039 0,99990 0,00039 0,99990 0,00039 0,99990 0,00039 0,99990 0,00039 

3,73 0,99990 0,00038 0,99990 0,00038 0,99991 0,00038 0,99991 0,00038 0,99991 0,00037 

3,74 0,99991 0,00037 0,99991 0,00036 0,99991 0,00036 0,99991 0,00036 0,99991 0,00036 

3,75 0,99991 0,00035 0,99991 0,00035 0,99991 0,00035 0,99991 0,00035 0,99991 0,00035 

3,76 0,99992 0,00034 0,99992 0,00034 0,99992 0,00034 0,99992 0,00034 0,99992 0,00033 

3,77 0,99992 0,00033 0,99992 0,00033 0,99992 0,00032 0,99992 0,00032 0,99992 0,00032 

3,78 0,99992 0,00031 0,99992 0,00031 0,99992 0,00031 0,99992 0,00031 0,99992 0,00031 

3,79 0,99992 0,00030 0,99992 0,00030 0,99993 0,00030 0,99993 0,00030 0,99993 0,00030 

3,80 0,99993 0,00029 0,99993 0,00029 0,99993 0,00029 0,99993 0,00029 0,99993 0,00029 

3,81 0,99993 0,00028 0,99993 0,00028 0,99993 0,00028 0,99993 0,00028 0,99993 0,00028 

3,82 0,99993 0,00027 0,99993 0,00027 0,99993 0,00027 0,99993 0,00027 0,99993 0,00027 

3,83 0,99994 0,00026 0,99994 0,00026 0,99994 0,00026 0,99994 0,00026 0,99994 0,00026 

3,84 0,99994 0,00025 0,99994 0,00025 0,99994 0,00025 0,99994 0,00025 0,99994 0,00025 

3,85 0,99994 0,00024 0,99994 0,00024 0,99994 0,00024 0,99994 0,00024 0,99994 0,00024 

3,86 0,99994 0,00023 0,99994 0,00023 0,99994 0,00023 0,99994 0,00023 0,99994 0,00023 

3,87 0,99995 0,00022 0,99995 0,00022 0,99995 0,00022 0,99995 0,00022 0,99995 0,00022 

3,88 0,99995 0,00021 0,99995 0,00021 0,99995 0,00021 0,99995 0,00021 0,99995 0,00021 

3,89 0,99995 0,00021 0,99995 0,00021 0,99995 0,00020 0,99995 0,00020 0,99995 0,00020 

3,90 0,99995 0,00020 0,99995 0,00020 0,99995 0,00020 0,99995 0,00020 0,99995 0,00020 

3,91 0,99995 0,00019 0,99995 0,00019 0,99995 0,00019 0,99995 0,00019 0,99995 0,00019 

3,92 0,99996 0,00018 0,99996 0,00018 0,99996 0,00018 0,99996 0,00018 0,99996 0,00018 

3,93 0,99996 0,00018 0,99996 0,00018 0,99996 0,00018 0,99996 0,00017 0,99996 0,00017 

3,94 0,99996 0,00017 0,99996 0,00017 0,99996 0,00017 0,99996 0,00017 0,99996 0,00017 

3,95 0,99996 0,00016 0,99996 0,00016 0,99996 0,00016 0,99996 0,00016 0,99996 0,00016 

3,96 0,99996 0,00016 0,99996 0,00016 0,99996 0,00016 0,99996 0,00016 0,99996 0,00015 
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3,97 0,99996 0,00015 0,99996 0,00015 0,99996 0,00015 0,99996 0,00015 0,99996 0,00015 

3,98 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 

3,99 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 
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0,00 0,50199 0,39886 0,50239 0,39885 0,50279 0,39885 0,50319 0,39885 0,50359 0,39885 

0,01 0,50598 0,39882 0,50638 0,39881 0,50678 0,39880 0,50718 0,39880 0,50758 0,39879 

0,02 0,50997 0,39874 0,51037 0,39873 0,51077 0,39872 0,51117 0,39871 0,51157 0,39869 

0,03 0,51396 0,39862 0,51436 0,39860 0,51476 0,39859 0,51516 0,39857 0,51555 0,39856 

0,04 0,51795 0,39846 0,51834 0,39844 0,51874 0,39842 0,51914 0,39840 0,51954 0,39838 

0,05 0,52193 0,39826 0,52233 0,39824 0,52273 0,39821 0,52313 0,39819 0,52352 0,39817 

0,06 0,52591 0,39802 0,52631 0,39799 0,52671 0,39797 0,52711 0,39794 0,52751 0,39791 

0,07 0,52989 0,39774 0,53029 0,39771 0,53069 0,39768 0,53109 0,39765 0,53148 0,39762 

0,08 0,53387 0,39742 0,53427 0,39739 0,53466 0,39736 0,53506 0,39732 0,53546 0,39729 

0,09 0,53784 0,39707 0,53824 0,39703 0,53864 0,39699 0,53903 0,39695 0,53943 0,39691 

0,10 0,54181 0,39667 0,54221 0,39663 0,54261 0,39659 0,54300 0,39654 0,54340 0,39650 

0,11 0,54578 0,39623 0,54617 0,39619 0,54657 0,39614 0,54697 0,39609 0,54736 0,39605 

0,12 0,54974 0,39576 0,55013 0,39571 0,55053 0,39566 0,55093 0,39561 0,55132 0,39556 

0,13 0,55369 0,39524 0,55409 0,39519 0,55448 0,39514 0,55488 0,39508 0,55527 0,39503 

0,14 0,55764 0,39469 0,55804 0,39463 0,55843 0,39458 0,55883 0,39452 0,55922 0,39446 

0,15 0,56159 0,39410 0,56198 0,39404 0,56238 0,39398 0,56277 0,39391 0,56317 0,39385 

0,16 0,56553 0,39347 0,56592 0,39340 0,56631 0,39334 0,56671 0,39327 0,56710 0,39321 

0,17 0,56946 0,39280 0,56985 0,39273 0,57025 0,39266 0,57064 0,39259 0,57103 0,39252 

0,18 0,57339 0,39209 0,57378 0,39202 0,57417 0,39195 0,57456 0,39188 0,57495 0,39180 

0,19 0,57730 0,39135 0,57769 0,39127 0,57809 0,39120 0,57848 0,39112 0,57887 0,39104 

0,20 0,58121 0,39057 0,58160 0,39049 0,58200 0,39041 0,58239 0,39033 0,58278 0,39025 

0,21 0,58512 0,38975 0,58551 0,38967 0,58590 0,38958 0,58629 0,38950 0,58667 0,38941 

0,22 0,58901 0,38889 0,58940 0,38880 0,58979 0,38872 0,59018 0,38863 0,59057 0,38854 

0,23 0,59290 0,38800 0,59328 0,38791 0,59367 0,38782 0,59406 0,38772 0,59445 0,38763 

0,24 0,59677 0,38707 0,59716 0,38697 0,59755 0,38688 0,59793 0,38678 0,59832 0,38669 

0,25 0,60064 0,38610 0,60102 0,38600 0,60141 0,38590 0,60180 0,38581 0,60218 0,38571 

0,26 0,60450 0,38510 0,60488 0,38500 0,60527 0,38490 0,60565 0,38479 0,60604 0,38469 

0,27 0,60834 0,38406 0,60873 0,38396 0,60911 0,38385 0,60949 0,38374 0,60988 0,38364 

0,28 0,61218 0,38299 0,61256 0,38288 0,61294 0,38277 0,61333 0,38266 0,61371 0,38255 

0,29 0,61600 0,38188 0,61638 0,38177 0,61677 0,38165 0,61715 0,38154 0,61753 0,38143 

0,30 0,61982 0,38073 0,62020 0,38062 0,62058 0,38050 0,62096 0,38038 0,62134 0,38027 

0,31 0,62362 0,37956 0,62400 0,37944 0,62438 0,37932 0,62476 0,37920 0,62514 0,37908 

0,32 0,62741 0,37834 0,62779 0,37822 0,62817 0,37810 0,62854 0,37797 0,62892 0,37785 

0,33 0,63119 0,37710 0,63156 0,37697 0,63194 0,37684 0,63232 0,37672 0,63270 0,37659 

0,34 0,63495 0,37582 0,63533 0,37569 0,63570 0,37556 0,63608 0,37543 0,63646 0,37530 

0,35 0,63871 0,37450 0,63908 0,37437 0,63945 0,37424 0,63983 0,37410 0,64020 0,37397 

0,36 0,64244 0,37316 0,64282 0,37302 0,64319 0,37289 0,64356 0,37275 0,64394 0,37261 

0,37 0,64617 0,37178 0,64654 0,37164 0,64691 0,37150 0,64728 0,37136 0,64766 0,37122 

0,38 0,64988 0,37037 0,65025 0,37023 0,65062 0,37008 0,65099 0,36994 0,65136 0,36980 

0,39 0,65358 0,36893 0,65395 0,36878 0,65432 0,36864 0,65468 0,36849 0,65505 0,36834 

0,40 0,65726 0,36746 0,65763 0,36731 0,65800 0,36716 0,65836 0,36701 0,65873 0,36686 

0,41 0,66093 0,36595 0,66129 0,36580 0,66166 0,36565 0,66203 0,36550 0,66239 0,36534 
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0,42 0,66458 0,36442 0,66495 0,36426 0,66531 0,36411 0,66567 0,36395 0,66604 0,36380 

0,43 0,66822 0,36285 0,66858 0,36270 0,66894 0,36254 0,66931 0,36238 0,66967 0,36222 

0,44 0,67184 0,36126 0,67220 0,36110 0,67256 0,36094 0,67292 0,36078 0,67328 0,36062 

0,45 0,67545 0,35964 0,67581 0,35948 0,67616 0,35931 0,67652 0,35915 0,67688 0,35898 

0,46 0,67903 0,35799 0,67939 0,35782 0,67975 0,35766 0,68011 0,35749 0,68047 0,35732 

0,47 0,68261 0,35631 0,68296 0,35614 0,68332 0,35597 0,68367 0,35580 0,68403 0,35563 

0,48 0,68616 0,35460 0,68652 0,35443 0,68687 0,35426 0,68723 0,35409 0,68758 0,35391 

0,49 0,68970 0,35287 0,69005 0,35270 0,69041 0,35252 0,69076 0,35235 0,69111 0,35217 

0,50 0,69322 0,35111 0,69357 0,35093 0,69392 0,35076 0,69427 0,35058 0,69462 0,35040 

0,51 0,69672 0,34933 0,69707 0,34915 0,69742 0,34896 0,69777 0,34878 0,69812 0,34860 

0,52 0,70021 0,34751 0,70056 0,34733 0,70090 0,34715 0,70125 0,34696 0,70160 0,34678 

0,53 0,70368 0,34568 0,70402 0,34549 0,70437 0,34531 0,70471 0,34512 0,70506 0,34493 

0,54 0,70712 0,34381 0,70747 0,34363 0,70781 0,34344 0,70815 0,34325 0,70850 0,34306 

0,55 0,71055 0,34193 0,71089 0,34174 0,71124 0,34155 0,71158 0,34136 0,71192 0,34117 

0,56 0,71396 0,34002 0,71430 0,33983 0,71464 0,33963 0,71498 0,33944 0,71532 0,33925 

0,57 0,71735 0,33809 0,71769 0,33789 0,71803 0,33770 0,71837 0,33750 0,71871 0,33731 

0,58 0,72073 0,33613 0,72106 0,33593 0,72140 0,33574 0,72173 0,33554 0,72207 0,33534 

0,59 0,72408 0,33415 0,72441 0,33396 0,72475 0,33376 0,72508 0,33356 0,72541 0,33336 

0,60 0,72741 0,33216 0,72774 0,33195 0,72807 0,33175 0,72841 0,33155 0,72874 0,33135 

0,61 0,73072 0,33014 0,73105 0,32993 0,73138 0,32973 0,73171 0,32953 0,73204 0,32932 

0,62 0,73401 0,32809 0,73434 0,32789 0,73467 0,32768 0,73500 0,32748 0,73533 0,32727 

0,63 0,73729 0,32603 0,73761 0,32583 0,73794 0,32562 0,73826 0,32541 0,73859 0,32520 

0,64 0,74054 0,32395 0,74086 0,32375 0,74118 0,32354 0,74151 0,32333 0,74183 0,32312 

0,65 0,74377 0,32186 0,74409 0,32164 0,74441 0,32143 0,74473 0,32122 0,74505 0,32101 

0,66 0,74697 0,31974 0,74729 0,31953 0,74761 0,31931 0,74793 0,31910 0,74825 0,31889 

0,67 0,75016 0,31760 0,75048 0,31739 0,75080 0,31717 0,75111 0,31696 0,75143 0,31674 

0,68 0,75333 0,31545 0,75364 0,31523 0,75396 0,31502 0,75427 0,31480 0,75459 0,31459 

0,69 0,75647 0,31328 0,75679 0,31306 0,75710 0,31285 0,75741 0,31263 0,75772 0,31241 

0,70 0,75959 0,31110 0,75991 0,31088 0,76022 0,31066 0,76053 0,31044 0,76084 0,31022 

0,71 0,76270 0,30890 0,76300 0,30867 0,76331 0,30845 0,76362 0,30823 0,76393 0,30801 

0,72 0,76577 0,30668 0,76608 0,30646 0,76639 0,30623 0,76669 0,30601 0,76700 0,30579 

0,73 0,76883 0,30445 0,76913 0,30422 0,76944 0,30400 0,76974 0,30378 0,77005 0,30355 

0,74 0,77186 0,30220 0,77217 0,30198 0,77247 0,30175 0,77277 0,30153 0,77307 0,30130 

0,75 0,77488 0,29995 0,77518 0,29972 0,77548 0,29949 0,77577 0,29927 0,77607 0,29904 

0,76 0,77786 0,29768 0,77816 0,29745 0,77846 0,29722 0,77876 0,29699 0,77905 0,29676 

0,77 0,78083 0,29539 0,78113 0,29516 0,78142 0,29493 0,78172 0,29470 0,78201 0,29448 

0,78 0,78377 0,29310 0,78407 0,29287 0,78436 0,29264 0,78465 0,29241 0,78494 0,29218 

0,79 0,78669 0,29079 0,78698 0,29056 0,78727 0,29033 0,78756 0,29010 0,78785 0,28986 

0,80 0,78959 0,28847 0,78988 0,28824 0,79017 0,28801 0,79045 0,28778 0,79074 0,28754 

0,81 0,79246 0,28615 0,79275 0,28591 0,79304 0,28568 0,79332 0,28545 0,79361 0,28521 

0,82 0,79531 0,28381 0,79560 0,28358 0,79588 0,28334 0,79616 0,28311 0,79645 0,28287 

0,83 0,79814 0,28146 0,79842 0,28123 0,79870 0,28099 0,79898 0,28076 0,79927 0,28052 

0,84 0,80094 0,27911 0,80122 0,27887 0,80150 0,27864 0,80178 0,27840 0,80206 0,27817 

0,85 0,80372 0,27675 0,80400 0,27651 0,80428 0,27627 0,80455 0,27604 0,80483 0,27580 

0,86 0,80648 0,27438 0,80675 0,27414 0,80703 0,27390 0,80730 0,27366 0,80758 0,27343 

0,87 0,80921 0,27200 0,80948 0,27176 0,80976 0,27152 0,81003 0,27129 0,81030 0,27105 

0,88 0,81192 0,26962 0,81219 0,26938 0,81246 0,26914 0,81273 0,26890 0,81300 0,26866 

0,89 0,81461 0,26723 0,81487 0,26699 0,81514 0,26675 0,81541 0,26651 0,81567 0,26627 

0,90 0,81727 0,26483 0,81753 0,26459 0,81780 0,26435 0,81806 0,26411 0,81832 0,26387 

0,91 0,81990 0,26243 0,82017 0,26219 0,82043 0,26195 0,82069 0,26171 0,82095 0,26147 
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0,92 0,82252 0,26003 0,82278 0,25979 0,82304 0,25955 0,82330 0,25931 0,82356 0,25907 

0,93 0,82511 0,25762 0,82536 0,25738 0,82562 0,25714 0,82588 0,25690 0,82613 0,25666 

0,94 0,82767 0,25521 0,82793 0,25497 0,82818 0,25473 0,82844 0,25449 0,82869 0,25425 

0,95 0,83021 0,25280 0,83046 0,25256 0,83072 0,25232 0,83097 0,25208 0,83122 0,25184 

0,96 0,83273 0,25039 0,83298 0,25014 0,83323 0,24990 0,83348 0,24966 0,83373 0,24942 

0,97 0,83522 0,24797 0,83547 0,24773 0,83572 0,24749 0,83596 0,24724 0,83621 0,24700 

0,98 0,83769 0,24555 0,83793 0,24531 0,83818 0,24507 0,83842 0,24482 0,83867 0,24458 

0,99 0,84013 0,24313 0,84037 0,24289 0,84062 0,24265 0,84086 0,24241 0,84110 0,24216 

1,00 0,84255 0,24071 0,84279 0,24047 0,84303 0,24023 0,84327 0,23999 0,84351 0,23974 

1,01 0,84495 0,23829 0,84519 0,23805 0,84542 0,23781 0,84566 0,23757 0,84590 0,23733 

1,02 0,84732 0,23588 0,84755 0,23563 0,84779 0,23539 0,84803 0,23515 0,84826 0,23491 

1,03 0,84967 0,23346 0,84990 0,23322 0,85013 0,23297 0,85036 0,23273 0,85060 0,23249 

1,04 0,85199 0,23104 0,85222 0,23080 0,85245 0,23056 0,85268 0,23032 0,85291 0,23008 

1,05 0,85429 0,22863 0,85452 0,22839 0,85474 0,22815 0,85497 0,22791 0,85520 0,22766 

1,06 0,85656 0,22622 0,85679 0,22598 0,85701 0,22574 0,85724 0,22550 0,85747 0,22526 

1,07 0,85881 0,22381 0,85904 0,22357 0,85926 0,22333 0,85948 0,22309 0,85971 0,22285 

1,08 0,86104 0,22141 0,86126 0,22117 0,86148 0,22093 0,86170 0,22069 0,86192 0,22045 

1,09 0,86324 0,21901 0,86346 0,21877 0,86368 0,21853 0,86390 0,21829 0,86412 0,21805 

1,10 0,86542 0,21661 0,86564 0,21637 0,86585 0,21613 0,86607 0,21589 0,86628 0,21565 

1,11 0,86757 0,21422 0,86779 0,21398 0,86800 0,21374 0,86822 0,21350 0,86843 0,21326 

1,12 0,86971 0,21183 0,86992 0,21160 0,87013 0,21136 0,87034 0,21112 0,87055 0,21088 

1,13 0,87181 0,20945 0,87202 0,20922 0,87223 0,20898 0,87244 0,20874 0,87265 0,20850 

1,14 0,87390 0,20708 0,87410 0,20684 0,87431 0,20661 0,87452 0,20637 0,87472 0,20613 

1,15 0,87595 0,20471 0,87616 0,20448 0,87636 0,20424 0,87657 0,20400 0,87677 0,20377 

1,16 0,87799 0,20235 0,87819 0,20212 0,87839 0,20188 0,87860 0,20164 0,87880 0,20141 

1,17 0,88000 0,20000 0,88020 0,19976 0,88040 0,19953 0,88060 0,19929 0,88080 0,19906 

1,18 0,88199 0,19765 0,88219 0,19742 0,88239 0,19718 0,88258 0,19695 0,88278 0,19671 

1,19 0,88396 0,19531 0,88415 0,19508 0,88435 0,19485 0,88454 0,19461 0,88474 0,19438 

1,20 0,88590 0,19298 0,88609 0,19275 0,88628 0,19252 0,88648 0,19229 0,88667 0,19205 

1,21 0,88782 0,19066 0,88801 0,19043 0,88820 0,19020 0,88839 0,18997 0,88858 0,18974 

1,22 0,88971 0,18835 0,88990 0,18812 0,89009 0,18789 0,89028 0,18766 0,89046 0,18743 

1,23 0,89158 0,18605 0,89177 0,18582 0,89196 0,18559 0,89214 0,18536 0,89233 0,18513 

1,24 0,89343 0,18375 0,89362 0,18353 0,89380 0,18330 0,89398 0,18307 0,89417 0,18284 

1,25 0,89526 0,18147 0,89544 0,18124 0,89562 0,18102 0,89580 0,18079 0,89598 0,18056 

1,26 0,89706 0,17920 0,89724 0,17897 0,89742 0,17875 0,89760 0,17852 0,89778 0,17829 

1,27 0,89885 0,17694 0,89902 0,17671 0,89920 0,17649 0,89938 0,17626 0,89955 0,17604 

1,28 0,90060 0,17469 0,90078 0,17446 0,90095 0,17424 0,90113 0,17402 0,90130 0,17379 

1,29 0,90234 0,17245 0,90251 0,17223 0,90268 0,17200 0,90286 0,17178 0,90303 0,17156 

1,30 0,90405 0,17022 0,90422 0,17000 0,90439 0,16978 0,90456 0,16956 0,90473 0,16933 

1,31 0,90575 0,16801 0,90591 0,16779 0,90608 0,16756 0,90625 0,16734 0,90642 0,16712 

1,32 0,90741 0,16580 0,90758 0,16558 0,90775 0,16536 0,90791 0,16514 0,90808 0,16493 

1,33 0,90906 0,16361 0,90923 0,16339 0,90939 0,16318 0,90955 0,16296 0,90971 0,16274 

1,34 0,91069 0,16144 0,91085 0,16122 0,91101 0,16100 0,91117 0,16078 0,91133 0,16057 

1,35 0,91229 0,15927 0,91245 0,15905 0,91261 0,15884 0,91277 0,15862 0,91293 0,15841 

1,36 0,91387 0,15712 0,91403 0,15690 0,91419 0,15669 0,91434 0,15648 0,91450 0,15626 

1,37 0,91543 0,15498 0,91559 0,15477 0,91574 0,15456 0,91590 0,15434 0,91605 0,15413 

1,38 0,91697 0,15286 0,91713 0,15265 0,91728 0,15243 0,91743 0,15222 0,91758 0,15201 

1,39 0,91849 0,15075 0,91864 0,15054 0,91879 0,15033 0,91894 0,15012 0,91909 0,14991 

1,40 0,91999 0,14865 0,92014 0,14844 0,92029 0,14823 0,92043 0,14803 0,92058 0,14782 

1,41 0,92147 0,14657 0,92161 0,14636 0,92176 0,14616 0,92190 0,14595 0,92205 0,14574 



LAMPIRAN 

227 

Z 
,005 ,006 ,007 ,008 ,009 

Luas Ordinat Luas Ordinat Luas Ordinat Luas Ordinat Luas Ordinat 

1,42 0,92292 0,14450 0,92307 0,14430 0,92321 0,14409 0,92335 0,14389 0,92350 0,14368 

1,43 0,92436 0,14245 0,92450 0,14225 0,92464 0,14204 0,92478 0,14184 0,92492 0,14164 

1,44 0,92577 0,14042 0,92591 0,14021 0,92605 0,14001 0,92619 0,13981 0,92633 0,13960 

1,45 0,92717 0,13839 0,92730 0,13819 0,92744 0,13799 0,92758 0,13779 0,92772 0,13759 

1,46 0,92854 0,13639 0,92868 0,13619 0,92881 0,13599 0,92895 0,13579 0,92908 0,13559 

1,47 0,92989 0,13440 0,93003 0,13420 0,93016 0,13400 0,93030 0,13380 0,93043 0,13361 

1,48 0,93123 0,13242 0,93136 0,13223 0,93149 0,13203 0,93162 0,13183 0,93176 0,13164 

1,49 0,93254 0,13046 0,93267 0,13027 0,93280 0,13007 0,93293 0,12988 0,93306 0,12969 

1,50 0,93384 0,12852 0,93397 0,12833 0,93409 0,12814 0,93422 0,12794 0,93435 0,12775 

1,51 0,93511 0,12660 0,93524 0,12640 0,93537 0,12621 0,93549 0,12602 0,93562 0,12583 

1,52 0,93637 0,12469 0,93650 0,12450 0,93662 0,12431 0,93674 0,12412 0,93687 0,12393 

1,53 0,93761 0,12279 0,93773 0,12260 0,93785 0,12242 0,93798 0,12223 0,93810 0,12204 

1,54 0,93883 0,12092 0,93895 0,12073 0,93907 0,12054 0,93919 0,12036 0,93931 0,12017 

1,55 0,94003 0,11906 0,94015 0,11887 0,94026 0,11869 0,94038 0,11850 0,94050 0,11832 

1,56 0,94121 0,11721 0,94133 0,11703 0,94144 0,11685 0,94156 0,11666 0,94168 0,11648 

1,57 0,94237 0,11539 0,94249 0,11521 0,94260 0,11503 0,94272 0,11484 0,94283 0,11466 

1,58 0,94352 0,11358 0,94363 0,11340 0,94374 0,11322 0,94386 0,11304 0,94397 0,11286 

1,59 0,94464 0,11179 0,94476 0,11161 0,94487 0,11143 0,94498 0,11125 0,94509 0,11108 

1,60 0,94575 0,11001 0,94586 0,10984 0,94597 0,10966 0,94608 0,10948 0,94619 0,10931 

1,61 0,94684 0,10826 0,94695 0,10808 0,94706 0,10791 0,94717 0,10773 0,94728 0,10756 

1,62 0,94792 0,10652 0,94803 0,10634 0,94813 0,10617 0,94824 0,10600 0,94834 0,10583 

1,63 0,94898 0,10479 0,94908 0,10462 0,94918 0,10445 0,94929 0,10428 0,94939 0,10411 

1,64 0,95002 0,10309 0,95012 0,10292 0,95022 0,10275 0,95032 0,10258 0,95043 0,10241 

1,65 0,95104 0,10140 0,95114 0,10124 0,95124 0,10107 0,95134 0,10090 0,95144 0,10073 

1,66 0,95204 0,09973 0,95214 0,09957 0,95224 0,09940 0,95234 0,09924 0,95244 0,09907 

1,67 0,95303 0,09808 0,95313 0,09792 0,95323 0,09775 0,95333 0,09759 0,95342 0,09743 

1,68 0,95401 0,09645 0,95410 0,09629 0,95420 0,09612 0,95429 0,09596 0,95439 0,09580 

1,69 0,95496 0,09483 0,95506 0,09467 0,95515 0,09451 0,95525 0,09435 0,95534 0,09419 

1,70 0,95590 0,09323 0,95600 0,09307 0,95609 0,09292 0,95618 0,09276 0,95627 0,09260 

1,71 0,95683 0,09165 0,95692 0,09150 0,95701 0,09134 0,95710 0,09118 0,95719 0,09103 

1,72 0,95774 0,09009 0,95783 0,08993 0,95792 0,08978 0,95801 0,08962 0,95810 0,08947 

1,73 0,95863 0,08854 0,95872 0,08839 0,95881 0,08824 0,95889 0,08808 0,95898 0,08793 

1,74 0,95951 0,08702 0,95959 0,08687 0,95968 0,08671 0,95977 0,08656 0,95985 0,08641 

1,75 0,96037 0,08551 0,96046 0,08536 0,96054 0,08521 0,96063 0,08506 0,96071 0,08491 

1,76 0,96122 0,08402 0,96130 0,08387 0,96139 0,08372 0,96147 0,08357 0,96155 0,08342 

1,77 0,96205 0,08254 0,96213 0,08240 0,96222 0,08225 0,96230 0,08210 0,96238 0,08196 

1,78 0,96287 0,08109 0,96295 0,08094 0,96303 0,08080 0,96311 0,08065 0,96319 0,08051 

1,79 0,96367 0,07965 0,96375 0,07950 0,96383 0,07936 0,96391 0,07922 0,96399 0,07908 

1,80 0,96446 0,07823 0,96454 0,07808 0,96462 0,07794 0,96470 0,07780 0,96477 0,07766 

1,81 0,96524 0,07682 0,96531 0,07668 0,96539 0,07654 0,96547 0,07641 0,96554 0,07627 

1,82 0,96600 0,07544 0,96607 0,07530 0,96615 0,07516 0,96623 0,07503 0,96630 0,07489 

1,83 0,96675 0,07407 0,96682 0,07393 0,96690 0,07380 0,96697 0,07366 0,96704 0,07353 

1,84 0,96748 0,07272 0,96755 0,07258 0,96763 0,07245 0,96770 0,07232 0,96777 0,07218 

1,85 0,96820 0,07139 0,96827 0,07125 0,96834 0,07112 0,96842 0,07099 0,96849 0,07086 

1,86 0,96891 0,07007 0,96898 0,06994 0,96905 0,06981 0,96912 0,06968 0,96919 0,06955 

1,87 0,96960 0,06877 0,96967 0,06864 0,96974 0,06851 0,96981 0,06839 0,96988 0,06826 

1,88 0,97029 0,06749 0,97035 0,06736 0,97042 0,06724 0,97049 0,06711 0,97055 0,06698 

1,89 0,97095 0,06623 0,97102 0,06610 0,97109 0,06598 0,97115 0,06585 0,97122 0,06573 

1,90 0,97161 0,06498 0,97167 0,06486 0,97174 0,06473 0,97180 0,06461 0,97187 0,06449 

1,91 0,97225 0,06375 0,97232 0,06363 0,97238 0,06351 0,97244 0,06339 0,97251 0,06327 
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1,92 0,97289 0,06254 0,97295 0,06242 0,97301 0,06230 0,97307 0,06218 0,97313 0,06206 

1,93 0,97350 0,06134 0,97357 0,06123 0,97363 0,06111 0,97369 0,06099 0,97375 0,06087 

1,94 0,97411 0,06017 0,97417 0,06005 0,97423 0,05993 0,97429 0,05982 0,97435 0,05970 

1,95 0,97471 0,05900 0,97477 0,05889 0,97483 0,05877 0,97488 0,05866 0,97494 0,05854 

1,96 0,97529 0,05786 0,97535 0,05775 0,97541 0,05763 0,97547 0,05752 0,97552 0,05741 

1,97 0,97587 0,05673 0,97592 0,05662 0,97598 0,05651 0,97604 0,05639 0,97609 0,05628 

1,98 0,97643 0,05562 0,97648 0,05551 0,97654 0,05540 0,97659 0,05529 0,97665 0,05518 

1,99 0,97698 0,05452 0,97703 0,05441 0,97709 0,05430 0,97714 0,05420 0,97720 0,05409 

2,00 0,97752 0,05344 0,97757 0,05334 0,97763 0,05323 0,97768 0,05312 0,97773 0,05302 

2,01 0,97805 0,05238 0,97810 0,05227 0,97815 0,05217 0,97820 0,05206 0,97826 0,05196 

2,02 0,97857 0,05133 0,97862 0,05123 0,97867 0,05112 0,97872 0,05102 0,97877 0,05092 

2,03 0,97907 0,05030 0,97912 0,05020 0,97917 0,05010 0,97923 0,04999 0,97927 0,04989 

2,04 0,97957 0,04928 0,97962 0,04918 0,97967 0,04908 0,97972 0,04898 0,97977 0,04888 

2,05 0,98006 0,04828 0,98011 0,04818 0,98016 0,04809 0,98020 0,04799 0,98025 0,04789 

2,06 0,98054 0,04730 0,98059 0,04720 0,98063 0,04710 0,98068 0,04701 0,98073 0,04691 

2,07 0,98101 0,04633 0,98105 0,04623 0,98110 0,04614 0,98115 0,04604 0,98119 0,04595 

2,08 0,98147 0,04538 0,98151 0,04528 0,98156 0,04519 0,98160 0,04509 0,98165 0,04500 

2,09 0,98191 0,04444 0,98196 0,04435 0,98200 0,04425 0,98205 0,04416 0,98209 0,04407 

2,10 0,98235 0,04351 0,98240 0,04342 0,98244 0,04333 0,98248 0,04324 0,98253 0,04315 

2,11 0,98279 0,04261 0,98283 0,04252 0,98287 0,04243 0,98291 0,04234 0,98295 0,04225 

2,12 0,98321 0,04171 0,98325 0,04162 0,98329 0,04154 0,98333 0,04145 0,98337 0,04136 

2,13 0,98362 0,04083 0,98366 0,04075 0,98370 0,04066 0,98374 0,04057 0,98378 0,04049 

2,14 0,98402 0,03997 0,98406 0,03988 0,98410 0,03980 0,98414 0,03971 0,98418 0,03963 

2,15 0,98442 0,03912 0,98446 0,03903 0,98450 0,03895 0,98454 0,03887 0,98457 0,03878 

2,16 0,98481 0,03828 0,98484 0,03820 0,98488 0,03812 0,98492 0,03803 0,98496 0,03795 

2,17 0,98518 0,03746 0,98522 0,03738 0,98526 0,03730 0,98530 0,03722 0,98533 0,03714 

2,18 0,98556 0,03665 0,98559 0,03657 0,98563 0,03649 0,98567 0,03641 0,98570 0,03633 

2,19 0,98592 0,03586 0,98595 0,03578 0,98599 0,03570 0,98603 0,03562 0,98606 0,03555 

2,20 0,98627 0,03508 0,98631 0,03500 0,98634 0,03492 0,98638 0,03485 0,98641 0,03477 

2,21 0,98662 0,03431 0,98665 0,03424 0,98669 0,03416 0,98672 0,03408 0,98676 0,03401 

2,22 0,98696 0,03356 0,98699 0,03348 0,98703 0,03341 0,98706 0,03334 0,98709 0,03326 

2,23 0,98729 0,03282 0,98732 0,03275 0,98736 0,03267 0,98739 0,03260 0,98742 0,03253 

2,24 0,98762 0,03209 0,98765 0,03202 0,98768 0,03195 0,98771 0,03188 0,98774 0,03180 

2,25 0,98793 0,03138 0,98796 0,03131 0,98800 0,03124 0,98803 0,03117 0,98806 0,03110 

2,26 0,98824 0,03068 0,98827 0,03061 0,98830 0,03054 0,98834 0,03047 0,98837 0,03040 

2,27 0,98855 0,02999 0,98858 0,02992 0,98861 0,02985 0,98864 0,02978 0,98867 0,02972 

2,28 0,98884 0,02931 0,98887 0,02925 0,98890 0,02918 0,98893 0,02911 0,98896 0,02905 

2,29 0,98913 0,02865 0,98916 0,02858 0,98919 0,02852 0,98922 0,02845 0,98925 0,02839 

2,30 0,98942 0,02800 0,98944 0,02793 0,98947 0,02787 0,98950 0,02780 0,98953 0,02774 

2,31 0,98969 0,02736 0,98972 0,02729 0,98975 0,02723 0,98978 0,02717 0,98980 0,02711 

2,32 0,98996 0,02673 0,98999 0,02667 0,99002 0,02661 0,99004 0,02654 0,99007 0,02648 

2,33 0,99023 0,02611 0,99025 0,02605 0,99028 0,02599 0,99031 0,02593 0,99033 0,02587 

2,34 0,99049 0,02551 0,99051 0,02545 0,99054 0,02539 0,99056 0,02533 0,99059 0,02527 

2,35 0,99074 0,02492 0,99076 0,02486 0,99079 0,02480 0,99081 0,02474 0,99084 0,02468 

2,36 0,99098 0,02434 0,99101 0,02428 0,99103 0,02422 0,99106 0,02416 0,99108 0,02411 

2,37 0,99123 0,02377 0,99125 0,02371 0,99127 0,02365 0,99130 0,02360 0,99132 0,02354 

2,38 0,99146 0,02321 0,99148 0,02315 0,99151 0,02310 0,99153 0,02304 0,99155 0,02299 

2,39 0,99169 0,02266 0,99171 0,02261 0,99174 0,02255 0,99176 0,02250 0,99178 0,02244 

2,40 0,99191 0,02212 0,99194 0,02207 0,99196 0,02202 0,99198 0,02196 0,99200 0,02191 

2,41 0,99213 0,02160 0,99215 0,02154 0,99218 0,02149 0,99220 0,02144 0,99222 0,02139 
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2,42 0,99235 0,02108 0,99237 0,02103 0,99239 0,02098 0,99241 0,02093 0,99243 0,02088 

2,43 0,99255 0,02057 0,99257 0,02052 0,99260 0,02047 0,99262 0,02042 0,99264 0,02037 

2,44 0,99276 0,02008 0,99278 0,02003 0,99280 0,01998 0,99282 0,01993 0,99284 0,01988 

2,45 0,99296 0,01959 0,99298 0,01954 0,99299 0,01950 0,99301 0,01945 0,99303 0,01940 

2,46 0,99315 0,01912 0,99317 0,01907 0,99319 0,01902 0,99321 0,01897 0,99323 0,01893 

2,47 0,99334 0,01865 0,99336 0,01860 0,99338 0,01856 0,99339 0,01851 0,99341 0,01847 

2,48 0,99352 0,01819 0,99354 0,01815 0,99356 0,01810 0,99358 0,01806 0,99359 0,01801 

2,49 0,99370 0,01774 0,99372 0,01770 0,99374 0,01766 0,99376 0,01761 0,99377 0,01757 

2,50 0,99388 0,01731 0,99389 0,01726 0,99391 0,01722 0,99393 0,01718 0,99395 0,01713 

2,51 0,99405 0,01688 0,99407 0,01684 0,99408 0,01679 0,99410 0,01675 0,99412 0,01671 

2,52 0,99422 0,01646 0,99423 0,01642 0,99425 0,01637 0,99426 0,01633 0,99428 0,01629 

2,53 0,99438 0,01605 0,99439 0,01601 0,99441 0,01597 0,99443 0,01593 0,99444 0,01588 

2,54 0,99454 0,01564 0,99455 0,01560 0,99457 0,01556 0,99458 0,01553 0,99460 0,01549 

2,55 0,99469 0,01525 0,99471 0,01521 0,99472 0,01517 0,99474 0,01513 0,99475 0,01510 

2,56 0,99484 0,01486 0,99486 0,01483 0,99487 0,01479 0,99489 0,01475 0,99490 0,01471 

2,57 0,99499 0,01449 0,99500 0,01445 0,99502 0,01441 0,99503 0,01438 0,99505 0,01434 

2,58 0,99513 0,01412 0,99515 0,01408 0,99516 0,01405 0,99517 0,01401 0,99519 0,01397 

2,59 0,99527 0,01376 0,99528 0,01372 0,99530 0,01369 0,99531 0,01365 0,99533 0,01362 

2,60 0,99541 0,01340 0,99542 0,01337 0,99543 0,01333 0,99545 0,01330 0,99546 0,01327 

2,61 0,99554 0,01306 0,99555 0,01303 0,99556 0,01299 0,99558 0,01296 0,99559 0,01292 

2,62 0,99567 0,01272 0,99568 0,01269 0,99569 0,01265 0,99571 0,01262 0,99572 0,01259 

2,63 0,99579 0,01239 0,99581 0,01236 0,99582 0,01233 0,99583 0,01229 0,99584 0,01226 

2,64 0,99592 0,01207 0,99593 0,01204 0,99594 0,01200 0,99595 0,01197 0,99596 0,01194 

2,65 0,99603 0,01175 0,99605 0,01172 0,99606 0,01169 0,99607 0,01166 0,99608 0,01163 

2,66 0,99615 0,01144 0,99616 0,01141 0,99617 0,01138 0,99618 0,01135 0,99620 0,01132 

2,67 0,99626 0,01114 0,99627 0,01111 0,99629 0,01108 0,99630 0,01105 0,99631 0,01102 

2,68 0,99637 0,01085 0,99638 0,01082 0,99640 0,01079 0,99641 0,01076 0,99642 0,01073 

2,69 0,99648 0,01056 0,99649 0,01053 0,99650 0,01050 0,99651 0,01048 0,99652 0,01045 

2,70 0,99658 0,01028 0,99660 0,01025 0,99661 0,01022 0,99662 0,01020 0,99663 0,01017 

2,71 0,99669 0,01000 0,99670 0,00998 0,99671 0,00995 0,99672 0,00992 0,99673 0,00990 

2,72 0,99678 0,00974 0,99679 0,00971 0,99680 0,00968 0,99681 0,00966 0,99682 0,00963 

2,73 0,99688 0,00947 0,99689 0,00945 0,99690 0,00942 0,99691 0,00940 0,99692 0,00937 

2,74 0,99697 0,00922 0,99698 0,00919 0,99699 0,00917 0,99700 0,00914 0,99701 0,00912 

2,75 0,99707 0,00897 0,99707 0,00894 0,99708 0,00892 0,99709 0,00889 0,99710 0,00887 

2,76 0,99715 0,00872 0,99716 0,00870 0,99717 0,00868 0,99718 0,00865 0,99719 0,00863 

2,77 0,99724 0,00849 0,99725 0,00846 0,99726 0,00844 0,99727 0,00841 0,99727 0,00839 

2,78 0,99732 0,00825 0,99733 0,00823 0,99734 0,00821 0,99735 0,00818 0,99736 0,00816 

2,79 0,99741 0,00803 0,99741 0,00800 0,99742 0,00798 0,99743 0,00796 0,99744 0,00794 

2,80 0,99748 0,00780 0,99749 0,00778 0,99750 0,00776 0,99751 0,00774 0,99752 0,00772 

2,81 0,99756 0,00759 0,99757 0,00757 0,99758 0,00754 0,99758 0,00752 0,99759 0,00750 

2,82 0,99764 0,00738 0,99764 0,00736 0,99765 0,00733 0,99766 0,00731 0,99767 0,00729 

2,83 0,99771 0,00717 0,99772 0,00715 0,99772 0,00713 0,99773 0,00711 0,99774 0,00709 

2,84 0,99778 0,00697 0,99779 0,00695 0,99779 0,00693 0,99780 0,00691 0,99781 0,00689 

2,85 0,99785 0,00677 0,99785 0,00675 0,99786 0,00674 0,99787 0,00672 0,99788 0,00670 

2,86 0,99791 0,00658 0,99792 0,00656 0,99793 0,00655 0,99793 0,00653 0,99794 0,00651 

2,87 0,99798 0,00640 0,99799 0,00638 0,99799 0,00636 0,99800 0,00634 0,99801 0,00632 

2,88 0,99804 0,00622 0,99805 0,00620 0,99806 0,00618 0,99806 0,00616 0,99807 0,00614 

2,89 0,99810 0,00604 0,99811 0,00602 0,99812 0,00600 0,99812 0,00599 0,99813 0,00597 

2,90 0,99816 0,00587 0,99817 0,00585 0,99818 0,00583 0,99818 0,00581 0,99819 0,00580 

2,91 0,99822 0,00570 0,99823 0,00568 0,99823 0,00566 0,99824 0,00565 0,99824 0,00563 
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2,92 0,99828 0,00553 0,99828 0,00552 0,99829 0,00550 0,99829 0,00549 0,99830 0,00547 

2,93 0,99833 0,00537 0,99834 0,00536 0,99834 0,00534 0,99835 0,00533 0,99835 0,00531 

2,94 0,99839 0,00522 0,99839 0,00520 0,99840 0,00519 0,99840 0,00517 0,99841 0,00516 

2,95 0,99844 0,00507 0,99844 0,00505 0,99845 0,00504 0,99845 0,00502 0,99846 0,00501 

2,96 0,99849 0,00492 0,99849 0,00490 0,99850 0,00489 0,99850 0,00487 0,99851 0,00486 

2,97 0,99854 0,00477 0,99854 0,00476 0,99854 0,00475 0,99855 0,00473 0,99855 0,00472 

2,98 0,99858 0,00463 0,99859 0,00462 0,99859 0,00461 0,99860 0,00459 0,99860 0,00458 

2,99 0,99863 0,00450 0,99863 0,00448 0,99864 0,00447 0,99864 0,00446 0,99865 0,00444 

3,00 0,99867 0,00436 0,99868 0,00435 0,99868 0,00434 0,99869 0,00433 0,99869 0,00431 

3,01 0,99872 0,00424 0,99872 0,00422 0,99872 0,00421 0,99873 0,00420 0,99873 0,00418 

3,02 0,99876 0,00411 0,99876 0,00410 0,99877 0,00408 0,99877 0,00407 0,99877 0,00406 

3,03 0,99880 0,00399 0,99880 0,00397 0,99881 0,00396 0,99881 0,00395 0,99881 0,00394 

3,04 0,99884 0,00387 0,99884 0,00386 0,99884 0,00384 0,99885 0,00383 0,99885 0,00382 

3,05 0,99887 0,00375 0,99888 0,00374 0,99888 0,00373 0,99889 0,00372 0,99889 0,00371 

3,06 0,99891 0,00364 0,99892 0,00363 0,99892 0,00362 0,99892 0,00360 0,99893 0,00359 

3,07 0,99895 0,00353 0,99895 0,00352 0,99895 0,00351 0,99896 0,00350 0,99896 0,00349 

3,08 0,99898 0,00342 0,99899 0,00341 0,99899 0,00340 0,99899 0,00339 0,99900 0,00338 

3,09 0,99902 0,00332 0,99902 0,00331 0,99902 0,00330 0,99903 0,00329 0,99903 0,00328 

3,10 0,99905 0,00322 0,99905 0,00321 0,99906 0,00320 0,99906 0,00319 0,99906 0,00318 

3,11 0,99908 0,00312 0,99908 0,00311 0,99909 0,00310 0,99909 0,00309 0,99909 0,00308 

3,12 0,99911 0,00302 0,99911 0,00301 0,99912 0,00300 0,99912 0,00299 0,99912 0,00298 

3,13 0,99914 0,00293 0,99914 0,00292 0,99915 0,00291 0,99915 0,00290 0,99915 0,00289 

3,14 0,99917 0,00284 0,99917 0,00283 0,99918 0,00282 0,99918 0,00281 0,99918 0,00280 

3,15 0,99920 0,00275 0,99920 0,00274 0,99920 0,00273 0,99921 0,00272 0,99921 0,00272 

3,16 0,99922 0,00266 0,99923 0,00266 0,99923 0,00265 0,99923 0,00264 0,99924 0,00263 

3,17 0,99925 0,00258 0,99925 0,00257 0,99926 0,00256 0,99926 0,00256 0,99926 0,00255 

3,18 0,99928 0,00250 0,99928 0,00249 0,99928 0,00248 0,99928 0,00248 0,99929 0,00247 

3,19 0,99930 0,00242 0,99930 0,00241 0,99931 0,00241 0,99931 0,00240 0,99931 0,00239 

3,20 0,99932 0,00235 0,99933 0,00234 0,99933 0,00233 0,99933 0,00232 0,99933 0,00232 

3,21 0,99935 0,00227 0,99935 0,00226 0,99935 0,00226 0,99935 0,00225 0,99936 0,00224 

3,22 0,99937 0,00220 0,99937 0,00219 0,99937 0,00219 0,99938 0,00218 0,99938 0,00217 

3,23 0,99939 0,00213 0,99939 0,00212 0,99940 0,00212 0,99940 0,00211 0,99940 0,00210 

3,24 0,99941 0,00206 0,99941 0,00206 0,99942 0,00205 0,99942 0,00204 0,99942 0,00204 

3,25 0,99943 0,00200 0,99944 0,00199 0,99944 0,00198 0,99944 0,00198 0,99944 0,00197 

3,26 0,99945 0,00193 0,99945 0,00193 0,99946 0,00192 0,99946 0,00191 0,99946 0,00191 

3,27 0,99947 0,00187 0,99947 0,00186 0,99948 0,00186 0,99948 0,00185 0,99948 0,00185 

3,28 0,99949 0,00181 0,99949 0,00180 0,99949 0,00180 0,99950 0,00179 0,99950 0,00179 

3,29 0,99951 0,00175 0,99951 0,00175 0,99951 0,00174 0,99951 0,00173 0,99951 0,00173 

3,30 0,99953 0,00169 0,99953 0,00169 0,99953 0,00168 0,99953 0,00168 0,99953 0,00167 

3,31 0,99954 0,00164 0,99954 0,00163 0,99955 0,00163 0,99955 0,00162 0,99955 0,00162 

3,32 0,99956 0,00159 0,99956 0,00158 0,99956 0,00157 0,99956 0,00157 0,99956 0,00156 

3,33 0,99957 0,00153 0,99958 0,00153 0,99958 0,00152 0,99958 0,00152 0,99958 0,00151 

3,34 0,99959 0,00148 0,99959 0,00148 0,99959 0,00147 0,99959 0,00147 0,99959 0,00146 

3,35 0,99960 0,00143 0,99960 0,00143 0,99961 0,00142 0,99961 0,00142 0,99961 0,00142 

3,36 0,99962 0,00139 0,99962 0,00138 0,99962 0,00138 0,99962 0,00137 0,99962 0,00137 

3,37 0,99963 0,00134 0,99963 0,00134 0,99963 0,00133 0,99963 0,00133 0,99964 0,00132 

3,38 0,99964 0,00130 0,99965 0,00129 0,99965 0,00129 0,99965 0,00128 0,99965 0,00128 

3,39 0,99966 0,00125 0,99966 0,00125 0,99966 0,00124 0,99966 0,00124 0,99966 0,00124 

3,40 0,99967 0,00121 0,99967 0,00121 0,99967 0,00120 0,99967 0,00120 0,99967 0,00119 

3,41 0,99968 0,00117 0,99968 0,00117 0,99968 0,00116 0,99968 0,00116 0,99969 0,00115 
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3,42 0,99969 0,00113 0,99969 0,00113 0,99969 0,00112 0,99970 0,00112 0,99970 0,00112 

3,43 0,99970 0,00109 0,99970 0,00109 0,99971 0,00109 0,99971 0,00108 0,99971 0,00108 

3,44 0,99971 0,00106 0,99972 0,00105 0,99972 0,00105 0,99972 0,00105 0,99972 0,00104 

3,45 0,99972 0,00102 0,99973 0,00102 0,99973 0,00101 0,99973 0,00101 0,99973 0,00101 

3,46 0,99973 0,00099 0,99974 0,00098 0,99974 0,00098 0,99974 0,00098 0,99974 0,00097 

3,47 0,99974 0,00095 0,99975 0,00095 0,99975 0,00095 0,99975 0,00094 0,99975 0,00094 

3,48 0,99975 0,00092 0,99975 0,00092 0,99976 0,00091 0,99976 0,00091 0,99976 0,00091 

3,49 0,99976 0,00089 0,99976 0,00088 0,99976 0,00088 0,99977 0,00088 0,99977 0,00088 

3,50 0,99977 0,00086 0,99977 0,00085 0,99977 0,00085 0,99977 0,00085 0,99978 0,00085 

3,51 0,99978 0,00083 0,99978 0,00082 0,99978 0,00082 0,99978 0,00082 0,99978 0,00082 

3,52 0,99979 0,00080 0,99979 0,00080 0,99979 0,00079 0,99979 0,00079 0,99979 0,00079 

3,53 0,99980 0,00077 0,99980 0,00077 0,99980 0,00077 0,99980 0,00076 0,99980 0,00076 

3,54 0,99980 0,00074 0,99980 0,00074 0,99981 0,00074 0,99981 0,00074 0,99981 0,00073 

3,55 0,99981 0,00072 0,99981 0,00072 0,99981 0,00071 0,99981 0,00071 0,99981 0,00071 

3,56 0,99982 0,00069 0,99982 0,00069 0,99982 0,00069 0,99982 0,00069 0,99982 0,00068 

3,57 0,99982 0,00067 0,99983 0,00067 0,99983 0,00066 0,99983 0,00066 0,99983 0,00066 

3,58 0,99983 0,00065 0,99983 0,00064 0,99983 0,00064 0,99983 0,00064 0,99983 0,00064 

3,59 0,99984 0,00062 0,99984 0,00062 0,99984 0,00062 0,99984 0,00062 0,99984 0,00061 

3,60 0,99984 0,00060 0,99984 0,00060 0,99985 0,00060 0,99985 0,00059 0,99985 0,00059 

3,61 0,99985 0,00058 0,99985 0,00058 0,99985 0,00058 0,99985 0,00057 0,99985 0,00057 

3,62 0,99986 0,00056 0,99986 0,00056 0,99986 0,00055 0,99986 0,00055 0,99986 0,00055 

3,63 0,99986 0,00054 0,99986 0,00054 0,99986 0,00054 0,99986 0,00053 0,99986 0,00053 

3,64 0,99987 0,00052 0,99987 0,00052 0,99987 0,00052 0,99987 0,00051 0,99987 0,00051 

3,65 0,99987 0,00050 0,99987 0,00050 0,99987 0,00050 0,99987 0,00050 0,99987 0,00049 

3,66 0,99988 0,00048 0,99988 0,00048 0,99988 0,00048 0,99988 0,00048 0,99988 0,00048 

3,67 0,99988 0,00047 0,99988 0,00046 0,99988 0,00046 0,99988 0,00046 0,99988 0,00046 

3,68 0,99989 0,00045 0,99989 0,00045 0,99989 0,00045 0,99989 0,00044 0,99989 0,00044 

3,69 0,99989 0,00043 0,99989 0,00043 0,99989 0,00043 0,99989 0,00043 0,99989 0,00043 

3,70 0,99989 0,00042 0,99989 0,00042 0,99990 0,00041 0,99990 0,00041 0,99990 0,00041 

3,71 0,99990 0,00040 0,99990 0,00040 0,99990 0,00040 0,99990 0,00040 0,99990 0,00040 

3,72 0,99990 0,00039 0,99990 0,00039 0,99990 0,00038 0,99990 0,00038 0,99990 0,00038 

3,73 0,99991 0,00037 0,99991 0,00037 0,99991 0,00037 0,99991 0,00037 0,99991 0,00037 

3,74 0,99991 0,00036 0,99991 0,00036 0,99991 0,00036 0,99991 0,00036 0,99991 0,00035 

3,75 0,99991 0,00035 0,99991 0,00034 0,99991 0,00034 0,99991 0,00034 0,99991 0,00034 

3,76 0,99992 0,00033 0,99992 0,00033 0,99992 0,00033 0,99992 0,00033 0,99992 0,00033 

3,77 0,99992 0,00032 0,99992 0,00032 0,99992 0,00032 0,99992 0,00032 0,99992 0,00032 

3,78 0,99992 0,00031 0,99992 0,00031 0,99992 0,00031 0,99992 0,00031 0,99992 0,00030 

3,79 0,99993 0,00030 0,99993 0,00030 0,99993 0,00030 0,99993 0,00029 0,99993 0,00029 

3,80 0,99993 0,00029 0,99993 0,00029 0,99993 0,00028 0,99993 0,00028 0,99993 0,00028 

3,81 0,99993 0,00028 0,99993 0,00027 0,99993 0,00027 0,99993 0,00027 0,99993 0,00027 

3,82 0,99993 0,00027 0,99993 0,00026 0,99994 0,00026 0,99994 0,00026 0,99994 0,00026 

3,83 0,99994 0,00026 0,99994 0,00025 0,99994 0,00025 0,99994 0,00025 0,99994 0,00025 

3,84 0,99994 0,00025 0,99994 0,00024 0,99994 0,00024 0,99994 0,00024 0,99994 0,00024 

3,85 0,99994 0,00024 0,99994 0,00024 0,99994 0,00023 0,99994 0,00023 0,99994 0,00023 

3,86 0,99994 0,00023 0,99994 0,00023 0,99994 0,00023 0,99995 0,00022 0,99995 0,00022 

3,87 0,99995 0,00022 0,99995 0,00022 0,99995 0,00022 0,99995 0,00022 0,99995 0,00022 

3,88 0,99995 0,00021 0,99995 0,00021 0,99995 0,00021 0,99995 0,00021 0,99995 0,00021 

3,89 0,99995 0,00020 0,99995 0,00020 0,99995 0,00020 0,99995 0,00020 0,99995 0,00020 

3,90 0,99995 0,00019 0,99995 0,00019 0,99995 0,00019 0,99995 0,00019 0,99995 0,00019 

3,91 0,99995 0,00019 0,99995 0,00019 0,99996 0,00019 0,99996 0,00019 0,99996 0,00018 
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3,92 0,99996 0,00018 0,99996 0,00018 0,99996 0,00018 0,99996 0,00018 0,99996 0,00018 

3,93 0,99996 0,00017 0,99996 0,00017 0,99996 0,00017 0,99996 0,00017 0,99996 0,00017 

3,94 0,99996 0,00017 0,99996 0,00017 0,99996 0,00017 0,99996 0,00016 0,99996 0,00016 

3,95 0,99996 0,00016 0,99996 0,00016 0,99996 0,00016 0,99996 0,00016 0,99996 0,00016 

3,96 0,99996 0,00015 0,99996 0,00015 0,99996 0,00015 0,99996 0,00015 0,99996 0,00015 

3,97 0,99996 0,00015 0,99996 0,00015 0,99997 0,00015 0,99997 0,00015 0,99997 0,00015 

3,98 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 

3,99 0,99997 0,00014 0,99997 0,00014 0,99997 0,00014 0,99997 0,00013 0,99997 0,00013 

 

 

LAMPIRAN II: 
TABEL DISTRIBUSI F 

alfa df2 
df1 

1 2 3 4 5 6 7 

0.01 1 4,052.181 4,999.500 5,403.352 5,624.583 5,763.650 5,858.986 5,928.356 

0.01 2 98.503 99.000 99.166 99.249 99.299 99.333 99.356 

0.01 3 34.116 30.817 29.457 28.710 28.237 27.911 27.672 

0.01 4 21.198 18.000 16.694 15.977 15.522 15.207 14.976 

0.01 5 16.258 13.274 12.060 11.392 10.967 10.672 10.456 

0.01 6 13.745 10.925 9.780 9.148 8.746 8.466 8.260 

0.01 7 12.246 9.547 8.451 7.847 7.460 7.191 6.993 

0.01 8 11.259 8.649 7.591 7.006 6.632 6.371 6.178 

0.01 9 10.561 8.022 6.992 6.422 6.057 5.802 5.613 

0.01 10 10.044 7.559 6.552 5.994 5.636 5.386 5.200 

0.01 11 9.646 7.206 6.217 5.668 5.316 5.069 4.886 

0.01 12 9.330 6.927 5.953 5.412 5.064 4.821 4.640 

0.01 13 9.074 6.701 5.739 5.205 4.862 4.620 4.441 

0.01 14 8.862 6.515 5.564 5.035 4.695 4.456 4.278 

0.01 15 8.683 6.359 5.417 4.893 4.556 4.318 4.142 

0.01 16 8.531 6.226 5.292 4.773 4.437 4.202 4.026 

0.01 17 8.400 6.112 5.185 4.669 4.336 4.102 3.927 

0.01 18 8.285 6.013 5.092 4.579 4.248 4.015 3.841 

0.01 19 8.185 5.926 5.010 4.500 4.171 3.939 3.765 

0.01 20 8.096 5.849 4.938 4.431 4.103 3.871 3.699 

0.01 21 8.017 5.780 4.874 4.369 4.042 3.812 3.640 

0.01 22 7.945 5.719 4.817 4.313 3.988 3.758 3.587 

0.01 23 7.881 5.664 4.765 4.264 3.939 3.710 3.539 

0.01 24 7.823 5.614 4.718 4.218 3.895 3.667 3.496 

0.01 25 7.770 5.568 4.675 4.177 3.855 3.627 3.457 

0.01 26 7.721 5.526 4.637 4.140 3.818 3.591 3.421 

0.01 27 7.677 5.488 4.601 4.106 3.785 3.558 3.388 

0.01 28 7.636 5.453 4.568 4.074 3.754 3.528 3.358 

0.01 29 7.598 5.420 4.538 4.045 3.725 3.499 3.330 

0.01 30 7.562 5.390 4.510 4.018 3.699 3.473 3.304 

0.01 40 7.314 5.179 4.313 3.828 3.514 3.291 3.124 

0.01 60 7.077 4.977 4.126 3.649 3.339 3.119 2.953 

0.01 120 6.851 4.787 3.949 3.480 3.174 2.956 2.792 

0.01 10,000 6.635 4.605 3.782 3.319 3.017 2.802 2.639 
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0.05 1 161.448 199.500 215.707 224.583 230.162 233.986 236.768 

0.05 2 18.513 19.000 19.164 19.247 19.296 19.329 19.353 

0.05 3 10.128 9.552 9.277 9.117 9.014 8.941 8.887 

0.05 4 7.709 6.944 6.591 6.388 6.256 6.163 6.094 

0.05 5 6.608 5.786 5.410 5.192 5.050 4.950 4.876 

0.05 6 5.987 5.143 4.757 4.534 4.387 4.284 4.207 

0.05 7 5.591 4.737 4.347 4.120 3.971 3.866 3.787 

0.05 8 5.318 4.459 4.066 3.838 3.688 3.581 3.501 

0.05 9 5.117 4.256 3.862 3.633 3.482 3.374 3.293 

0.05 10 4.965 4.103 3.708 3.478 3.326 3.217 3.135 

0.05 11 4.844 3.982 3.587 3.357 3.204 3.095 3.012 

0.05 12 4.747 3.885 3.490 3.259 3.106 2.996 2.913 

0.05 13 4.667 3.806 3.410 3.179 3.025 2.915 2.832 

0.05 14 4.600 3.739 3.344 3.112 2.958 2.848 2.764 

0.05 15 4.543 3.682 3.287 3.056 2.901 2.791 2.707 

0.05 16 4.494 3.634 3.239 3.007 2.852 2.741 2.657 

0.05 17 4.451 3.591 3.197 2.965 2.810 2.699 2.614 

0.05 18 4.414 3.555 3.160 2.928 2.773 2.661 2.577 

0.05 19 4.381 3.522 3.127 2.895 2.740 2.628 2.543 

0.05 20 4.351 3.493 3.098 2.866 2.711 2.599 2.514 

0.05 21 4.325 3.467 3.072 2.840 2.685 2.573 2.488 

0.05 22 4.301 3.443 3.049 2.817 2.661 2.549 2.464 

0.05 23 4.279 3.422 3.028 2.796 2.640 2.528 2.442 

0.05 24 4.260 3.403 3.009 2.776 2.621 2.508 2.423 

0.05 25 4.242 3.385 2.991 2.759 2.603 2.490 2.405 

0.05 26 4.225 3.369 2.975 2.743 2.587 2.474 2.388 

0.05 27 4.210 3.354 2.960 2.728 2.572 2.459 2.373 

0.05 28 4.196 3.340 2.947 2.714 2.558 2.445 2.359 

0.05 29 4.183 3.328 2.934 2.701 2.545 2.432 2.346 

0.05 30 4.171 3.316 2.922 2.690 2.534 2.421 2.334 

0.05 40 4.085 3.232 2.839 2.606 2.450 2.336 2.249 

0.05 60 4.001 3.150 2.758 2.525 2.368 2.254 2.167 

0.05 120 3.920 3.072 2.680 2.447 2.290 2.175 2.087 

0.05 10,000 3.841 2.996 2.605 2.372 2.214 2.099 2.010 

0.10 1 39.863 49.500 53.593 55.833 57.240 58.204 58.906 

0.10 2 8.526 9.000 9.162 9.243 9.293 9.326 9.349 

0.10 3 5.538 5.462 5.391 5.343 5.309 5.285 5.266 

0.10 4 4.545 4.325 4.191 4.107 4.051 4.010 3.979 

0.10 5 4.060 3.780 3.619 3.520 3.453 3.405 3.368 

0.10 6 3.776 3.463 3.289 3.181 3.108 3.055 3.014 

0.10 7 3.589 3.257 3.074 2.961 2.883 2.827 2.785 

0.10 8 3.458 3.113 2.924 2.806 2.726 2.668 2.624 

0.10 9 3.360 3.006 2.813 2.693 2.611 2.551 2.505 

0.10 10 3.285 2.924 2.728 2.605 2.522 2.461 2.414 

0.10 11 3.225 2.860 2.660 2.536 2.451 2.389 2.342 

0.10 12 3.177 2.807 2.606 2.480 2.394 2.331 2.283 

0.10 13 3.136 2.763 2.560 2.434 2.347 2.283 2.234 

0.10 14 3.102 2.726 2.522 2.395 2.307 2.243 2.193 

0.10 15 3.073 2.695 2.490 2.361 2.273 2.208 2.158 

0.10 16 3.048 2.668 2.462 2.333 2.244 2.178 2.128 



BELAJAR STATISTIKA DENGAN UNPAD SAS 

234 

alfa df2 
df1 

1 2 3 4 5 6 7 

0.10 17 3.026 2.645 2.437 2.308 2.218 2.152 2.102 

0.10 18 3.007 2.624 2.416 2.286 2.196 2.130 2.079 

0.10 19 2.990 2.606 2.397 2.266 2.176 2.109 2.058 

0.10 20 2.975 2.589 2.380 2.249 2.158 2.091 2.040 

0.10 21 2.961 2.575 2.365 2.233 2.142 2.075 2.023 

0.10 22 2.949 2.561 2.351 2.219 2.128 2.061 2.008 

0.10 23 2.937 2.549 2.339 2.207 2.115 2.047 1.995 

0.10 24 2.927 2.538 2.327 2.195 2.103 2.035 1.983 

0.10 25 2.918 2.528 2.317 2.184 2.092 2.024 1.971 

0.10 26 2.909 2.519 2.307 2.174 2.082 2.014 1.961 

0.10 27 2.901 2.511 2.299 2.165 2.073 2.005 1.952 

0.10 28 2.894 2.503 2.291 2.157 2.064 1.996 1.943 

0.10 29 2.887 2.495 2.283 2.149 2.057 1.988 1.935 

0.10 30 2.881 2.489 2.276 2.142 2.049 1.980 1.927 

0.10 40 2.835 2.440 2.226 2.091 1.997 1.927 1.873 

0.10 60 2.791 2.393 2.177 2.041 1.946 1.875 1.819 

0.10 120 2.748 2.347 2.130 1.992 1.896 1.824 1.767 

0.10 10,000 2.706 2.303 2.084 1.945 1.847 1.774 1.717 

 

lanjutan 

alfa df2 
df1 

8 9 10 12 15 20 

0.01 1 5,981.070 6,022.473 6,055.847 6,106.321 6,157.285 6,208.730 

0.01 2 99.374 99.388 99.399 99.416 99.433 99.449 

0.01 3 27.489 27.345 27.229 27.052 26.872 26.690 

0.01 4 14.799 14.659 14.546 14.374 14.198 14.020 

0.01 5 10.289 10.158 10.051 9.888 9.722 9.553 

0.01 6 8.102 7.976 7.874 7.718 7.559 7.396 

0.01 7 6.840 6.719 6.620 6.469 6.314 6.155 

0.01 8 6.029 5.911 5.814 5.667 5.515 5.359 

0.01 9 5.467 5.351 5.257 5.111 4.962 4.808 

0.01 10 5.057 4.942 4.849 4.706 4.558 4.405 

0.01 11 4.744 4.632 4.539 4.397 4.251 4.099 

0.01 12 4.499 4.388 4.296 4.155 4.010 3.858 

0.01 13 4.302 4.191 4.100 3.960 3.815 3.665 

0.01 14 4.140 4.030 3.939 3.800 3.656 3.505 

0.01 15 4.004 3.895 3.805 3.666 3.522 3.372 

0.01 16 3.890 3.780 3.691 3.553 3.409 3.259 

0.01 17 3.791 3.682 3.593 3.455 3.312 3.162 

0.01 18 3.705 3.597 3.508 3.371 3.227 3.077 

0.01 19 3.631 3.523 3.434 3.297 3.153 3.003 

0.01 20 3.564 3.457 3.368 3.231 3.088 2.938 

0.01 21 3.506 3.398 3.310 3.173 3.030 2.880 

0.01 22 3.453 3.346 3.258 3.121 2.978 2.827 

0.01 23 3.406 3.299 3.211 3.074 2.931 2.781 

0.01 24 3.363 3.256 3.168 3.032 2.889 2.738 

0.01 25 3.324 3.217 3.129 2.993 2.850 2.699 

0.01 26 3.288 3.182 3.094 2.958 2.815 2.664 

0.01 27 3.256 3.149 3.062 2.926 2.783 2.632 



LAMPIRAN 

235 

alfa df2 
df1 

8 9 10 12 15 20 

0.01 28 3.226 3.120 3.032 2.896 2.753 2.602 

0.01 29 3.198 3.092 3.005 2.868 2.726 2.574 

0.01 30 3.173 3.067 2.979 2.843 2.700 2.549 

0.01 40 2.993 2.888 2.801 2.665 2.522 2.369 

0.01 60 2.823 2.718 2.632 2.496 2.352 2.198 

0.01 120 2.663 2.559 2.472 2.336 2.192 2.035 

0.01 10,000 2.511 2.407 2.321 2.185 2.039 1.878 

0.05 1 238.883 240.543 241.882 243.906 245.950 248.013 

0.05 2 19.371 19.385 19.396 19.413 19.429 19.446 

0.05 3 8.845 8.812 8.786 8.745 8.703 8.660 

0.05 4 6.041 5.999 5.964 5.912 5.858 5.803 

0.05 5 4.818 4.772 4.735 4.678 4.619 4.558 

0.05 6 4.147 4.099 4.060 4.000 3.938 3.874 

0.05 7 3.726 3.677 3.636 3.575 3.511 3.445 

0.05 8 3.438 3.388 3.347 3.284 3.218 3.150 

0.05 9 3.230 3.179 3.137 3.073 3.006 2.937 

0.05 10 3.072 3.020 2.978 2.913 2.845 2.774 

0.05 11 2.948 2.896 2.854 2.788 2.719 2.646 

0.05 12 2.849 2.796 2.753 2.687 2.617 2.544 

0.05 13 2.767 2.714 2.671 2.604 2.533 2.459 

0.05 14 2.699 2.646 2.602 2.534 2.463 2.388 

0.05 15 2.641 2.588 2.544 2.475 2.403 2.328 

0.05 16 2.591 2.538 2.494 2.425 2.352 2.276 

0.05 17 2.548 2.494 2.450 2.381 2.308 2.230 

0.05 18 2.510 2.456 2.412 2.342 2.269 2.191 

0.05 19 2.477 2.423 2.378 2.308 2.234 2.155 

0.05 20 2.447 2.393 2.348 2.278 2.203 2.124 

0.05 21 2.421 2.366 2.321 2.250 2.176 2.096 

0.05 22 2.397 2.342 2.297 2.226 2.151 2.071 

0.05 23 2.375 2.320 2.275 2.204 2.128 2.048 

0.05 24 2.355 2.300 2.255 2.183 2.108 2.027 

0.05 25 2.337 2.282 2.236 2.165 2.089 2.007 

0.05 26 2.320 2.265 2.220 2.148 2.072 1.990 

0.05 27 2.305 2.250 2.204 2.132 2.056 1.974 

0.05 28 2.291 2.236 2.190 2.118 2.041 1.959 

0.05 29 2.278 2.223 2.177 2.104 2.027 1.945 

0.05 30 2.266 2.211 2.165 2.092 2.015 1.932 

0.05 40 2.180 2.124 2.077 2.003 1.925 1.839 

0.05 60 2.097 2.040 1.993 1.917 1.836 1.748 

0.05 120 2.016 1.959 1.911 1.834 1.750 1.659 

0.05 10,000 1.938 1.880 1.831 1.752 1.666 1.570 

0.10 1 59.439 59.858 60.195 60.705 61.220 61.740 

0.10 2 9.367 9.381 9.392 9.408 9.425 9.441 

0.10 3 5.252 5.240 5.230 5.216 5.200 5.184 

0.10 4 3.955 3.936 3.920 3.896 3.870 3.844 

0.10 5 3.339 3.316 3.297 3.268 3.238 3.207 

0.10 6 2.983 2.958 2.937 2.905 2.871 2.836 

0.10 7 2.752 2.725 2.703 2.668 2.632 2.595 

0.10 8 2.589 2.561 2.538 2.502 2.464 2.425 

0.10 9 2.469 2.440 2.416 2.379 2.340 2.298 



BELAJAR STATISTIKA DENGAN UNPAD SAS 

236 

alfa df2 
df1 

8 9 10 12 15 20 

0.10 10 2.377 2.347 2.323 2.284 2.244 2.201 

0.10 11 2.304 2.273 2.248 2.209 2.167 2.123 

0.10 12 2.245 2.214 2.188 2.147 2.105 2.060 

0.10 13 2.195 2.164 2.138 2.097 2.053 2.007 

0.10 14 2.154 2.122 2.095 2.054 2.010 1.962 

0.10 15 2.119 2.086 2.059 2.017 1.972 1.924 

0.10 16 2.088 2.055 2.028 1.985 1.940 1.891 

0.10 17 2.061 2.028 2.001 1.958 1.912 1.862 

0.10 18 2.038 2.005 1.977 1.933 1.887 1.837 

0.10 19 2.017 1.984 1.956 1.912 1.865 1.814 

0.10 20 1.999 1.965 1.937 1.892 1.845 1.794 

0.10 21 1.982 1.948 1.920 1.875 1.827 1.776 

0.10 22 1.967 1.933 1.904 1.859 1.811 1.759 

0.10 23 1.953 1.919 1.890 1.845 1.796 1.744 

0.10 24 1.941 1.906 1.877 1.832 1.783 1.730 

0.10 25 1.929 1.895 1.866 1.820 1.771 1.718 

0.10 26 1.919 1.884 1.855 1.809 1.760 1.706 

0.10 27 1.909 1.874 1.845 1.799 1.749 1.695 

0.10 28 1.900 1.865 1.836 1.790 1.740 1.685 

0.10 29 1.892 1.857 1.827 1.781 1.731 1.676 

0.10 30 1.884 1.849 1.819 1.773 1.722 1.667 

0.10 40 1.829 1.793 1.763 1.715 1.662 1.605 

0.10 60 1.775 1.738 1.707 1.657 1.603 1.543 

0.10 120 1.722 1.684 1.652 1.601 1.545 1.482 

0.10 10,000 1.670 1.632 1.599 1.546 1.487 1.421 

 

lanjutan 

alfa df2 
df1 

24 30 40 60 120 10,000 

0.01 1 6,234.631 6,260.649 6,286.782 6,313.030 6,339.391 6,365.864 

0.01 2 99.458 99.466 99.474 99.482 99.491 99.499 

0.01 3 26.598 26.505 26.411 26.316 26.221 26.125 

0.01 4 13.929 13.838 13.745 13.652 13.558 13.463 

0.01 5 9.466 9.379 9.291 9.202 9.112 9.020 

0.01 6 7.313 7.229 7.143 7.057 6.969 6.880 

0.01 7 6.074 5.992 5.908 5.824 5.737 5.650 

0.01 8 5.279 5.198 5.116 5.032 4.946 4.859 

0.01 9 4.729 4.649 4.567 4.483 4.398 4.311 

0.01 10 4.327 4.247 4.165 4.082 3.996 3.909 

0.01 11 4.021 3.941 3.860 3.776 3.690 3.602 

0.01 12 3.780 3.701 3.619 3.535 3.449 3.361 

0.01 13 3.587 3.507 3.425 3.341 3.255 3.165 

0.01 14 3.427 3.348 3.266 3.181 3.094 3.004 

0.01 15 3.294 3.214 3.132 3.047 2.959 2.868 

0.01 16 3.181 3.101 3.018 2.933 2.845 2.753 

0.01 17 3.084 3.003 2.920 2.835 2.746 2.653 

0.01 18 2.999 2.919 2.835 2.749 2.660 2.566 

0.01 19 2.925 2.844 2.761 2.674 2.584 2.489 

0.01 20 2.859 2.778 2.695 2.608 2.517 2.421 



LAMPIRAN 

237 

alfa df2 
df1 

24 30 40 60 120 10,000 

0.01 21 2.801 2.720 2.636 2.548 2.457 2.360 

0.01 22 2.749 2.667 2.583 2.495 2.403 2.305 

0.01 23 2.702 2.620 2.535 2.447 2.354 2.256 

0.01 24 2.659 2.577 2.492 2.403 2.310 2.211 

0.01 25 2.620 2.538 2.453 2.364 2.270 2.169 

0.01 26 2.585 2.503 2.417 2.327 2.233 2.131 

0.01 27 2.552 2.470 2.384 2.294 2.198 2.097 

0.01 28 2.522 2.440 2.354 2.263 2.167 2.064 

0.01 29 2.495 2.412 2.325 2.234 2.138 2.034 

0.01 30 2.469 2.386 2.299 2.208 2.111 2.006 

0.01 40 2.288 2.203 2.114 2.019 1.917 1.805 

0.01 60 2.115 2.028 1.936 1.836 1.726 1.601 

0.01 120 1.950 1.860 1.763 1.656 1.533 1.381 

0.01 10,000 1.791 1.696 1.592 1.473 1.325 1.000 

0.05 1 249.052 250.095 251.143 252.196 253.253 254.314 

0.05 2 19.454 19.462 19.471 19.479 19.487 19.496 

0.05 3 8.639 8.617 8.594 8.572 8.549 8.526 

0.05 4 5.774 5.746 5.717 5.688 5.658 5.628 

0.05 5 4.527 4.496 4.464 4.431 4.399 4.365 

0.05 6 3.841 3.808 3.774 3.740 3.705 3.669 

0.05 7 3.410 3.376 3.340 3.304 3.267 3.230 

0.05 8 3.115 3.079 3.043 3.005 2.967 2.928 

0.05 9 2.901 2.864 2.826 2.787 2.748 2.707 

0.05 10 2.737 2.700 2.661 2.621 2.580 2.538 

0.05 11 2.609 2.570 2.531 2.490 2.448 2.405 

0.05 12 2.506 2.466 2.426 2.384 2.341 2.296 

0.05 13 2.420 2.380 2.339 2.297 2.252 2.206 

0.05 14 2.349 2.308 2.266 2.223 2.178 2.131 

0.05 15 2.288 2.247 2.204 2.160 2.114 2.066 

0.05 16 2.235 2.194 2.151 2.106 2.059 2.010 

0.05 17 2.190 2.148 2.104 2.058 2.011 1.960 

0.05 18 2.150 2.107 2.063 2.017 1.968 1.917 

0.05 19 2.114 2.071 2.026 1.980 1.930 1.878 

0.05 20 2.083 2.039 1.994 1.946 1.896 1.843 

0.05 21 2.054 2.010 1.964 1.917 1.866 1.812 

0.05 22 2.028 1.984 1.938 1.889 1.838 1.783 

0.05 23 2.005 1.960 1.914 1.865 1.813 1.757 

0.05 24 1.984 1.939 1.892 1.842 1.790 1.733 

0.05 25 1.964 1.919 1.872 1.822 1.768 1.711 

0.05 26 1.946 1.901 1.853 1.803 1.749 1.691 

0.05 27 1.930 1.884 1.836 1.785 1.731 1.672 

0.05 28 1.915 1.869 1.820 1.769 1.714 1.654 

0.05 29 1.901 1.854 1.806 1.754 1.698 1.638 

0.05 30 1.887 1.841 1.792 1.740 1.684 1.622 

0.05 40 1.793 1.744 1.693 1.637 1.577 1.509 

0.05 60 1.700 1.649 1.594 1.534 1.467 1.389 

0.05 120 1.608 1.554 1.495 1.429 1.352 1.254 

0.05 10,000 1.517 1.459 1.394 1.318 1.221 1.000 

0.10 1 62.002 62.265 62.529 62.794 63.061 63.328 

0.10 2 9.450 9.458 9.466 9.475 9.483 9.491 



BELAJAR STATISTIKA DENGAN UNPAD SAS 

238 

alfa df2 
df1 

24 30 40 60 120 10,000 

0.10 3 5.176 5.168 5.160 5.151 5.143 5.134 

0.10 4 3.831 3.817 3.804 3.790 3.775 3.761 

0.10 5 3.191 3.174 3.157 3.140 3.123 3.105 

0.10 6 2.818 2.800 2.781 2.762 2.742 2.722 

0.10 7 2.575 2.555 2.535 2.514 2.493 2.471 

0.10 8 2.404 2.383 2.361 2.339 2.316 2.293 

0.10 9 2.277 2.255 2.232 2.208 2.184 2.159 

0.10 10 2.178 2.155 2.132 2.107 2.082 2.055 

0.10 11 2.100 2.076 2.052 2.026 2.000 1.972 

0.10 12 2.036 2.011 1.986 1.960 1.932 1.904 

0.10 13 1.983 1.958 1.931 1.904 1.876 1.846 

0.10 14 1.938 1.912 1.885 1.857 1.828 1.797 

0.10 15 1.899 1.873 1.845 1.817 1.787 1.755 

0.10 16 1.866 1.839 1.811 1.782 1.751 1.718 

0.10 17 1.836 1.809 1.781 1.751 1.719 1.686 

0.10 18 1.810 1.783 1.754 1.723 1.691 1.657 

0.10 19 1.787 1.759 1.730 1.699 1.666 1.631 

0.10 20 1.767 1.738 1.708 1.677 1.643 1.607 

0.10 21 1.748 1.719 1.689 1.657 1.623 1.586 

0.10 22 1.731 1.702 1.671 1.639 1.604 1.567 

0.10 23 1.716 1.686 1.655 1.622 1.587 1.549 

0.10 24 1.702 1.672 1.641 1.607 1.571 1.533 

0.10 25 1.689 1.659 1.627 1.593 1.557 1.518 

0.10 26 1.677 1.647 1.615 1.580 1.544 1.504 

0.10 27 1.666 1.636 1.603 1.569 1.531 1.491 

0.10 28 1.656 1.625 1.592 1.558 1.520 1.478 

0.10 29 1.647 1.616 1.583 1.547 1.509 1.467 

0.10 30 1.638 1.606 1.573 1.538 1.499 1.456 

0.10 40 1.574 1.541 1.506 1.467 1.425 1.377 

0.10 60 1.511 1.476 1.437 1.395 1.348 1.291 

0.10 120 1.447 1.409 1.368 1.320 1.265 1.193 

0.10 10,000 1.383 1.342 1.295 1.240 1.169 1.000 

 
 

  



LAMPIRAN 

239 

LAMPIRAN III: 
DISTRIBUSI R 

df d10 d05 d02 d01  df d10 d05 d02 d01 

1 0.988 0.997 1.000 1.000  21 0.352 0.413 0.482 0.526 

2 0.900 0.950 0.980 0.990  22 0.344 0.404 0.472 0.515 

3 0.805 0.878 0.934 0.959  23 0.337 0.396 0.462 0.505 

4 0.729 0.811 0.882 0.917  24 0.330 0.388 0.453 0.496 

5 0.669 0.754 0.833 0.874  25 0.323 0.381 0.445 0.487 

6 0.622 0.707 0.789 0.834  26 0.317 0.374 0.437 0.479 

7 0.582 0.666 0.750 0.798  27 0.311 0.367 0.430 0.471 

8 0.549 0.632 0.716 0.765  28 0.306 0.361 0.423 0.463 

9 0.521 0.602 0.685 0.735  29 0.301 0.355 0.416 0.456 

10 0.497 0.576 0.658 0.708  30 0.296 0.349 0.409 0.449 

11 0.476 0.553 0.634 0.684  35 0.275 0.325 0.381 0.418 

12 0.458 0.532 0.612 0.661  40 0.257 0.304 0.358 0.393 

13 0.441 0.514 0.592 0.641  45 0.243 0.288 0.338 0.372 

14 0.426 0.497 0.574 0.623  50 0.231 0.273 0.322 0.354 

15 0.412 0.482 0.558 0.606  60 0.211 0.250 0.295 0.325 

16 0.400 0.468 0.542 0.590  70 0.195 0.232 0.274 0.303 

17 0.389 0.456 0.528 0.575  80 0.183 0.217 0.256 0.283 

18 0.378 0.444 0.516 0.561  90 0.173 0.205 0.242 0.267 

19 0.369 0.433 0.503 0.549  100 0.164 0.195 0.230 0.254 

20 0.360 0.423 0.492 0.537       

 

LAMPIRAN IV: 
DISTRIBUSI CHI-SQUARE 

df 
α 

0.10 0.05 0.025 0.001 
1 2,70554 3,84146 5,02389 6,6349 

2 4,60517 5,99146 7,37776 9,21034 

3 6,25139 7,81473 9,34840 11,34487 

4 7,77944 9,48773 11,14329 13,2767 

5 9,23636 11,0705 12,83250 15,08627 

6 10,64464 12,59159 14,44938 16,81189 

7 12,01704 14,06714 16,01276 18,47531 

8 13,36157 15,50731 17,53455 20,09024 

9 14,68366 16,91898 19,02277 21,66599 

10 15,98718 18,30704 20,48318 23,20925 

11 17,27501 19,67514 21,92005 24,72497 

12 18,54935 21,02607 23,33666 26,21697 

13 19,81193 22,36203 24,73560 27,68825 

14 21,06414 23,68479 26,11895 29,14124 

15 22,30713 24,99579 27,48839 30,57791 

16 23,54183 26,29623 28,84535 31,99993 

17 24,76904 27,58711 30,19101 33,40866 

18 25,98942 28,86930 31,52638 34,80531 

19 27,20357 30,14353 32,85233 36,19087 

20 28,41198 31,41043 34,16961 37,56623 

21 29,61509 32,67057 35,47888 38,93217 



BELAJAR STATISTIKA DENGAN UNPAD SAS 

240 

df 
α 

0.10 0.05 0.025 0.001 
22 30,81328 33,92444 36,78071 40,28936 

23 32,00690 35,17246 38,07563 41,63840 

24 33,19624 36,41503 39,36408 42,97982 

25 34,38159 37,65248 40,64647 44,31410 

26 35,56317 38,88514 41,92317 45,64168 

27 36,74122 40,11327 43,19451 46,96294 

28 37,91592 41,33714 44,46079 48,27824 

29 39,08747 42,55697 45,72229 49,58788 

30 40,25602 43,77297 46,97924 50,89218 

31 41,42174 44,98534 48,23189 52,19139 

32 42,58475 46,19426 49,48044 53,48577 

33 43,74518 47,39988 50,72508 54,77554 

34 44,90316 48,60237 51,96600 56,06091 

35 46,05879 49,80185 53,20335 57,34207 

36 47,21217 50,99846 54,43729 58,61921 

37 48,36341 52,19232 55,66797 59,89250 

38 49,51258 53,38354 56,89552 61,16209 

39 50,65977 54,57223 58,12006 62,42812 

40 51,80506 55,75848 59,34171 63,69074 

41 52,94851 56,94239 60,56057 64,95007 

42 54,09020 58,12404 61,77676 66,20624 

43 55,23019 59,30351 62,99036 67,45935 

44 56,36854 60,48089 64,20146 68,70951 

45 57,50530 61,65623 65,41016 69,95683 

46 58,64054 62,82962 66,61653 71,20140 

47 59,77429 64,00111 67,82065 72,44331 

48 60,90661 65,17077 69,02259 73,68264 

49 62,03754 66,33865 70,22241 74,91947 

50 63,16712 67,50481 71,42020 76,15389 

51 64,29540 68,66929 72,61599 77,38596 

52 65,42241 69,83216 73,80986 78,61576 

53 66,54820 70,99345 75,00186 79,84334 

54 67,67279 72,15322 76,19205 81,06877 

55 68,79621 73,31149 77,38047 82,29212 

56 69,91851 74,46832 78,56716 83,51343 

57 71,03971 75,62375 79,75219 84,73277 

58 72,15984 76,77780 80,93559 85,95018 

59 73,27893 77,93052 82,11741 87,16571 

60 74,39701 79,08194 83,29768 88,37942 

61 75,51409 80,23210 84,47644 89,59134 

62 76,63021 81,38102 85,65373 90,80153 

63 77,74538 82,52873 86,82959 92,01002 

64 78,85964 83,67526 88,00405 93,21686 

65 79,97300 84,82065 89,17715 94,42208 

66 81,08549 85,96491 90,34890 95,62572 

67 82,19711 87,10807 91,51936 96,82782 

68 83,30790 88,25016 92,68854 98,02840 

69 84,41787 89,39121 93,85647 99,22752 

70 85,52704 90,53123 95,02318 100,42518 

71 86,63543 91,67024 96,18870 101,62144 
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df 
α 

0.10 0.05 0.025 0.001 
72 87,74305 92,80827 97,35305 102,81631 

73 88,84992 93,94534 98,51626 104,00983 

74 89,95605 95,08147 99,67835 105,20203 

75 91,06146 96,21667 100,83934 106,39292 

76 92,16617 97,35097 101,99925 107,58254 

77 93,27018 98,48438 103,15811 108,77092 

78 94,37352 99,61693 104,31594 109,95807 

79 95,47619 100,74862 105,47275 111,14402 

80 96,57820 101,87947 106,62857 112,32879 

81 97,67958 103,00951 107,78341 113,51241 

82 98,78033 104,13874 108,93729 114,69489 

83 99,88046 105,26718 110,09024 115,87627 

84 100,97999 106,39484 111,24226 117,05654 

85 102,07892 107,52174 112,39337 118,23575 

86 103,17726 108,64789 113,54360 119,41390 

87 104,27504 109,77331 114,69295 120,59101 

88 105,37225 110,89800 115,84144 121,76711 

89 106,46890 112,02199 116,98908 122,94221 

90 107,56501 113,14527 118,13589 124,11632 

91 108,66058 114,26787 119,28189 125,28946 

92 109,75563 115,38979 120,42708 126,46166 

93 110,85015 116,51105 121,57148 127,63291 

94 111,94417 117,63165 122,71511 128,80325 

95 113,03769 118,75161 123,85797 129,97268 

96 114,13071 119,87094 125,00007 131,14122 

97 115,22324 120,98964 126,14144 132,30888 

98 116,31530 122,10773 127,28207 133,47567 

99 117,40688 123,22522 128,42199 134,64162 

100 118,4980 124,34211 129,56120 135,80672 
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